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Overview

Audience

Preface

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications
Manager 6.1 provides the information you need to understand, install, configure, manage, and
troubleshoot the phones in the Cisco Unified IP Phone 7965G and 7945G on a Voice-over-IP (VoIP)
network.

Because of the complexity of an IP telephony network, this guide does not provide complete and detailed
information for procedures that you need to perform in Cisco Unified Communications Manager or
other network devices.

Network engineers, system administrators, or telecom engineers should review this guide to learn the
steps required to properly set up the Cisco Unified IP Phone 7965G and 7945G on the network.

The tasks described are administration-level tasks and are not intended for end-users of the phones.
Many of the tasks involve configuring network settings and affect the phone’s ability to function in the
network.

Because of the close interaction between the Cisco Unified IP Phone and
Cisco Unified Communications Manager, many of the tasks in this manual require familiarity with
Cisco Unified Communications Manager.

Organization

This manual is organized as follows:

Chapter 1, “An Overview of the Cisco Provides a conceptual overview and description of
Unified IP Phone” the Cisco Unified IP Phone.

Chapter 2, “Preparing to Install the Cisco Describes how the Cisco Unified IP Phone
Unified IP Phone on Your Network” interacts with other key IP telephony components,

and provides an overview of the tasks required
prior to installation.

| oL-14641-01
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Chapter 3, “Setting Up the Cisco
Unified IP Phone”

Describes how to properly and safely install and
configure the Cisco Unified IP Phone on your
network.

Chapter 4, “Configuring Settings on the Cisco
Unified IP Phone”

Describes how to configure network settings,
verify status, and make global changes to the
Cisco Unified IP Phone.

Chapter 5, “Configuring Features, Templates,
Services, and Users”

Provides an overview of procedures for
configuring telephony features, configuring
directories, configuring phone button and softkey
templates, setting up services, and adding users to
Cisco Unified Communications Manager.

Chapter 6, “Customizing the Cisco Unified
IP Phone”

Explains how to customize phone ring sounds,
background images, and the phone idle display at
your site.

Chapter 7, “Viewing Model Information, Status,
and Statistics on the Cisco Unified IP Phone”

Explains how to view model information, status
messages, network statistics, and firmware
information from the Cisco Unified IP Phone.

Chapter 8, “Monitoring the Cisco
Unified IP Phone Remotely”

Describes the information that you can obtain
from the phone’s web page to remotely monitor
the operation of a phone and to assist with
troubleshooting.

Chapter 9, “Troubleshooting and Maintenance”

Provides tips for troubleshooting the
Cisco Unified IP Phone.

Appendix A, “Providing Information to Users Via
a Website”

Provides suggestions for setting up a website for
providing users with important information about
their Cisco Unified IP Phones.

Appendix B, “Feature Support by Protocol for the
Cisco Unified IP Phone 7965G and 7945G”

Provides information about feature support for the
Cisco Unified IP Phone 7965G and 7945G using
the SCCP or SIP protocol with Cisco Unified
Communications Manager Release 6.0.

Appendix C, “Supporting International Users”

Provides information about setting up phones in
non-English environments.

Appendix D, “Technical Specifications”

Provides technical specifications of the
Cisco Unified IP Phone.

Related Documentation

For more information about Cisco Unified IP Phones or Cisco Unified Communications Manager, refer

to the following publications:

Cisco Unified IP Phone 7900 Series
These publications are available at the following URL:

http://www.cisco.com/en/US/products/hw/phones/ps379/tsd_products_support_series_home.html
e Cisco Unified IP Phone 7965 Series Phone Guide
e (Cisco Unified IP Phone Features A-Z

l_ Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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e Cisco Unified IP Phone Expansion Module 7914 Phone Guide
e [Installing the Wall Mount Kit for the Cisco Unified IP Phone
® Regulatory Compliance and Safety Information for the Cisco Unified IP Phone 7900 Series

Cisco Unified Communications Manager Administration
Related publications are available at the following URL:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html

Cisco Unified Communications Manager Business Edition

Related publications are available at the following URL.:

http://www.cisco.com/en/US/products/ps7273/tsd_products_support_series_home.html

Obtaining Documentation, Obtaining Support, and Security

Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback,
security guidelines, and also recommended aliases and general Cisco documents, see the monthly
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Cisco Product Security Overview

This product contains cryptographic features and is subject to United States and local country laws
governing import, export, transfer and use. Delivery of Cisco cryptographic products does not imply
third-party authority to import, export, distribute or use encryption. Importers, exporters, distributors
and users are responsible for compliance with U.S. and local country laws. By using this product you
agree to comply with applicable laws and regulations. If you are unable to comply with U.S. and local
laws, return this product immediately.

A summary of U.S. laws governing Cisco cryptographic products may be found at:
http://www.cisco.com/wwl/export/crypto/tool/stqrg.html. If you require further assistance please
contact us by sending email to export@cisco.com.

Document Conventions

This document uses the following conventions:

Convention

Description

boldface font

Commands and keywords are in boldface.

italic font

Arguments for which you supply values are in italics.

[ ]

Elements in square brackets are optional.

{xlylz}

Alternative keywords are grouped in braces and separated by vertical bars.

| oL-14641-01
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Convention Description

[xlylz] Optional alternative keywords are grouped in brackets and separated by vertical bars.

string A nonquoted set of characters. Do not use quotation marks around the string or the string will

include the quotation marks.

screen font

Terminal sessions and information the system displays are in screen font.

boldface screen font Information you must enter is in boldface screen font.

italic screen font

Arguments for which you supply values are in italic screen font.

A

The symbol ” represents the key labeled Control—for example, the key combination AD in a
screen display means hold down the Control key while you press the D key.

Nonprinting characters, such as passwords are in angle brackets.

~

Note

A

Means reader take note. Notes contain helpful suggestions or references to material not covered in the
publication.

Caution

>

Warning

Means reader be careful. In this situation, you might do something that could result in equipment
damage or loss of data.

Warnings use the following convention:

IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could cause
bodily injury. Before you work on any equipment, be aware of the hazards
involved with electrical circuitry and be familiar with standard practices for
preventing accidents. Use the statement number provided at the end of each
warning to locate its translation in the translated safety warnings that
accompanied this device. Statement 1071
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= CHAPTER 1

An Overview of the Cisco Unified IP Phone

The Cisco Unified IP Phone 7965G and 7945G are full-featured telephones that provide voice
communication over an Internet Protocol (IP) network. These phones function much like digital business
phones, allowing you to place and receive phone calls and to access features such as mute, hold, transfer,
speed dial, call forward, and more. In addition, because Cisco Unified IP Phones are connected to your
data network, they offer enhanced IP telephony features, including access to network information and
services, and customizeable features and services. The phones also support security features that include
file authentication, device authentication, signaling encryption, and media encryption.

A Cisco Unified IP Phone, like other network devices, must be configured and managed. These phones
encode G.711a, G.711y, G.722, G.729a, G.729ab, iLBC, and decode G.711a, G.711u, G.722, iLBC,
G.729, G729a, G729b, and G729ab. These phones also support uncompressed wideband (16bits, 16kHz)
audio.

This chapter includes the following topics:
e Understanding the Cisco Unified IP Phone 7965G and 7945G, page 1-2
e What Networking Protocols Are Used?, page 1-4
e What Features are Supported on the Cisco Unified IP Phone 7965G and 7945G?, page 1-7
¢ Understanding Security Features for Cisco Unified IP Phones, page 1-9
e Overview of Configuring and Installing Cisco Unified IP Phones, page 1-17

Caution

Using a cell, mobile, or GSM phone, or two-way radio in close proximity to a Cisco Unified IP Phone
might cause interference. For more information, refer to the manufacturer documentation of the
interfering device.

| oL-14641-01
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Chapter 1 An Overview of the Cisco Unified IP Phone |

M Understanding the Cisco Unified IP Phone 7965G and 7945G

Understanding the Cisco Unified IP Phone 7965G and 7945G

Figure 1-1 shows the main components of the Cisco Unified IP Phone 7965G.
Figure 1-2 shows the main components of the Cisco Unified IP Phone 7945G.

Figure 1-1 Cisco Unified IP Phone 7965G

Figure 1-2 Cisco Unified IP Phone 7945G

184912
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| Chapter1

An Overview of the Cisco Unified IP Phone

Understanding the Cisco Unified IP Phone 7965G and 79456

1 |Programmable Depending on configuration, programmable buttons provide access to:
buttons e Phone lines (line buttons)
O e Speed-dial numbers (speed-dial buttons, including the BLF speed-dial feature)
e Web-based services (for example, a Personal Address Book button)
e Phone features (for example, a Privacy button)
Buttons illuminate to indicate status:
O Green, steady—Active call or two-way intercom call
O Green, flashing—Held call
O Amber, steady—Privacy in use, one-way intercom call, DND active, or logged into Hunt
Group
O Amber, flashing—Incoming call or reverting call
o Red, steady—Remote line in use (shared line or BLF status)
2 |Footstand Allows you to adjust the angle of the phone base.
adjustment button
3 |Display button Awakens the phone screen from sleep mode.
& & No color—Ready for input
=
@ Green steady—Sleep mode
4 |Messages button |Auto-dials your voice message service (varies by service).
5 |Directories button |Opens/closes the Directories menu. Use it to access call logs and directories.
6 |Help button Activates the Help menu.
7 |[Settings button Opens/closes the Settings menu. Use it to change phone screen and ring settings.
8 |Services button Opens/closes the Services menu.
9 |Volume button Controls the handset, headset, and speakerphone volume (off-hook) and the ringer volume
s (omhook)
10 |Speaker button Toggles the speakerphone on or off.
11 |Mute button Toggles the Mute feature on or off.
12 |Headset button Toggles the headset on or off.
Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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B What Networking Protocols Are Used?

13 |4-way navigation |Allows you to scroll through menus and highlight items. Use the Select button to select an item that
pad and Select is highlighted on the screen.
button (center) Navigation button
e Scroll up and down to see menus and highlight items.
e Scroll right and left to scroll horizontally in multi-column displays.
Select button—scroll to highlight a line using the Navigation button, and then:
e Press to open a menu.
e Press to play a ringer item.
e Press to access other features as described on the screen.
Note The Select button does not take action on all menu items.
14 |Keypad Allows you to dial phone numbers, enter letters, and choose menu items.
15 |Softkey buttons Each activates a softkey option (displayed on your phone screen).
)
16 |Handset light strip |Indicates an incoming call or new voice message.
17 |Phone screen Shows phone features.

What Networking Protocols Are Used?

Cisco Unified IP Phones support several industry-standard and Cisco networking protocols required for
voice communication. Table 1-1 provides an overview of the networking protocols that the Cisco
Unified IP Phone 7965G and 7945G supports.

Table 1-1

Supported Networking Protocols on the Cisco Unified IP Phone

Networking Protocol

Purpose Usage Notes

Bootstrap Protocol
(BootP)

BootP enables a network device such |If you are using BootP to assign IP addresses to the Cisco
as the Cisco Unified IP Phone to Unified IP Phone, the BOOTP Server option shows “Yes”
discover certain startup information, |in the network configuration settings on the phone.

such as its IP address.

Cisco Discovery
Protocol (CDP)

CDP is a device-discovery protocol |The Cisco Unified IP Phone uses CDP to communicate
that runs on all Cisco-manufactured |information such as auxiliary VLAN ID, per port power
equipment. management details, and Quality of Service (QoS)

Using CDP, a device can advertise its configuration information with the Cisco Catalyst switch.

existence to other devices and
receive information about other
devices in the network.
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Table 1-1

What Networking Protocols Are Used?

Supported Networking Protocols on the Cisco Unified IP Phone (continued)

Networking Protocol

Purpose

Usage Notes

Dynamic Host
Configuration Protocol
(DHCP)

DHCP dynamically allocates and
assigns an IP address to network
devices.

DHCP enables you to connect an [P
phone into the network and have the
phone become operational without
your needing to manually assign an
IP address or to configure additional
network parameters.

DHCP is enabled by default. If disabled, you must manually
configure the IP address, subnet mask, gateway, and a TFTP
server on each phone locally.

Cisco recommends that you use DHCP custom option 150.
With this method, you configure the TFTP server IP address
as the option value. For additional information about DHCP
configurations, refer to the “Cisco TFTP” chapter in Cisco
Unified Communications Manager System Guide.

Hypertext Transfer
Protocol (HTTP)

HTTP is the standard way of
transferring information and moving
documents across the Internet and the
web.

Cisco Unified IP Phones use HTTP for the XML services
and for troubleshooting purposes.

IEEE 802.1X

The IEEE 802.1X standard defines a
client-server-based access control
and authentication protocol that
restricts unauthorized clients from
connecting to a LAN through
publicly accessible ports.

Until the client is authenticated,
802.1X access control allows only
Extensible Authentication Protocol
over LAN (EAPOL) traffic through
the port to which the client is
connected. After authentication is
successful, normal traffic can pass
through the port.

The Cisco Unified IP Phone implements the IEEE 802.1X
standard by providing support for the EAP-MDS35 option for
802.1X authentication.

When 802.1X authentication is enabled on the phone, you
should disable the PC port and voice VLAN. Refer to the
“Supporting 802.1X Authentication on Cisco Unified IP
Phones” section on page 1-15 for additional information.

Internet Protocol (IP)

IP is a messaging protocol that
addresses and sends packets across
the network.

To communicate using IP, network devices must have an
assigned IP address, subnet, and gateway.

IP addresses, subnets, and gateways identifications are
automatically assigned if you are using the Cisco
Unified IP Phone with Dynamic Host Configuration
Protocol (DHCP). If you are not using DHCP, you must
manually assign these properties to each phone locally.

Link Layer Discovery
Protocol (LLDP)

LLDP is a standardized network
discovery protocol (similar to CDP)
that is supported on some Cisco and
third-party devices.

The Cisco Unified IP Phone supports LLDP on the PC port.
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Table 1-1

Supported Networking Protocols on the Cisco Unified IP Phone (continued)

Networking Protocol

Purpose

Usage Notes

Link Layer Discovery
Protocol-Media
Endpoint Devices
(LLDP-MED)

LLDP-MED is an extension of the
LLDP standard developed for voice
products.

The Cisco Unified IP Phone uses LLDP-MED to
communicate information such as:

Voice VLAN configuration
Device discovery

Power management
Inventory management

For more information about LLDP-MED support, see the
LLDP-MED and Cisco Discovery Protocol white paper:

http://www.cisco.com/en/US/tech/tk652/tk701/technologie
s_white_paper0900aecd804cd46d.shtml

Cisco Peer-to-Peer
Distribution Protocol
(CPPDP)

CPPDP is a Cisco proprietary
protocol used to form a peer-to-peer
hierarchy of devices. CPPDP is also
used to copy firmware or other files
from peer devices to neighboring
devices.

CPPDP is used by the Peer Firmware Sharing feature.

Real-Time Control
Protocol (RTCP)

RTCP works with Real-Time
Transport Protocol (RTP) to provide
QoS data (such as jitter, latency, and
round trip delay) on RTP streams.

RTCP is disabled by default, but you can enable it on a per
phone basis by using Cisco Unified Communications
Manager Phone Configuration. For more information, see
the “Network Configuration” section on page 4-27.

Real-Time Transport
Protocol (RTP)

RTP is a standard protocol for
transporting real-time data, such as
interactive voice and video, over data
networks.

Cisco Unified IP Phones use the RTP protocol to send and
receive real-time voice traffic from other phones and
gateways.

Session Initiation
Protocol (SIP)

SIP is the Internet Engineering Task
Force (IETF) standard for
multimedia conferencing over IP.
SIP is an ASCII-based
application-layer control protocol
(defined in RFC 3261) that can be
used to establish, maintain, and
terminate calls between two or more
endpoints.

Like other VoIP protocols, SIP is designed to address the
functions of signaling and session management within a
packet telephony network. Signaling allows call
information to be carried across network boundaries.
Session management provides the ability to control the
attributes of an end-to-end call.

Skinny Client Control
Protocol (SCCP)

SCCP includes a messaging set that
allows communications between call
control servers and endpoint clients
such as IP Phones. SCCP is
proprietary to Cisco Systems.

Cisco Unified IP Phones use SCCP for call control. You can
configure the Cisco Unified IP Phone to use either SCCP or
Session Initiation Protocol (SIP).

Session Description
Protocol (SDP)

SDP is the portion of the SIP protocol
that determines which parameters are
available during a connection
between two endpoints. Conferences
are established by using only the SDP
capabilities that are supported by all
endpoints in the conference.

SDP capabilities, such as codec types, DTMF detection, and
comfort noise, are normally configured on a global basis by
Cisco Unified Communications Manager or Media
Gateway in operation. Some SIP endpoints may allow these
parameters to be configured on the endpoint itself.
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Table 1-1 Supported Networking Protocols on the Cisco Unified IP Phone (continued)

Networking Protocol Purpose Usage Notes

Transmission Control | TCP is a connection-oriented Cisco Unified IP Phones use TCP to connect to Cisco

Protocol (TCP) transport protocol. Unified Communications Manager and to access XML

services.

Transport Layer TLS is a standard protocol for When security is implemented, Cisco Unified IP Phones

Security (TLS) securing and authenticating use the TLS protocol when securely registering with Cisco
communications. Unified Communications Manager.

Trivial File Transfer TFTP allows you to transfer files TFTP requires a TFTP server in your network, which can be

Protocol (TFTP) over the network. automatically identified from the DHCP server. If you want

a phone to use a TFTP server other than the one specified
by the DHCP server, you must manually assign TFTP server
from the Network Configuration menu on the phone.

On the Cisco Unified IP Phone,
TFTP enables you to obtain a
configuration file specific to the
phone type.

User Datagram Protocol |UDP is a connectionless messaging |Cisco Unified IP Phones transmit and receive RTP streams,
(UDP) protocol for delivery of data packets. |which utilize UDP.

Related Topics
¢ Understanding Interactions with Other Cisco Unified IP Communications Products, page 2-1

e Understanding the Phone Startup Process, page 2-7
e Network Configuration Menu, page 4-5

What Features are Supported on the Cisco Unified IP Phone
7965G and 7945G?

The Cisco Unified IP Phone functions much like a digital business phone, allowing you to place and
receive telephone calls. In addition to traditional telephony features, the Cisco Unified IP Phone includes
features that enable you to administer and monitor the phone as a network device.

This section includes the following topics:
e Feature Overview, page 1-7
e Configuring Telephony Features, page 1-8
e Configuring Network Parameters Using the Cisco Unified IP Phone, page 1-8

e Providing Users with Feature Information, page 1-9

Feature Overview

Cisco Unified IP Phones provide traditional telephony functionality, such as call forwarding and
transferring, redialing, speed dialing, conference calling, and voice messaging system access.

Cisco Unified IP phones also provide a variety of other features. For an overview of the telephony
features that the Cisco Unified IP Phone supports, see the “Telephony Features Available for the Phone”
section on page 5-2.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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As with other network devices, you must configure Cisco Unified IP Phones to prepare them to access
Cisco Unified Communications Manager and the rest of the IP network. By using DHCP, you have
fewer settings to configure on a phone, but if your network requires it, you can manually configure an
IP address, TFTP server, and subnet mask. For instructions on configuring the network settings on the
Cisco Unified IP Phones, see Chapter 4, “Configuring Settings on the Cisco Unified IP Phone.”

The Cisco Unified IP Phone can interact with other services and devices on your IP network to provide
enhanced functionality. For example, you can integrate the Cisco Unified IP Phones with the corporate
Lightweight Directory Access Protocol 3 (LDAP3) standard directory to enable users to search for
co-workers contact information directly from their IP phones. You can also use XML to enable users to
access information such as weather, stocks, quote of the day, and other web-based information. For
information about configuring such services, see the “Configuring Corporate Directories” section on
page 5-14 and the “Setting Up Services” section on page 5-16.

Finally, because the Cisco Unified IP Phone is a network device, you can obtain detailed status
information from it directly. This information can assist you with troubleshooting any problems users
might encounter when using their IP phones. See Chapter 7, “Viewing Model Information, Status, and
Statistics on the Cisco Unified IP Phone,” for more information.

Related Topics
e Configuring Settings on the Cisco Unified IP Phone, page 4-1
e Configuring Features, Templates, Services, and Users, page 5-1

e Troubleshooting and Maintenance, page 9-1

Configuring Telephony Features

You can modify certain settings for the Cisco Unified IP Phone from the Cisco Unified Communications
Manager Administration application. Use this web-based application to set up phone registration criteria
and calling search spaces, to configure corporate directories and services, and to modify phone button
templates, among other tasks. See the “Telephony Features Available for the Phone” section on page 5-2
and Cisco Unified Communications Manager Administration Guide for additional information.

For more information about the Cisco Unified Communications Manager Administration application,
refer to Cisco Unified Communications Manager documentation, including Cisco

Unified Communications Manager System Guide. You can also use the context-sensitive help available
within the application for guidance.

You can access the complete Cisco Unified Communications Manager documentation suite at this
location:

http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html

Related Topic
e Telephony Features Available for the Phone, page 5-2

Configuring Network Parameters Using the Cisco Unified IP Phone

You can configure parameters such as DHCP, TFTP, and IP settings on the phone itself. You can also
obtain statistics about a current call or firmware versions on the phone.

For more information about configuring features and viewing statistics from the phone, see Chapter 4,
“Configuring Settings on the Cisco Unified IP Phone,” and see Chapter 7, “Viewing Model Information,
Status, and Statistics on the Cisco Unified IP Phone.”

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Providing Users with Feature Information

If you are a system administrator, you are likely the primary source of information for Cisco Unified IP
Phone users in your network or company. To ensure that you distribute the most current feature and
procedural information, familiarize yourself with Cisco Unified IP Phone documentation. Make sure to
visit the Cisco Unified IP Phone web site:

http://www.cisco.com/en/US/products/hw/phones/ps379/tsd_products_support_series_home.html
From this site, you can access various user guides, including wallet cards.

In addition to providing users with documentation, it is important to inform them about available
Cisco Unified IP Phone features—including features specific to your company or network—and about
how to access and customize those features, if appropriate.

For a summary of some of the key information that phone users need their system administrators to
provide, see Appendix A, “Providing Information to Users Via a Website.”

Understanding Security Features for Cisco Unified IP Phones

Implementing security in the Cisco Unified Communications Manager system prevents identity theft of
the phone and Cisco Unified Communications Manager server, prevents data tampering, and prevents
call signaling and media stream tampering.

To alleviate these threats, the Cisco IP telephony network establishes and maintains authenticated and
encrypted communication streams between a phone and the server, digitally signs files before they are
transferred to a phone, and encrypts media streams and call signaling between Cisco Unified IP phones.

The Cisco Unified IP Phones Series use the Phone Security Profile, which defines whether the device is
nonsecure, authenticated, or encrypted. For information on applying the security profile to the phone,
refer to Cisco Unified Communications Manager Security Guide.

If you configure security-related settings in Cisco Unified Communications Manager Administration,
the phone configuration file will contain sensitive information. To ensure the privacy of a configuration
file, you must configure it for encryption. For detailed information, refer to the “Configuring Encrypted
Phone Configuration Files” chapter in Cisco Unified Communications Manager Security Guide.

Table 1-2 shows where you can find additional information about security in this and other documents.

Table 1-2 Cisco Unified IP Phone and Cisco Unified Communications Manager Security
Topics

Topic Reference

Detailed explanation of security, including set |Refer to Cisco Unified Communications Manager
up, configuration, and troubleshooting Security Guide

information for Cisco Unified Communications
Manager and Cisco Unified IP Phones

Security features supported on the Cisco Unified |See the “Overview of Supported Security Features”

IP Phone section on page 1-11

Restrictions regarding security features See the “Security Restrictions” section on page 1-17

Viewing a security profile name See the “Understanding Security Profiles” section
on page 1-13

Identifying phone calls for which security is See the “Identifying Encrypted and Authenticated
implemented Phone Calls” section on page 1-13
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Table 1-2 Cisco Unified IP Phone and Cisco Unified Communications Manager Security

Topics (continued)

Topic

Reference

TLS connection

See the “What Networking Protocols Are Used?”
section on page 1-4

See the “Understanding Phone Configuration Files”
section on page 2-5

Security and the phone startup process

See the “Understanding the Phone Startup Process”
section on page 2-7

Security and phone configuration files

See the “Understanding Phone Configuration Files”
section on page 2-5

Changing the TFTP Server 1 or TFTP Server 2
option on the phone when security is
implemented

See the Table 4-1“Network Configuration Menu”
section on page 4-5

Understanding security icons in the
Communications Manager 1 through
Communications Manager 5 options in the
Device Configuration Menu on the phone

See the “CallManager Configuration menu” section
on page 4-11

Items on the Security Configuration menu that
you access from the Device Configuration menu
on the phone

See the “Security Configuration Menu” section on
page 4-25

Items on the Security Configuration menu that
you access from the Settings menu on the phone

See the “Security Configuration Menu” section on
page 4-31

Unlocking the CTL file

See the “CTL File Menu” section on page 4-32

Disabling access to web pages for a phone

See the “Disabling and Enabling Web Page Access”
section on page 8-3

Troubleshooting

See the “Troubleshooting Cisco Unified IP Phone
Security” section on page 9-9

Refer to Cisco Unified Communications Manager
Security Guide, Troubleshooting chapter

Deleting the CTL file from the phone

See the “Resetting or Restoring the Cisco Unified IP
Phone” section on page 9-14

Resetting or restoring the phone

See the “Resetting or Restoring the Cisco Unified IP
Phone” section on page 9-14

802.1X Authentication for Cisco Unified IP
Phones

See these sections:

e “Supporting 802.1X Authentication on Cisco
Unified IP Phones” section on page 1-15

e “802.1X Authentication and Status” section on
page 4-34

e “Troubleshooting Cisco Unified IP Phone
Security” section on page 9-9
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Overview of Supported Security Features

Table 1-3

Note

Table 1-3 provides an overview of the security features that the Cisco Unified IP Phone 7965G and
7945G supports. For more information about these features and about Cisco Unified Communications
Manager and Cisco Unified IP Phone security, refer to Cisco Unified Communications Manager
Security Guide.

For information about current security settings on a phone, look at the Security Configuration menus on
the phone (choose Settings > Security Configuration and choose Settings > Device Configuration >
Security Configuration). For more information, see Chapter 4, “Configuring Settings on the Cisco
Unified IP Phone.”

Most security features are available only if a certificate trust list (CTL) is installed on the phone. For
more information about the CTL, refer to “Configuring the Cisco CTL Client” chapter in the Cisco
Unified Communications Manager Security Guide.

Overview of Security Features

Feature

Description

Image authentication

Signed binary files (with the extension .sgn) prevent tampering with the firmware image
before it is loaded on a phone. Tampering with the image causes a phone to fail the
authentication process and reject the new image.

Customer-site certificate Each Cisco Unified IP Phone requires a unique certificate for device authentication.

installation

Phones include a manufacturing installed certificate (MIC), but for additional security,
you can specify in Cisco Unified Communications Manager Administration that a
certificate be installed by using the CAPF (Certificate Authority Proxy Function).
Alternatively, you can install an Locally Significant Certificate (LSC) from the Security
Configuration menu on the phone. See the “Configuring Security on the Cisco Unified IP
Phone” section on page 3-13 for more information.

Device authentication Occurs between the Cisco Unified Communications Manager server and the phone when

each entity accepts the certificate of the other entity. Determines whether a secure
connection between the phone and a Cisco Unified Communications Manager should
occur, and, if necessary, creates a secure signaling path between the entities using
Transport Layer Security (TLS) protocol. Cisco Unified Communications Manager does
not register phones unless they can be authenticated by the

Cisco Unified Communications Manager.

File authentication

Validates digitally signed files that the phone downloads. The phone validates the
signature to make sure that file tampering did not occur after the file creation. Files that
fail authentication are not written to Flash memory on the phone. The phone rejects such
files without further processing.

Signaling Authentication Uses the TLS protocol to validate that no tampering has occurred to signaling packets
during transmission.

Manufacturing installed Each Cisco Unified IP Phone contains a unique manufacturing installed certificate (MIC),

certificate which is used for device authentication. The MIC is a permanent unique proof of identity

for the phone, and allows Cisco Unified Communications Manager to authenticate the
phone.
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Table 1-3

Overview of Security Features (continued)

Feature

Description

Secure SRST reference

(SCCP pohones only)

After you configure a SRST reference for security and then reset the dependent devices in
Cisco Unified Communications Manager Administration, the TFTP server adds the SRST
certificate to the phone cnf.xml file and sends the file to the phone. A secure phone then
uses a TLS connection to interact with the SRST-enabled router.

Media encryption

Uses SRTP to ensure that the media streams between supported devices proves secure and
that only the intended device receives and reads the data. Includes creating a media master
key pair for the devices, delivering the keys to the devices, and securing the delivery of
the keys while the keys are in transport.

Signaling encryption

Ensures that all SCCP signaling messages that are sent between the device and the
Cisco Unified Communications Manager server are encrypted.

CAPF (Certificate Authority
Proxy Function)

Implements parts of the certificate generation procedure that are too processing-intensive
for the phone, and it interacts with the phone for key generation and certificate installation.
The CAPF can be configured to request certificates from customer-specified certificate

authorities on behalf of the phone, or it can be configured to generate certificates locally.

Security profiles

Defines whether the phone is nonsecure, authenticated, or encrypted. See the
“Understanding Security Profiles” section on page 1-13 for more information.

Encrypted configuration files

Lets you ensure the privacy of phone configuration files.

Optional disabling of the web
server functionality for a phone

You can prevent access to a phone’s web page, which displays a variety of operational
statistics for the phone.

Phone hardening

Additional security options, which you control from Cisco Unified Communications
Manager Administration:

e Disabling PC port
e Disabling Gratuitous ARP (GARP)
e Disabling PC Voice VLAN access

e Disabling access to the Setting menus, or providing restricted access that allows
access to the User Preferences menu and saving volume changes only

e Disabling access to web pages for a phone.

Note  Youcan view current settings for the PC Port Disabled, GARP Enabled, and Voice

VLAN enabled options by looking at the phone’s Security Configuration menu.

For more information, see the “Device Configuration Menu” section on page 4-11.

802.1X Authentication

The Cisco Unified IP Phone can use 802.1X authentication to request and gain access to
the network. See the “Supporting 802.1X Authentication on Cisco Unified IP Phones”
section on page 1-15 for more information.

Related Topics

e Understanding Security Profiles, page 1-13

e Identifying Encrypted and Authenticated Phone Calls, page 1-13

e Device Configuration Menu, page 4-11

e Supporting 802.1X Authentication on Cisco Unified IP Phones, page 1-15

e Security Restrictions, page 1-17
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Understanding Security Profiles

Cisco Unified IP Phones that support Cisco Unified Communications Manager 6.0 or later use a security
profile, which defines whether the phone is nonsecure, authenticated, or encrypted. For information
about configuring the security profile and applying the profile to the phone, refer to Cisco Unified
Communications Manager Security Guide.

To view the security mode that is set for the phone, look at the Security Mode setting in the Security
Configuration menu. For more information, see the “Security Configuration Menu” section on
page 4-25.

Related Topics
e Identifying Encrypted and Authenticated Phone Calls, page 1-13

e Device Configuration Menu, page 4-11

e Security Restrictions, page 1-17

Identifying Encrypted and Authenticated Phone Calls

Note

When security is implemented for a phone, you can identify authenticated or encrypted phone calls by
icons on the screen on the phone.

In an authenticated call, all devices participating in the establishment of the call are authenticated by
Cisco Unified Communications Manager. When a call in progress is authenticated, the call progress icon
to the right of the call duration timer in the phone LCD screen changes to this icon:

%

In an encrypted call, all devices participating in the establishment of the call are authenticated by
Cisco Unified Communications Manager. In addition, call signaling and media streams are encrypted.
An encrypted call offers the highest level of security, providing integrity and privacy to the call. When
a call in progress is being encrypted, the call progress icon to the right of the call duration timer in the
phone LCD screen changes to the following icon:

%

If the call is routed through non-IP call legs, for example, PSTN, the call may be nonsecure even though
it is encrypted within the IP network and has a lock icon associated with it.

Related Topic
e Understanding Security Features for Cisco Unified IP Phones, page 1-9

e Understanding Security Profiles, page 1-13

e Security Restrictions, page 1-17
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Establishing and Identifying Secure Conference Calls

You can initiate a secure conference call and monitor the security level of participants. A secure
conference call is established using this process:

1. A user initiates the conference from a secure phone (encrypted or authenticated security mode).
2. Cisco Unified Communications Manager assigns a secure conference bridge to the call.

3. As participants are added, Cisco Unified Communications Manager verifies the security mode of
each phone (encrypted or authenticated) and maintains the secure level for the conference.

4. The phone displays the security level of the conference call. A secure conference displays E:f:é
(encrypted) or @ (authenticated) icon to the right of “Conference” on the phone screen. If [fa icon
displays, the conference is not secure.

~
Note There are interactions, restrictions, and limitations that affect the security level of the conference call

depending on the security mode of the participant’s phones and the availability of secure conference
bridges. See Table 1-4 and Table 1-5 for information about these interactions.

Call Security Interactions and Restrictions

Cisco Unified Communications Manager checks the phone security status when conferences are
established and changes the security indication for the conference or blocks the completion of the call
to maintain integrity and also security in the system. Table 1-4 provides information about changes to
call security levels when using Barge.

Table 1-4 Call Security Interactions When Using Barge

Initiator's Phone

Security Level Feature Used Call Security Level Results of Action

Non-secure Barge Encrypted call Call barged and identified as non-secure call
Secure (encrypted) |Barge Authenticated call Call barged and identified as authenticated call
Secure Barge Encrypted call Call barged and identified as authenticated call
(authenticated)

Non-secure Barge Authenticated call Call barged and identified as non-secure call

Table 1-5 provides information about changes to conference security levels depending on the initiator’s
phone security level, the security levels of participants, and the availability of secure conference bridges.

Table 1-5 Security Restrictions with Conference Calls

Initiator's Phone
Security Level Feature Used Security Level of Participants Results of Action

Non-secure Conference Encrypted or authenticated Non-secure conference bridge

Non-secure conference

Secure (encrypted |Conference At least one member is non-secure Secure conference bridge
or authenticated)

Non-secure conference

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Table 1-5 Security Restrictions with Conference Calls (continued)

Initiator's Phone
Security Level Feature Used Security Level of Participants Results of Action

Secure (encrypted) |Conference All participants are encrypted Secure conference bridge

Secure encrypted level conference

Secure Conference All participants are encrypted or Secure conference bridge

(authenticated) authenticated Secure authenticated level conference

Non-secure Conference Encrypted or authenticated Only secure conference bridge is available
and used

Non-secure conference

Secure (encrypted |Conference Encrypted or authenticated Only non-secure conference bridge is
or authenticated) available and used

Non-secure conference

Secure (encrypted |Conference Secure or encrypted. Conference remains secure

or authenticated) When one participant tries to Hold the call

with MOH, the MOH does not play.

Secure (encrypted) |Join Encrypted or authenticated Secure conference bridge

Conference remains secure (encrypted or
authenticated)

Non-secure cBarge All participants are encrypted Secure conference bridge

Conference changes to non-secure

Non-secure MeetMe Minimum security level is encrypted |Initiator receives message “Does not meet
Security Level”, call rejected.
Secure (encrypted) |MeetMe Minimum security level is Secure conference bridge
authenticated

Conference accepts encrypted and
authenticated calls

Secure (encrypted) |MeetMe Minimum security level is non-secure |Only secure conference bridge available and
used

Conference accepts all calls

Supporting 802.1X Authentication on Cisco Unified IP Phones

These sections provide information about 802.1X support on the Cisco Unified IP Phones:
e Overview, page 1-15
e Required Network Components, page 1-16

e Best Practices—Requirements and Recommendations, page 1-16

Overview
Cisco Unified IP phones and Cisco Catalyst switches have traditionally used Cisco Discovery Protocol
(CDP) to identify each other and to determine parameters such as VLAN allocation and inline power
requirements. However, CDP is not used to identify any locally attached PCs. Therefore, Cisco Unified
Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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IP Phones provide an EAPOL pass-through mechanism, whereby a PC locally attached to the IP phone
may pass through EAPOL messages to the 802.1X authenticator in the LAN switch. This capability
prevents the IP phone from having to act as the authenticator, yet allows the LAN switch to authenticate
a data end point prior to accessing the network.

In conjunction with the EAPOL pass-through mechanism, Cisco Unified IP Phones provide a proxy
EAPOL-Logoff mechanism. If the locally attached PC is disconnected from the IP phone, the LAN
switch would not see the physical link fail, because the link between the LAN switch and the IP phone
is maintained. To avoid compromising network integrity, the IP phone sends an EAPOL-Logoff message
to the switch on behalf of the downstream PC, which triggers the LAN switch to clear the authentication
entry for the downstream PC.

The Cisco Unified IP phones contain an 802.1X supplicant in addition to the EAPOL pass-through
mechanism. This supplicant allows network administrators to control the connectivity of IP phones to
the LAN switch ports. The IP phone 802.1X supplicant implements the EAP-MDS5 option for 802.1X
authentication.

Required Network Components

Support for 802.1X authentication on Cisco Unified IP Phones requires several components, including:

e Cisco Unified IP Phone—The phone acts as the 802.1X supplicant, which initiates the request to
access the network.

e Cisco Secure Access Control Server (ACS) (or other third-party authentication server)—The
authentication server and the phone must both be configured with a shared secret that is used to
authenticate the phone.

e (Cisco Catalyst Switch (or other third-party switch)—The switch must support 802.1X, so it can act
as the authenticator and pass the messages between the phone and the authentication server. When
the exchange is completed, the switch grants or denies the phone access to the network.

Best Practices—Requirements and Recommendations

e Enable 802.1X Authentication—If you want to use the 802.1X standard to authenticate Cisco
Unified IP Phones, make sure that you have properly configured the other components before
enabling it on the phone. See the “802.1X Authentication and Status” section on page 4-34for more
information.

e Configure PC Port—The 802.1X standard does not take into account the use of VLANSs and thus
recommends that only a single device be authenticated to a specific switch port. However, some
switches (including Cisco Catalyst switches) support multi-domain authentication. The switch
configuration determines whether you can connect a PC to the phone PC port.

— Enabled—If you are using a switch that supports multi-domain authentication, you can enable
the PC port and connect a PC to it. In this case, Cisco Unified IP Phones support proxy
EAPOL-Logoff to monitor the authentication exchanges between the switch and the attached
PC. For more information about IEEE 802.1X support on the Cisco Catalyst switches, refer to
the Cisco Catalyst switch configuration guides at:

http://www.cisco.com/en/US/products/hw/switches/ps708/tsd_products_support_series_home.
html
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— Disabled—If the switch does not support multiple 802.1X-compliant devices on the same port,
you should disable the PC Port when 802.1X authentication is enabled. See the “Security
Configuration Menu” section on page 4-25 for more information. If you do not disable this port
and subsequently attempt to attach a PC to it, the switch will deny network access to the phone
and the PC.

¢ Configure Voice VLAN—Because the 802.1X standard does not account for VLANS, you should
configure this setting based on the switch support.

— Enabled—If you are using a switch that supports multi-domain authentication, you can continue
to use the voice VLAN.

— Disabled—If the switch does not support multi-domain authentication, disable the Voice VLAN
and consider assigning the port to the native VLAN. See the “Security Configuration Menu”
section on page 4-25 for more information.

e Enter MD5 Shared Secret—If you disable 802.1X authentication or perform a factory reset on the
phone, the previously configured MDS5 shared secret is deleted. See the “802.1X Authentication and
Status” section on page 4-34 for more information.

Security Restrictions

A user cannot barge into an encrypted call if the phone that is used to barge is not configured for
encryption. When barge fails in this case, a reorder tone (fast busy tone) plays on the phone on which
the user initiated the barge.

If the initiator phone is configured for encryption, the barge initiator can barge into an authenticated or
nonsecure call from the encrypted phone. After the barge occurs, Cisco Unified Communications
Manager classifies the call as nonsecure.

If the initiator phone is configured for encryption, the barge initiator can barge into an encrypted call,
and the phone indicates that the call is encrypted.

A user can barge into an authenticated call, even if the phone that is used to barge is nonsecure. The
authentication icon continues to appear on the authenticated devices in the call, even if the initiator
phone does not support security.

Overview of Configuring and Installing Cisco Unified IP Phones

When deploying a new IP telephony system, system administrators and network administrators must
complete several initial configuration tasks to prepare the network for IP telephony service. For
information and a checklist for setting up and configuring a complete Cisco IP telephony network, refer
to the “System Configuration Overview” chapter in Cisco Unified Communications Manager System
Guide.

After you have set up the IP telephony system and configured system-wide features in Cisco Unified
Communications Manager, you can add IP phones to the system.

The following topics provide an overview of procedures for adding Cisco Unified IP Phones to your
network:

e Configuring Cisco Unified IP Phones in Cisco Unified Communications Manager, page 1-18

¢ Installing Cisco Unified IP Phones, page 1-21
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Configuring Cisco Unified IP Phones in Cisco Unified Communications
Manager

To add phones to the Cisco Unified Communications Manager database, you can use:
e Auto-registration
e Cisco Unified Communications Manager Administration
e Bulk Administration Tool (BAT)
e BAT and the Tool for Auto-Registered Phones Support (TAPS)

For more information about these choices, see the “Adding Phones to the Cisco
Unified Communications Manager Database” section on page 2-8.

For general information about configuring phones in Cisco Unified Communications Manager, refer to
the “Cisco Unified IP Phone” chapter in Cisco Unified Communications Manager System Guide and to
the “Cisco Unified IP Phone Configuration” chapter in Cisco Unified Communications Manager
Administration Guide.
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Checklist for Configuring the Cisco Unified IP Phone 7965G and 7945G in
Cisco Unified Communications Manager

Table 1-6 provides an overview and checklist of configuration tasks for the Cisco Unified IP Phone
7965G and 7945G in Cisco Unified Communications Manager Administration. The list presents a
suggested order to guide you through the phone configuration process. Some tasks are optional,
depending on your system and user needs. For detailed procedures and information, refer to the sources

in the list.
Table 1-6 Checklist for Configuring the Cisco Unified IP Phone 7965G and 7945G in Cisco Unified Communications
Manager
Configuration Step and Purpose For More Information
Step1 |Gather the following information about the phone: Refer to Cisco Unified
e Phone Model Communicgtions ].V[anage.r.
System Guide, “Cisco Unified IP
e MAC address Phone” chapter.
¢ Physical location of the phone See the “Telephony Features
¢ Name or user ID of phone user Available for the Phone” section
. on page 5-2.
e Device pool
e Partition, calling search space, and location information
e Number of lines and associated directory numbers (DN5s) to assign to the
phone
¢ Cisco Unified Communications Manager user to associate with the phone
¢ Phone usage information that affects phone button template, softkey template,
phone features, IP Phone services, or phone applications
Provides list of configuration requirements for setting up phones.
Identifies preliminary configuration that you need to perform before configuring
individual phones, such as phone button templates or softkey templates.
Step2 |Customize phone button templates (if required). Refer to Cisco Unified

Communications Manager
Administration Guide, “Phone
Button Template Configuration”
chapter.

Changes the number of line buttons, speed-dial buttons, Service URL buttons or
adds a Privacy button to meet user needs.

See the “Modifying Phone Button
Templates” section on page 5-15.

Step3 |Add and configure the phone by completing the required fields in the Phone Refer to Cisco Unified
Configuration window. Required fields are indicated by an asterisk (*) next to the |Communications Manager
field name; for example, MAC address and device pool. Administration Guide, “Cisco
Adds the device with its default settings to the Cisco Unified Communications Lilmflted IP Phone Configuration

chapter.

Manager database.
For information about Product
Specific Configuration fields,

refer to “?” Button Help in the
Phone Configuration window.
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Table 1-6

Manager (continued)

Checklist for Configuring the Cisco Unified IP Phone 7965G and 7945G in Cisco Unified Communications

Configuration Step and Purpose

For More Information

Step4 | Add and configure directory numbers (lines) on the phone by completing the Refer to the Cisco Unified
required fields in the Directory Number Configuration window. Required fields |Communications Manager
are indicated by an asterisk (*) next to the field name; for example, directory Administration Guide, Directory
number and presence group. Number Configuration chapter,
Adds primary and secondary directory numbers and features associated with Cr.eatmg a CI_SCO Unity Voice
di Mailbox” section
irectory numbers to the phone.
See the “Telephony Features
Available for the Phone” section
on page 5-2.
Step5 |Customize softkey templates. Refer to Cisco Unified
Adds, deletes, or changes order of softkey features that display on the user’s phone Comr'nz'mlca?wns ]\/{ana‘ger
¢ Administration Guide, “Softkey
o meet feature usage needs. . o
Template Configuration
chapter.
See the “Configuring Softkey
Templates” section on page 5-15.
Step6 |Configure speed-dial buttons and assign speed-dial numbers (optional). Refer to Cisco Unified
Adds speed-dial buttons and numbers. Coml.m.mlca{lons Manag er
Administration Guide, “Cisco
Users can change speed-dial settings on their phones by using Cisco Unified CM | Unified IP Phone Configuration”
User Options. chapter, “Configuring
Speed-Dial Buttons” section.
Step7 |Configure Cisco Unified IP Phone services and assign services (optional). Refer to Cisco Unified
Provides IP Phone services. Comi.nl.mlcafzons Manag er
Administration Guide, “Cisco
Users can add or change services on their phones by using the Cisco Unified CM |Unified IP Phone Services
User Options. Configuration” chapter.
See the “Setting Up Services”
section on page 5-16.
Step8 | Assign services to phone buttons (optional). Refer to Cisco Unified
Provides single button access to an IP phone service or URL. Comr'nz'mlca?wns ]V{anagei.’
Administration Guide, “Cisco
Unified IP Phone Configuration”
chapter, “Adding a Cisco
Unified IP Phone Service to a
Phone Button” section.
Step9 |Add user information by configuring required fields. Required fields are indicated |Refer to Cisco Unified

by an asterisk (*); for example, User ID and last name.

Note  Assign a password (for User Options web pages) and PIN (for Extension

Mobility and Personal Directory)

Adds user information to the global directory for Cisco Unified Communications
Manager.

Communications Manager
Administration Guide, “End User
Configuration” chapter.

See the “Adding Users to Cisco
Unified Communications
Manager” section on page 5-16
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Table 1-6 Checklist for Configuring the Cisco Unified IP Phone 7965G and 7945G in Cisco Unified Communications
Manager (continued)

Configuration Step and Purpose For More Information

Step 10 | Associate a user to a user group. Refer to Cisco Unified

Communications Manager
Administration Guide:

¢ “End User Configuration”
chapter, “End User
Configuration Settings”
section

e “User Group Configuration”
chapter, “Adding Users to a
User Group” section.

Step 11 | Associate a user with a phone (optional). Refer to Cisco Unified
Communications Manager
Administration Guide, “End User

Configuration” chapter,
Note  Some phones, such as those in conference rooms, do not have an “Associating Devices to a User”

associated user. section.

Provides users with control over their phone such a forwarding calls or adding
speed-dial numbers or services.

Installing Cisco Unified IP Phones

After you have added the phones to the Cisco Unified Communications Manager database, you can
complete the phone installation. You (or the phone users) can install the phone at the users’s location.
The Cisco Unified IP Phone Installation Guide, which is provided on the cisco.com web site, provides
directions for connecting the phone handset, cables, and other accessories.

Note  Before you install a phone, even if it is new, upgrade the phone to the current firmware image. For
information about upgrading, refer to the Readme file for your phone, which is located at:

http://www.cisco.com/cgi-bin/tablebuild.pl/ip-7900ser

After the phone is connected to the network, the phone startup process begins, and the phone registers
with Cisco Unified Communications Manager. To finish installing the phone, configure the network
settings on the phone depending on whether you enable or disable DHCP service.

If you used auto-registration, you need to update the specific configuration information for the phone
such as associating the phone with a user, changing the button table, or directory number.
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Checklist for Installing the Cisco Unified IP Phone 7965G and 7945G

Table 1-7 provides an overview and checklist of installation tasks for the Cisco Unified IP Phone 7965G
and 7945G. The list presents a suggested order to guide you through the phone installation. Some tasks
are optional, depending on your system and user needs. For detailed procedures and information, refer
to the sources in the list.

Table 1-7 Checkilist for Installing the Cisco Unified IP Phone 7965G and 7945G
Configuration Step and Purpose For More Information
Step 1 Choose the power source for the phone: See the “Providing Power to the Phone” section on
e Power over Ethernet (PoE) page 2-3.
e External power supply
Determines how the phone receives power.
Step 2 Assemble the phone, adjust phone placement, and See the “Installing the Cisco Unified IP Phone” section
connect the network cable. on page 3-6.
Locates and installs the phone in the network. See the “Adjusting the Placement of the Cisco Unified IP

Phone” section on page 3-9.

Step 3 Add a Cisco Unified IP Phone Expansion Module See the “Attaching the Cisco Unified IP Phone
7914 to the Cisco Unified IP Phone 7965G and 7945G |Expansion Module 7914 (SCCP Phones Only)” section
(optional). on page 3-8.

Adds the device with its default settings to the Cisco
Unified Communications Manager database.

Extends functionality of a Cisco Unified IP Phone
Cisco Unified IP Phone 7965G and 7945G by adding
14 line appearances or speed dial numbers.

Step 4 Monitor the phone startup process. See the “Verifying the Phone Startup Process” section on

Adds primary and secondary directory numbers and page 3-12.

features associated with directory numbers to the
phone.

Verifies that phone is configured properly.
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Checklist for Installing the Cisco Unified IP Phone 7965G and 7945G (continued)

Configuration Step and Purpose

For More Information

Step 5

Configure these network settings on the phone by
choosing Settings > Network Configuration.

To enable DHCP:
e Set DHCP Enabled to Yes

e To use an alternate TFTP server, set Alternate
TFTP Server to Yes
Enter IP address for TFTP Server 1

To disable DHCP:
e Set DHCP Enabled to No
¢ Enter static IP address for phone
e Enter subnet mask
e Enter default router IP addresses
e Enter domain name where phone resides

Set Alternate TFTP Server to Yes
Enter IP address for TFTP Server 1.

Using DHCP—The IP address is automatically
assigned, and the Cisco Unified IP Phone is directed
to a TFTP Server.

Note  Consult with the network administrator if you
need to assign an alternative TFTP server
instead of using the TFTP server assigned by
DHCP.

Without DHCP—You must configure the IP address,
TFTP server, subnet mask, domain name, and default
router locally on the phone.

See the “Configuring Startup Network Settings” section
on page 3-13.

See the “Network Configuration Menu” section on
page 4-5.

Step 6

Set up security on the phone.

Provides protection against data tampering threats and
identity theft of phones.

See the “Configuring Security on the Cisco Unified IP
Phone” section on page 3-13.

Step 7

Make calls with the Cisco Unified IP Phone.

Verifies that the phone and features work correctly.

Refer to Cisco Unified IP Phone 7965G and 7945G
Guide for Cisco Unified Communications Manager 6.0
(SCCP and SIP)

Step 8

Provide information to end users about how to use

their phones and how to configure their phone options.

Ensures that users have adequate information to
successfully use their Cisco Unified IP Phones.

See Appendix A, “Providing Information to Users Via a
Website.”
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Preparing to Install the Cisco Unified IP Phone on
Your Network

Cisco Unified IP Phones enable you to communicate by using voice over a data network. To provide this
capability, the IP Phones depend upon and interact with several other key Cisco IP Telephony and
network components, including Cisco Unified Communications Manager, DNS and DHCP servers,
TFTP servers, media resources, Cisco prestandard PoE, and so on.

This chapter focuses on the interactions between the Cisco Unified IP Phone 7965G and 7945G and
Cisco Unified Communications Manager, DNS and DHCP servers, TFTP servers, and switches. It also
describes options for powering phones.

For related information about voice and IP communications, refer to this URL:
http://www.cisco.com/en/US/partner/products/sw/voicesw/index.html

This chapter provides an overview of the interaction between the Cisco Unified IP Phone 7965G and
7945G and other key components of the Voice over IP (VoIP) network. It includes these topics:

e Understanding Interactions with Other Cisco Unified IP Communications Products, page 2-1
¢ Providing Power to the Phone, page 2-3

¢ Understanding Phone Configuration Files, page 2-5

e Understanding the Phone Startup Process, page 2-7

e Adding Phones to the Cisco Unified Communications Manager Database, page 2-8

e Using Cisco Unified IP Phones with Different Protocols, page 2-11

e Determining the MAC Address of a Cisco Unified IP Phone, page 2-13

Understanding Interactions with Other Cisco Unified
IP Communications Products

To function in the IP telephony network, the Cisco Unified IP Phone must be connected to a networking
device, such as a Cisco Catalyst switch. You must also register the Cisco Unified IP Phone with a
Cisco Unified Communications Manager system before sending and receiving calls.

This section includes these topics:

e Understanding How the Cisco Unified IP Phone Interacts with Cisco Unified Communications
Manager, page 2-2

e Understanding How the Cisco Unified IP Phone Interacts with the VLAN, page 2-2
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Understanding How the Cisco Unified IP Phone Interacts with Cisco
Unified Communications Manager

Note

Cisco Unified Communications Manager is an open and industry-standard call processing system.
Cisco Unified Communications Manager software sets up and tears down calls between phones,
integrating traditional PBX functionality with the corporate IP network. Cisco Unified Communications
Manager manages the components of the IP telephony system—the phones, the access gateways, and the
resources necessary for features such as call conferencing and route planning. Cisco Unified
Communications Manager also provides:

e Firmware for phones

e Authentication and encryption (if configured for the telephony system)
e Configuration file and CTL file, via TFTP service

¢ Phone registration

e (all preservation, so that a media session continues if signaling is lost between the primary
Communications Manager and a phone

For information about configuring Cisco Unified Communications Manager to work with the IP devices
described in this chapter, refer to Cisco Unified Communications Manager Administration Guide, Cisco
Unified Communications Manager System Guide, and Cisco Unified Communications Manager Security
Guide.

For an overview of security functionality for the Cisco Unified IP Phone, see the “Understanding
Security Features for Cisco Unified IP Phones” section on page 1-9.

If the Cisco Unified IP Phone model that you want to configure does not appear in the Phone Type
drop-down list in Cisco Unified Communications Manager Administration, go to the following URL and
install the latest support patch for your version of Cisco Unified Communications Manager:

http://www.cisco.com/kobayashi/sw-center/sw-voice.shtml

Related Topic
e Telephony Features Available for the Phone, page 5-2

Understanding How the Cisco Unified IP Phone Interacts with the VLAN

The Cisco Unified IP Phone 7965G and 7945G has an internal Ethernet switch, enabling forwarding of
packets to the phone, and to the access port and the network port on the back of the phone.

If a computer is connected to the access port, the computer and the phone share the same physical link
to the switch and share the same port on the switch. This shared physical link has the following
implications for the VLAN configuration on the network:

e The current VLANs might be configured on an IP subnet basis. However, additional IP address
might not be available to assign the phone to the same subnet as other devices connect to the same
port.

e Data traffic present on the data/native VLAN may reduce the quality of Voice-over-IP traffic.

e Network security may indicate a need to isolate the VLAN voice traffic from the VLAN data traffic.
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You can resolve these issues by isolating the voice traffic onto a separate VLAN. The switch port that
the phone is connected to would be configured to have separate VLANSs for carrying:

e Voice traffic to and from the IP phone (auxiliary VLAN, on the Cisco Catalyst 6000 series, for
example)

e Data traffic to and from the PC connected to the switch through the access port of the IP phone
(native VLAN)

Isolating the phones on a separate, auxiliary VLAN improves the quality of the voice traffic and allows
a large number of phones to be added to an existing network where there are not enough IP addresses
for each phone.

For more information, refer to the documentation included with a Cisco switch. You can also access
related documentation at this URL:

http://www.cisco.com/en/US/products/hw/switches/tsd_products_support_category_home.html

Related Topics
e Understanding the Phone Startup Process, page 2-7

e Network Configuration Menu, page 4-5

Providing Power to the Phone

Note

The Cisco Unified IP Phone 7965G and 7945G can be powered with external power or with Power over
Ethernet (PoE). External power is provided through a separate power supply. PoE is provided by a
switch through the Ethernet cable attached to a phone.

When you install a phone that is powered with external power, connect the power supply to the phone
and to a power outlet before you connect the Ethernet cable to the phone. When you remove a phone that
is powered with external power, disconnect the Ethernet cable from the phone before you disconnect the
power supply.

The following sections provide more information about powering a phone:
e Power Guidelines, page 2-4
e Phone Power Consumption and Display Brightness, page 2-4
e Power Outage, page 2-5

e Obtaining Additional Information about Power, page 2-5
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Power Guidelines

Table 2-1 provides guidelines that apply to external power and to PoE power for the Cisco Unified IP
Phone 7965G and 7945G.

Table 2-1 Guidelines for Powering the Cisco Unified IP Phone 7965G and 7945G
Power Type Guidelines
External power— Provided e The Cisco Unified IP Phone Series use the CP-PWR-CUBE-3 power supply.

through the CP-PWR-CUBE-3
external power supply

External power— The Cisco Unified IP Phone Power Injector may be used with any Cisco Unified IP
Provided through the Cisco Unified |Phone. Functioning as a midspan device, the injector delivers inline power to the
IP Phone Power Injector attached phone. The Cisco Unified IP Phone Power Injector is connected between a

switch port and the IP Phone, and supports a maximum cable length of 100m between
the unpowered switch and the IP Phone.

IEEE 802.3af PoE e The Cisco Unified IP Phone 7965G and 7945G support IEEE 802.3af Class 3 power
power—Provided by a switch on signal pairs and spare pairs.

:hrgl”ghhthe Ethernet cableattached |, . iseo Unified IP Phone 7965G and 7945G do not support Cisco inline PoE.
o the phone

e To ensure uninterruptible operation of the phone, make sure that the switch has a
backup power supply.

e Make sure that the CatOS or IOS version running on your switch supports your
intended phone deployment. Refer to the documentation for your switch for
operating system version information.

Phone Power Consumption and Display Brightness

The power consumed by a phone depends on its power configuration. See Table 2-1 for a power
configuration overview. See Table 2-2 for the maximum power consumed by a phone for each
configuration option and the correlating phone screen brightness level.

Note  Power consumption values shown in the table include power losses in the cable that connects the phone
to the switch.

Table 2-2 Power Consumption and Display Brightness for Power Configurations
Max. Power |Phone
Consumed Screen
Phone Model Power Configuration from a Switch |Brightness
Cisco Unified IP Phone IEEE 802.3af Class 3 power from a Cisco switch, with 12W Full
7965G and 7945G bidirectional power negotiation enabled
External power — Full
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Power OQutage

Your accessibility to emergency service through the phone is dependent on the phone being powered. If
there is an interruption in the power supply, Service and Emergency Calling Service dialing will not
function until power is restored. In the case of a power failure or disruption, you may need to reset or
reconfigure equipment before using the Service or Emergency Calling Service dialing.

Obtaining Additional Information about Power

For related information about power, refer to the documents shown in Table 2-3. These documents
provide information about these topics:

e Cisco switches that work with the Cisco Unified IP Phone 7965G and 7945G
e The Cisco IOS releases that support bidirectional power negotiation

e Other requirements and restrictions regarding power

Table 2-3 Related Documentation for Power

Document Topics URL

Cisco Unified IP Phone Power |http://http://www.cisco.com/en/US/products/ps6951/index.html
Injector

PoE Solutions http://www.cisco.com/en/US/netsol/
ns340/ns394/ns147/ns412/networking_solutions_package.html
Cisco Catalyst Switches http://www.cisco.com/univercd/cc/td/
doc/product/lan/index.htm
Integrated Service Routers http://www.cisco.com/en/US/products/hw/routers/index.html
Cisco IOS Software http://www.cisco.com/en/US/products/sw/iosswrel/products_ios_c

isco_ios_software_category_home.html

Understanding Phone Configuration Files

Configuration files for a phone are stored on the TFTP server and define parameters for connecting to
Cisco Unified Communications Manager. In general, any time you make a change in Cisco Unified
Communications Manager that requires the phone to be reset, a change is automatically made to the
phone’s configuration file.

Configuration files also contain information about which image load the phone should be running. If this
image load differs from the one currently loaded on a phone, the phone contacts the TFTP server to
request the required load files. (These files are digitally signed to ensure the authenticity of the files’
source.)

In addition, if the device security mode in the configuration file is set to Authenticated and the CTL file
on the phone has a valid certificate for Cisco Unified Communications Manager, the phone establishes
a TLS connection to Cisco Unified Communications Manager. Otherwise, the phone establishes a TCP
connection. For SIP phones, a TLS connection requires that the transport protocol in the phone
configuration file be set to TLS, which corresponds to the transport type in the SIP Security Profile in
Cisco Unified Communications Manager Administration.
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Note If the device security mode in the configuration file is set to Authenticated or Encrypted, but the phone
has not received a CTL file, the phone will continuously try to obtain a CTL file, so that it can register
securely.

If you configure security-related settings in Cisco Unified Communications Manager Administration,
the phone configuration file will contain sensitive information. To ensure the privacy of a configuration
file, you must configure it for encryption. For detailed information, refer to the “Configuring Encrypted
Phone Configuration Files” chapter in Cisco Unified Communications Manager Security Guide. A
phone requests a configuration file whenever it resets and registers with Cisco Unified Communications
Manager.

A phone accesses a default configuration file named XmlDefault.cnf.xml from the TFTP server when
the following conditions exist:

* You have enabled auto-registration in Cisco Unified Communications Manager
¢ The phone has not been added to the Cisco Unified Communications Manager Database
¢ The phone is registering for the first time

If auto registration is not enabled and the phone has not been added to the Cisco Unified
Communications Manager database, the phone registration request will be rejected. In this case, the
phone will reset and attempt to register repeatedly.

If the phone has registered before, the phone will access the configuration file named
SEPmac_address.cnf.xml, where mac_address is the MAC address of the phone.

The TFTP server generates these SIP configuration files:
e SIP IP Phone:
— For unsigned and unencrypted files—SEP<mac>.cnf.xml
— For signed files—SEP<mac>.cnf.xml.sgn
— For signed and encrypted files—SEP<mac>.cnf.xml.enc.sgn
e Dial Plan—<dialplan>.xml
e Softkey Template—<softkey_template>.xml

The filenames are derived from the MAC Address and Description fields in the Phone Configuration
window of Cisco Unified Communications Manager. The MAC address uniquely identifies the phone.
For more information refer to the Cisco Unified Communications Manager Administration Guide.
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Understanding the Phone Startup Process

When connecting to the VoIP network, the Cisco Unified IP Phone 7965G and 7945G goes through a
standard startup process, as described in Table 2-4. Depending on your specific network configuration,
not all of these process steps may occur on your Cisco Unified IP Phone.

Table 2-4

Cisco Unified IP Phone Startup Process

Understanding the Phone Startup Process W

Configuration Step and Description

Related Topics

Step1 |Obtaining Power from the Switch. See the “Providing Power to the
If a phone is not using external power, the switch provides in-line power Phone™ section on page 2-3.
through the Ethernet cable that is attached to the phone. See the “Resolving Startup Problems”
section on page 9-2.
Step2 |Loading the Stored Phone Image. See the “Resolving Startup Problems”
The Cisco Unified IP Phone 7965G and 7945G has non-volatile flash section on page 9-2.
memory in which it stores firmware images and user-defined preferences. At
startup, the phone runs a bootstrap loader that loads a phone image stored in
flash memory. Using this image, the phone initializes its software and
hardware.
Step3 |Configuring VLAN. See the “Network Configuration
If the Cisco Unified IP Phone 7965G and 7945G is connected to a Cisco Menu™ section on page 4-5.
switch, the switch next informs the phone of the voice VLAN defined on the |See the “Resolving Startup Problems”
switch port. The phone needs to know its VLAN membership before it can |section on page 9-2.
proceed with the Dynamic Host Configuration Protocol (DHCP) request for
an IP address.
Step4 |Obtaining an IP Address. See the “Network Configuration
If the Cisco Unified TP Phone 7965G and 7945G is using DHCP to obtain an | MenU~ section on page 4-5.
IP address, the phone queries the DHCP server to obtain one. If you are not |See the “Resolving Startup Problems”
using DHCP in your network, you must assign static IP addresses to each  |section on page 9-2.
phone locally.
Step5 |Accessing a TFTP Server. See the “Network Configuration
In addition to assigning an IP address, the DHCP server directs the Cisco Menu™ section on page 4-5.
Unified IP Phone to a TFTP Server. If the phone has a statically defined IP |See the “Resolving Startup Problems”
address, you must configure the TFTP server locally on the phone; the phone |section on page 9-2.
then contacts the TFTP server directly.
Note  You can also assign an alternative TFTP server to use instead of the
one assigned by DHCP.
Step6 |Requesting the CTL file. Refer to Cisco Unified
The TFTP server stores the certificate trust list (CTL) file. This file contains ((;:ozmu‘r‘z(z:cat?ms Manﬁg eCr.Secué’a{)I:
a list of Cisco Unified Communications Managers and TFTP servers that the Clbfl © , hon 1guring the Cisco
phone is authorized to connect to. It also contains the certificates necessary fent” chapter.
for establishing a secure connection between the phone and Cisco Unified
Communications Manager.
Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Table 2-4 Cisco Unified IP Phone Startup Process (continued)
Configuration Step and Description Related Topics
Step7 |Requesting the Configuration File. See the “Understanding Phone
The TFTP server has configuration files, which define parameters for Conﬁ;gusratlon Files™ section on
page 2-5.

connecting to Cisco Unified Communications Manager and other
information for the phone. See the “Resolving Startup Problems”
section on page 9-2.

Step8 |Contacting Cisco Unified Communications Manager. See the “Resolving Startup Problems”

The configuration file defines how the Cisco Unified IP Phone section on page 9-2.

communicates with Cisco Unified Communications Manager and provides a
phone with its load ID. After obtaining the file from the TFTP server, the
phone attempts to make a connection to the highest priority Cisco

Unified Communications Manager on the list. If security is implemented,
the phone makes a TLS connection. Otherwise, it makes a non-secure TCP
connection.

If the phone was manually added to the database, Cisco

Unified Communications Manager identifies the phone. If the phone was not
manually added to the database and auto-registration is enabled in Cisco
Unified Communications Manager, the phone attempts to auto-register itself
in the Cisco Unified Communications Manager database.

Note  Auto-registration is disabled when security is enabled on Cisco
Unified Communications Manager. In this case, the phone must be
manually added to the Cisco Unified Communications Manager
database.

Adding Phones to the Cisco Unified Communications Manager
Database

Before installing the Cisco Unified IP phone, you must choose a method for adding phones to the
Cisco Unified Communications Manager database. These sections describe the methods:

e Adding Phones with Auto-Registration, page 2-9
e Adding Phones with Auto-Registration and TAPS, page 2-10
¢ Adding Phones with Cisco Unified Communications Manager Administration, page 2-11

e Adding Phones with BAT, page 2-11
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Adding Phones to the Cisco Unified Communications Manager Database W

Table 2-5 provides an overview of these methods for adding phones to the Cisco Unified
Communications Manager database.

Table 2-5 Methods for Adding Phones to the Cisco Unified Communications Manager
Database

Requires MAC
Method Address? Notes

Auto-registration No e Provides no control over directory number
assignment to phone.

¢ Not available when security or encryption is
enabled.

Auto-registration with TAPS No Requires auto-registration and the Bulk
Administration Tool (BAT); updates the Cisco
Unified Communications Manager database with
the MAC address and DNs for the device when
user calls TAPS from the phone.

Using the Cisco Unified Yes Requires phones to be added individually
Communications Manager

Administration

Using BAT Yes Can add groups of same model of phone.

Can schedule when phones are added to the Cisco
Unified Communications Manager database.

Adding Phones with Auto-Registration

By enabling auto-registration before you begin installing phones, you can:
¢ Add phones without first gathering MAC addresses from the phones.

e Automatically add a Cisco Unified IP Phone to the Cisco Unified Communications Manager
database when you physically connect the phone to your IP telephony network. During
auto-registration, Cisco Unified Communications Manager assigns the next available sequential
directory number to the phone.

¢ Quickly enter phones into the Cisco Unified Communications Manager database and modify any
settings, such as the directory numbers, from Cisco Unified Communications Manager.

¢ Move auto-registered phones to new locations and assign them to different device pools without
affecting their directory numbers.

Note  Cisco recommends you use auto-registration to add less than 100 phones to your network. To add more
than 100 phones to your network, use the Bulk Administration Tool (BAT). See the “Adding Phones
with BAT” section on page 2-11.

Auto-registration is disabled by default. In some cases, you might not want to use auto-registration; for
example, if you want to assign a specific directory number to the phone, or if you plan to implement
authentication or encryption, as described in Cisco Unified Communications Manager Security Guide.
For information about enabling auto-registration, refer to “Enabling Auto-Registration” in the Cisco
Unified Communications Manager Administration Guide.
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Note  When you configure the cluster for mixed mode through the Cisco CTL client, auto-registration is
automatically disabled. When you configure the cluster for non-secure mode through the Cisco CTL
client, auto-registration is automatically enabled.

Related Topics
e Adding Phones with Auto-Registration and TAPS, page 2-10
¢ Adding Phones with Cisco Unified Communications Manager Administration, page 2-11

¢ Adding Phones with BAT, page 2-11

Adding Phones with Auto-Registration and TAPS

You can add phones with auto-registration and TAPS, the Tool for Auto-Registered Phones Support,
without first gathering MAC addresses from phones.

TAPS works with the Bulk Administration Tool (BAT) to update a batch of phones that were already
added to the Cisco Unified Communications Manager database with dummy MAC addresses. Use TAPS
to update MAC addresses and download pre-defined configurations for phones.

Note  Ciscorecommends you use auto-registration and TAPS to add less than 100 phones to your network. To
add more than 100 phones to your network, use the Bulk Administration Tool (BAT). See the “Adding
Phones with BAT” section on page 2-11.

To implement TAPS, you or the end-user dial a TAPS directory number and follow voice prompts. When
the process is complete, the phone will have downloaded its directory number and other settings, and the
phone will be updated in Cisco Unified Communications Manager Administration with the correct MAC
address.

Auto-registration must be enabled in Cisco Unified Communications Manager Administration
(System > Cisco Unified Communications Manager) for TAPS to function.

Note  When you configure the cluster for mixed mode through the Cisco CTL client, auto-registration is
automatically disabled. When you configure the cluster for non-secure mode through the Cisco CTL
client, auto-registration is automatically enabled.

Refer to Cisco Unified Communications Manager Bulk Administration Guide for detailed instructions
about BAT and about TAPS.

Related Topics
e Adding Phones with Auto-Registration, page 2-9

¢ Adding Phones with Cisco Unified Communications Manager Administration, page 2-11

¢ Adding Phones with BAT, page 2-11
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Adding Phones with Cisco Unified Communications Manager Administration

You can add phones individually to the Cisco Unified Communications Manager database using
Cisco Unified Communications Manager Administration. To do so, you first need to obtain the MAC
address for each phone.

For information about determining a MAC address, see the “Determining the MAC Address of a Cisco
Unified IP Phone” section on page 2-13.

After you have collected MAC addresses, in Cisco Unified Communications Manager Administration,
choose Device > Phone and click Add New to begin.

For complete instructions and conceptual information about Cisco Unified Communications Manager,
refer to Cisco Unified Communications Manager Administration Guide and to Cisco Unified
Communications Manager System Guide.

Related Topics
e Adding Phones with Auto-Registration, page 2-9
e Adding Phones with Auto-Registration and TAPS, page 2-10
¢ Adding Phones with BAT, page 2-11

Adding Phones with BAT

Cisco Unified Communications Manager Bulk Administration Tool (BAT), a standard Cisco Unified
Communications Manager application, enables you to perform batch operations, including registration,
on multiple phones.

To add phones by using BAT only (not in conjunction with TAPS), you first need to obtain the
appropriate MAC address for each phone.

For information about determining a MAC address, see the “Determining the MAC Address of a Cisco
Unified IP Phone” section on page 2-13.

For detailed instructions about using BAT, refer to Cisco Unified Communications Manager Bulk
Administration Guide.

Related Topics
e Adding Phones with Auto-Registration, page 2-9
e Adding Phones with Auto-Registration and TAPS, page 2-10

¢ Adding Phones with Cisco Unified Communications Manager Administration, page 2-11

Using Cisco Unified IP Phones with Different Protocols

The Cisco Unified IP Phone can operate with SCCP (Skinny Client Control Protocol) or SIP (Session
Initiation Protocol). You can convert a phone that is using one protocol for use with the other protocol.

This section includes these topics:
e Converting a New Phone from SCCP to SIP, page 2-12
e Converting an In-Use Phone from SCCP to SIP, page 2-12
e Converting an In-Use Phone from SIP to SCCP, page 2-12
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e Deploying a Phone in an SCCP and SIP Environment, page 2-13

Converting a New Phone from SCCP to SIP

A new, unused phone is set for SCCP by default. To convert this phone to SIP, perform these steps:

Procedure

Step 1 Take one of these actions:

e To auto-register the phone, set the Auto Registration Phone Protocol enterprise parameter in
Cisco Unified Communications Manager Administration to SIP.

e To provision the phone by using the Bulk Administration Tool (BAT), choose the appropriate phone
model and choose SIP from BAT.

e To provision the phone manually, make the appropriate changes for SIP on the Phone Configuration
window in Cisco Unified Communications Manager Administration.

Refer to Cisco Unified Communications Manager Administration Guide for detailed information about
Cisco Unified Communications Manager configuration. Refer to Cisco Unified Communications
Manager Bulk Administration Guide for detailed information about using BAT.

Step2  If you are not using DHCP in your network, configure the network parameters for the phone.
See the “Configuring Startup Network Settings” section on page 3-14.

Step3  Save the configuration updates and reset the phone.

Converting an In-Use Phone from SCCP to SIP

You can use the Bulk Administration Tool (BAT) to convert a phone that is in use in your network from
SCCP to SIP. To access BAT from Cisco Unified Communications Manager Administration, choose
Bulk Administration > Phones > Migrate Phones > SCCP to SIP. For detailed information, refer to
Cisco Unified Communications Manager Bulk Administration Guide.

Converting an In-Use Phone from SIP to SCCP

To convert a phone that is in use in your network from SIP to SCCP, perform these steps. For more
information, Cisco Unified Communications Manager Administration Guide.

Procedure

Step1  In Cisco Unified Communications Manager Administration, delete the existing SIP phone from the
Cisco Unified Communications Manager database.

Step2  In Cisco Unified Communications Manager Administration, create the phone as an SCCP phone.

Step3  Power cycle the phone.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Deploying a Phone in an SCCP and SIP Environment

To deploy Cisco Unified IP Phones in an environment that includes SCCP and SIP and in which the
Cisco Unified Communications Manager Auto-Registration parameter is SCCP, perform these general
steps:

1.

Set the Cisco Unified Communications Manager Auto Registration Protocol enterprise parameter to
SCCP.

From Cisco Unified Communications Manager Administration, choose System > Enterprise
Parameters.

Install the phones.
Change the Auto Registration Protocol enterprise parameter to SIP.

Auto-register the SIP phones.

Determining the MAC Address of a Cisco Unified IP Phone

Several of the procedures that are described in this manual require you to determine the MAC address
of a Cisco Unified IP Phone. You can determine the MAC address for a phone in any of these ways:

From the phone, choose Settings > Network Configuration and look at the MAC Address field.
Look at the MAC label on the back of the phone.
Display the web page for the phone and click the Device Information hyperlink.

For information about accessing the web page, see the “Accessing the Web Page for a Phone”
section on page 8-2.
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Setting Up the Cisco Unified IP Phone

This chapter includes the following topics, which help you install the Cisco Unified IP Phone 7965G and
7945G on an IP telephony network:

e Before You Begin, page 3-1

e Understanding the Cisco Unified IP Phone 7965G and 7945G Components, page 3-3

¢ Installing the Cisco Unified IP Phone, page 3-6

e Attaching the Cisco Unified IP Phone Expansion Module 7914 (SCCP Phones Only), page 3-8
e Adjusting the Placement of the Cisco Unified IP Phone, page 3-9

e Verifying the Phone Startup Process, page 3-12

e Configuring Startup Network Settings, page 3-13

¢ Configuring Security on the Cisco Unified IP Phone, page 3-13

Note  Before you install a Cisco Unified IP phone, you must decide how to configure the phone in your
network. Then you can install the phone and verify its functionality. For more information, see
Chapter 2, “Preparing to Install the Cisco Unified IP Phone on Your Network.”

Before You Begin

Before installing the Cisco Unified IP Phone, review the requirements in these sections:
e Network Requirements, page 3-2
e Cisco Unified Communications Manager Configuration, page 3-2

e Safety, page 3-2
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Network Requirements

For the Cisco Unified IP Phone 7965G and 7945G to successfully operate as a Cisco Unified IP Phone
endpoint in your network, your network must meet these requirements:

e Working Voice over IP (VoIP) network:
— VolIP configured on your Cisco routers and gateways

— Cisco Unified Communications Manager Release 6.0 or higher installed in your network and
configured to handle call processing

e [P network that supports DHCP or manual assignment of IP address, gateway, and subnet mask

~

Note  The Cisco Unified IP Phone displays the date and time from Cisco Unified Communications Manager.
If the Cisco Unified Communications Manager server is located in a different time zone than the phones,
the phones will not display the correct local time.

Cisco Unified Communications Manager Configuration

The Cisco Unified IP Phone requires Cisco Unified Communications Manager to handle call
processing. Refer to Cisco Unified Communications Manager Administration Guide or to
context-sensitive help in the Cisco Unified Communications Manager application to ensure that
Cisco Unified Communications Manager is set up properly to manage the phone and to properly route
and process calls.

If you plan to use auto-registration, verify that it is enabled and properly configured in

Cisco Unified Communications Manager before connecting any Cisco Unified IP Phone to the network.
For information about enabling and configuring auto-registration, refer to Cisco

Unified Communications Manager Administration Guide. Also, see the “Adding Phones to the Cisco
Unified Communications Manager Database” section on page 2-8.

You must use Cisco Unified Communications Manager to configure and assign telephony features to the
Cisco Unified IP Phones. See the “Telephony Features Available for the Phone” section on page 5-2 for
details.

In Cisco Unified Communications Manager, you can add users to the database and associate them with
specific phones. In this way, users gain access to web pages that allow them to configure items such as
call forwarding, speed dialing, and voice messaging system options. See the “Adding Users to Cisco
Unified Communications Manager” section on page 5-16 for details.

Safety

Review the following warnings before installing the Cisco Unified IP Phone 7965G and 7945G. To see
translations of these warnings, refer to the Regulatory Compliance and Safety Information for the Cisco
Unified IP Phone 7900 Series document that accompanied this device.

>

Warning  Read the installation instructions before you connect the system to its power source.

>

Warning  Only trained and qualified personnel should be allowed to install, replace, or service this equipment.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Ultimate disposal of this product should be handled according to all national laws and regulations.

Do not work on the system or connect or disconnect cables during periods of lightning activity.

>

To avoid electric shock, do not connect safety extra low voltage (SELV) circuits to telephone network
voltage (TNV) circuits. LAN ports contain SELV circuits, and WAN ports contain TNV circuits. Some
LAN and WAN ports both use RJ-45 connectors. Use caution when connecting cables.

Caution

Inline power circuits provide current over the cable. Use the Cisco provided cable or a minimum 24
AWG communication cable.

The following warnings apply when you use an external power supply.

Caution

>

Warning

>

Warning

>

Warning

Only use the proper Cisco approved external power supply. Reference the installation manual provided
with the phone.

This product relies on the building's installation for short-circuit (overcurrent) protection. Ensure that
a fuse or circuit breaker no larger than 120 VAC, 15 A U.S. (240 VAC, 10 A international) is used on the
phase conductors (all current-carrying conductors).

The device is designed to work with TN power systems.

The plug-socket combination must be accessible at all times because it serves as the main
disconnecting device.

Understanding the Cisco Unified IP Phone 7965G and 7945G
Components

The Cisco Unified IP Phone 7965G and 7945G include these components on the phone or as accessories
for the phone:

e Network and Access Ports, page 3-4
e Handset, page 3-4

e Speakerphone, page 3-4

e Headset, page 3-4
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Network and Access Ports

The back of the Cisco Unified IP Phone includes these ports:
e Network port—Labeled 10/100/1000 SW on the Cisco Unified IP Phone 7965G and 7945G
e Access port—Labeled 10/100/1000 PC on the Cisco Unified IP Phone 7965G and 7945G

You can use either Category 3/5/5e/6 cabling for 10 Mbps connections, but you must use Category
5/5e/6 for 100 Mbps connections and Category 5e/6 for 1000 Mbps connections.

Use the SW network port to connect the phone to the network. You must use a straight-through cable on
this port. The phone can also obtain inline power from a switch over this connection. See the “Providing
Power to the Phone” section on page 2-3 for details.

Use the PC access port to connect a network device, such as a computer, to the phone. You must use a
straight-through cable on this port.

Handset

The wideband-capable handset is designed especially for use with a Cisco Unified IP Phone. It includes
a light strip that indicates incoming calls and voice messages waiting.

To connect a handset to the Cisco Unified IP Phone, plug the cable into the handset and into the Handset
port on the back of the phone.

Speakerphone

By default, the wideband-capable speakerphone is enabled on the Cisco Unified IP Phone.

You can disable the speakerphone by using Cisco Unified Communications Manager Administration. To
do so, choose Device > Phone and locate the phone you want to modify. In the Phone Configuration
window for the phone, check the Disable Speakerphone check box.

Headset

Although Cisco Systems performs some internal testing of third-party headsets for use with the

Cisco Unified IP Phones, Cisco does not certify or support products from headset or handset vendors.
Because of the inherent environmental and hardware inconsistencies in the locations where

Cisco Unified IP Phones are deployed, there is not a single “best” solution that is optimal for all
environments. Cisco recommends that customers test the headsets that work best in their environment
before deploying a large number of units in their network.

In some instances, the mechanics or electronics of various headsets can cause a remote party to hear a
voice echo when speaking to a Cisco Unified IP Phone user.

Cisco Systems recommends the use of good quality headsets that are screened against unwanted radio
frequency (RF) and audio frequency (AF) signals. Depending on the quality of headsets and their
proximity to other devices, such as cell phones and two-way radios, some audio noise may still occur.

The primary reason that support of a headset would be inappropriate for an installation is the potential
for an audible hum. This hum can either be heard by the remote party or by both the remote party and
the Cisco Unified IP Phone user. Some potential humming or buzzing sounds can be caused by a range
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of outside sources, for example, electric lights, being near electric motors, large PC monitors. In some
cases, a hum experienced by a user may be reduced or eliminated by using a local power cube. See the
“Safety” section on page 3-2 for more information.

Cisco Unified IP Phone 7965G and 7945G support wideband headsets.

Audio Quality Subjective to the User

Beyond the physical, mechanical and technical performance, the audio portion of a headset must sound
good to the user and the party on the far end. Sound is subjective and Cisco cannot guarantee the
performance of any headsets or handsets, but some of the headsets and handsets on the sites listed below
have been reported to perform well on Cisco Unified IP Phones.

Nevertheless, it is ultimately still the responsibility of customers to test this equipment in their
environments to determine suitable performance.

For information about headsets, refer to:
http://www.vxicorp.com/cisco
http://www.plantronics.com

http://www.jabra.com

Connecting a Headset

To connect a headset to the Cisco Unified IP Phone, plug it into the Headset port on the back of the
phone. Press the Headset button on the phone to place and answer calls using the headset.

You can use the headset with all of the features on the Cisco Unified IP Phone, including the Volume
and Mute buttons. Use these buttons to adjust the ear piece volume and to mute the speech path from the
headset microphone.

Disabling a Headset

You can disable the headset through the Cisco Unified Communications Manager Administration. If you
do so, you also will disable the speakerphone.

To disable the headset from Cisco Unified Communications Manager Administration, choose Device >
Phone and locate the phone that you want to modify. In the Phone Configuration window for the phone,
check the Disable Speakerphone and Headset check box.
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Using External Devices with Your Cisco Unified IP Phone

A

The following information applies when you use external devices with the Cisco Unified IP Phone:

Cisco recommends the use of good quality external devices that are shielded (screened) against
unwanted radio frequency (RF) and audio frequency (AF) signals.

Depending on the quality of these devices and their proximity to other devices such as mobile phones or
two-way radios, some audio noise may still occur. In these cases, Cisco recommends that you take one
or more of the following actions:

e Move the external device away from the source of the RF or AF signals.

¢ Route the external device cables away from the source of the RF or AF signals.

e Use shielded cables for the external device, or use cables with a better shield and connector.
e Shorten the length of the external device cable.

e Apply ferrites or other such devices on the cables for the external device.

Cisco cannot guarantee the performance of the system because Cisco has no control over the quality of
external devices, cables, and connectors. The system will perform adequately when suitable devices are
attached using good quality cables and connectors.

Caution

In European Union countries, use only external headsets that are fully compliant with the EMC Directive
[89/336/EC].

Installing the Cisco Unified IP Phone

Table 3-1

~

Note

You must connect the Cisco Unified IP Phone to the network and to a power source before using it. See
Figure 3-1 for a graphical representation of the connections.

Before you install a phone, even if it is new, upgrade the phone to the current firmware image.

Before using external devices, read the “Using External Devices with Your Cisco Unified IP Phone”
section on page 3-6 for safety and performance information.

To install a Cisco Unified IP Phone, perform the following steps:

Installing the Cisco Unified IP Phone 7965G and 7945G

Configuration Step and Notes Reference

Step1 |Connect the handset to the Handset port. —

Step2 |Connect a headset to the Headset port. See the “Headset” section on

Optional. You can add a headset later if you do not connect one

page 3-4 for supported headsets.

now.
Step3 |Connect the power supply to the Cisco DC Adapter port. See the “Providing Power to the
Onti Phone” section on page 2-3.
ptional.
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Table 3-1 Installing the Cisco Unified IP Phone 7965G and 7945G
Configuration Step and Notes Reference
Step4 |Connect a straight-through Ethernet cable from the switch to the See the “Network and Access
10/100/1000 SW port. Ports” section on page 3-4 for
guidelines.

Each Cisco Unified IP Phone ships with one Ethernet cable in the
box.

You can use either Category 3/5/5e/6 cabling for 10 Mbps
connections, but you must use Category 5/5¢/6 for 100 Mbps
connections and Category 5e/6 for 1000 Mbps connections.

Step5 |Connect a straight-through Ethernet cable from another network See the “Network and Access
device, such as a desktop computer, to the 10/100/1000 PC port. Ports” section on page 3-4 for

Optional. You can connect another network device later if you do guidelines.

not connect one now.

You can use either Category 3/5/5e/6 cabling for 10 Mbps
connections, but you must use Category 5/5¢/6 for 100 Mbps
connections and Category 5e/6 for 1000 Mbps connections.

Figure 3-1 Cisco Unified IP Phone 7965G and 7945G Rear Cable Connections

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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[ | Attaching the Cisco Unified IP Phone Expansion Module 7914 (SCCP Phones Only)

Cisco Unified IP Phone 7965G and 7945G Rear Cable Connections:

1 |DC adapter port (DC48V) 5 |Access port
2 |Power supply with DC Connector 6 |Handset port
3 |Power cable with AC wall plug 71 |Headset port
4 |Network port

Related Topics
e Before You Begin, page 3-1

e Attaching the Cisco Unified IP Phone Expansion Module 7914 (SCCP Phones Only)
e Adjusting the Placement of the Cisco Unified IP Phone, page 3-9
e Configuring Startup Network Settings, page 3-13

Attaching the Cisco Unified IP Phone Expansion Module 7914
(SCCP Phones Only)

The Cisco Unified IP Phone Expansion Module 7914 can be attached to an SCCP Cisco Unified IP
Phone 7965G to extend the number of line appearances or speed dial buttons. You can customize the
button templates for the Cisco Unified IP Phone Expansion Module 7914 to determine the number of
line appearances and speed dial buttons. See the “Modifying Phone Button Templates™ section on
page 5-15 for details.

The Cisco Unified IP Phone Expansion Module 7914 is not compatible with the following:
e The Cisco Unified IP Phone Expansion Module 7914 is not compatible with SIP phones.

e The Cisco Unified IP Phone Expansion Module 7914 is not supported on the
Cisco Unified IP Phone 7945G.

You can attach one or two Cisco Unified IP Phone Expansion Module 7914s to a Cisco Unified IP Phone
7965G by using one of the following methods:

¢ When you initially add the phone to Cisco Unified Communications Manager by selecting
7914 14-Button Line Expansion Module in the Module 1 or Module 2 fields and selecting the
appropriate expansion module firmware. See Step 6 in the following procedure.

e After the phone is configured in Cisco Unified Communications Manager.

To configure the Cisco Unified IP Phone Expansion Module 7914 on the Cisco Unified IP Phone, follow
these steps:

Procedure

Step 1 Log in to Cisco Unified Communications Manager Administration.
Cisco Unified Communications Manager Administration window displays.
Step 2 From the menu, choose Device > Phone.

The Find and List Phone page appears. You can search for one or more phones that you want to configure
for the Cisco Unified IP Phone Expansion Module 7914.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Step 3

Step 4

Step 5
Step 6

Step 7

Step 8

Note

Adjusting the Placement of the Cisco Unified IP Phone W

Select and enter your search criteria and click Find.

The Find and List Phone window displays showing a list of the phones that match your search criteria.
Click the IP Phone that you want to configure for the Cisco Unified IP Phone Expansion Module 7914.
The Phone Configuration window displays.

Scroll to the Expansion Module Information section.

To add support for one expansion module, in the Module 1 field, choose 7914 14-Button Line
Expansion Module.

To add support for a second expansion module, in the Module 2 field, choose 7914 14-Button Line
Expansion Module.

In the Firmware Load Information section, there are two fields that specify the firmware load for
Modules 1 and 2. You can leave these fields blank to use the default firmware load.

Click the Save icon.
A message displays asking you to reset the phone for the changes to take effect. Click OK.
Click Reset for the changes to take effect.

Refer users to their Cisco Unified Communications Manager User Options web pages, so they can
configure speed dial buttons and program buttons to access phone services on the Cisco Unified IP
Phone Expansion Module 7914. See the “How Users Subscribe to Services and Configure Phone
Features” section on page A-3 for more details.

Related Topics
e Before You Begin, page 3-1

e Adjusting the Placement of the Cisco Unified IP Phone, page 3-9
e Configuring Startup Network Settings, page 3-13

Adjusting the Placement of the Cisco Unified IP Phone

The Cisco Unified IP Phone includes an adjustable footstand. When placing the phone on a desktop
surface, you can adjust the tilt height to several different angles in 7.5 degree increments from flat to 60
degrees. You can also mount these phones to the wall by using the footstand or by using the optional
locking wall mount kit.

Adjusting Cisco Unified IP Phone Footstand and Phone Height

Step 1

You can adjust the footstand adjustment plate on the Cisco Unified IP Phone to the height that provides
optimum viewing of the phone screen. See Figure 3-3 for more information.

Procedure

Push in the footstand adjustment button.
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W Adjusting the Placement of the Cisco Unified IP Phone

Step2  Adjust the footstand to the desired height.

Securing the Phone with a Cable Lock

You can secure the Cisco Unified IP Phone 7965G and 7945G to a desktop by using a laptop cable lock.
The lock connects to the security slot on the back of the phone, and the cable can be secured to a desktop.

The security slot can accommodate a lock up to 20 mm. Compatible laptop cable locks include the
Kensington laptop cable lock and laptop cable locks from other manufacturers that can fit into the
security slot on the back of the phone.

See Figure 3-2.

Figure 3-2 Connecting a Cable Lock to the Cisco Unified IP Phone 7965G and 7945G

Mounting the Phone to the Wall

You can mount the Cisco Unified IP Phone on the wall by using the footstand as a mounting bracket or
you can use special brackets available in a Cisco Unified IP Phone wall mount kit. (Wall mount kits must
be ordered separately from the phones.) If you attach the phone to a wall by using the standard footstand
and not the wall mount kit, you need to supply the following tools and parts:

e Screwdriver

e Screws to secure the Cisco Unified IP phone to the wall

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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A

Adjusting the Placement of the Cisco Unified IP Phone

See Figure 3-3 for a graphical representation of the phone parts.

Before You Begin

To ensure that the handset attaches securely to a wall-mounted phone, remove the handset wall hook
from the handset rest, rotate the hook 180 degrees, and reinsert the hook. Turning the hook exposes a lip
on which the handset catches when the phone is vertical. For an illustrated procedure, refer to Installing
the Wall Mount Kit for the Cisco Unified IP Phonee at:

http://www.cisco.com/en/US/products/hw/phones/ps379/prod_installation_guides_list.html

To mount the phone on the wall using the standard footstand, follow these steps:

Caution

Step 1
Step 2
Step 3

Step 4

Use care not to damage wires or pipes located inside the wall when securing screws to wall studs.

Procedure

Push in the footstand adjustment button.

Adjust the footstand so it is flat against the back of the phone.

Insert two screws into a wall stud, matching them to the two screw holes on the back of the footstand.
The keyholes fit standard phone jack mounts.

Hang the phone on the wall.

Figure 3-3 Parts Used in Wall Mounting the Cisco Unified IP Phone

1 |Footstand adjustment button—Raises and lowers adjustment plate

Wall mounting screw holes

3 |Adjustment plate—Raises and lowers phone vertically
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W Verifying the Phone Startup Process

Verifying the Phone Startup Process

After the Cisco Unified IP Phone has power connected to it, the phone begins its startup process by
cycling through these steps.

1. These buttons flash on and off in sequence:

— Headset. (Only if the handset is off-hook when the phone powers up. Hang up the handset
within 3 seconds to have the phone launch its secondary load. To continue with the primary
load, leave the handset off-hook.)

- Mute.
- Speaker.
2. Some or all of the line keys flash orange.

A

Caution  If the line keys flash red in sequence after flashing yellow, do not power down the phone until the
sequence of red flashes completes. This sequence can take several minutes to complete.

3. Some or all of the line keys flash green.

Normally, this sequence takes just a few seconds. However, if the phone flash memory is erased or
the phone load is corrupted, the sequence of green flashes will continue while the phone begins a
software update procedure. If the phone performs this procedure, the following buttons light to
indicate progress:

— Headset—Phone is waiting for the network and completing CDP and DHCP configuration. (A
DHCP server must be available in your network.)

— Mute—Phone is downloading images from the TFTP server.
- Speaker—Phone is writing images to its flash memory.
4. The phone screen displays the Cisco Systems, Inc., logo screen.
5. These messages display as the phone starts:

— Verifying load (if the phone load does not match the load on the TFTP server). If this message
displays, the phone start up again and repeats step 1 through step 4 above.

— Configuring IP.
— Updating CTL.
— Updating Locale.
— Configuring CM List.
— Registering.
6. The main phone screen displays:

Current date and time

Primary directory number

Additional directory numbers and speed dial numbers, if configured

Softkeys

If the phone successfully passes through these stages, it has started up properly. If the phone does not
start up properly, see the “Resolving Startup Problems” section on page 9-2.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Configuring Startup Network Settings

If you are not using DHCP in your network, you must configure these network settings on the
Cisco Unified IP Phone after installing the phone on the network:

e [P address
e [P subnet mask
e Default gateway IP address
e TFTP server IP address
You may also configure these optional settings as necessary:
¢ Domain name
e DNS server IP address

Collect this information and see the instructions in Chapter 4, “Configuring Settings on the Cisco
Unified IP Phone.”

Configuring Security on the Cisco Unified IP Phone

Step 1
Step 2

The security features protect against several threats, including threats to the identity of the phone and to
data. These features establish and maintain authenticated communication streams between the phone and
the Cisco Unified Communications Manager server, and digitally sign files before they are delivered.

For more information about the security features, see the “Understanding Security Features for Cisco
Unified IP Phones” section on page 1-9. Also, refer to Cisco Unified Communications Manager Security
Guide.

A Locally Significant Certificate (LSC) installs on phones after you perform the necessary tasks that are
associated with the Certificate Authority Proxy Function (CAPF). You can use

Cisco Unified Communications Manager Administration to configure an LSC, as described in

Cisco Unified Communications Manager Security Guide.

Alternatively, you can initiate the installation of an LSC from the Security Configuration menu on the
phone. This menu also lets you update or remove an LSC.

Before you begin, make sure that the appropriate Cisco Unified Communications Manager and the
CAPF security configurations are complete:

e The CTL file should have a CAPF certificate.

e The CAPF certificate must exist in the /usr/local/cm/.security/certs folder in every server in the
cluster.

e The CAPF is running and configured.
Refer to Cisco Unified Communications Manager Security Guide for more information.

To configure an LSC on the phone, perform the following procedure. Depending on how you have
configured the CAPF, this procedure installs an LSC, updates an existing LSC, or removes an existing
LSC.

Procedure

Obtain the CAPF authentication code that was set when the CAPF was configured.

From the phone, press the Settings > Security Configuration.
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M Configuring Security on the Cisco Unified IP Phone

Step 3

Step 4

Step 5

~

Note  You can control access to the Settings Menu by using the Settings Access field in the
Cisco Unified Communications Manager Administration Phone Configuration window. For
more information, see Cisco Unified Communications Manager Administration Guide.

Press **# to unlock settings on the Security Configuration menu. (See the “Unlocking and Locking
Options” section on page 4-3 for information using locking and unlocking options.)

S

Note  If a Settings Menu password has been provisioned, SIP phones present an “Enter password”
prompt after you enter **#.

Scroll to LSC and press the Update softkey.
The phone prompts for an authentication string.
Enter the authentication code and press the Submit softkey.

The phone begins to install, update, or remove the LSC, depending on how the CAPF was configured.
During the procedure, a series of messages appears in the LSC option field in the Security Configuration
menu, so you can monitor progress. When the procedure completes successfully, the phone will display
Installed or Not Installed.

The LSC install, update, or removal process can take a long time to complete. You can stop the process
at any time by pressing the Stop softkey from the Security Configuration menu. (Settings must be
unlocked before you can press this softkey.)

When the phone successfully completes the installation procedure, it displays “Success.” If the phone
displays, “Failure,” the authorization string may be incorrect or the phone may not enabled for
upgrading. Refer to error messages generated by the CAPF and take appropriate actions.

You can verify that an LSC is installed on the phone by choosing Settings > Model Information and
ensuring that the LSC setting shows Installed.

Related Topic
e Understanding Security Features for Cisco Unified IP Phones, page 1-9
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Configuring Settings on the Cisco
Unified IP Phone

The Cisco Unified IP Phone includes many configurable network and device settings that you may need
to modify before the phone is functional for your users. You can access these settings, and change many
of them, through menus on the phone.

This chapter includes the following topics:
e Configuration Menus on the Cisco Unified IP Phone 7965G and 7945G, page 4-1
e Overview of Options Configurable from a Phone, page 4-4
e Network Configuration Menu, page 4-5
e Device Configuration Menu, page 4-11

e Security Configuration Menu, page 4-31

Configuration Menus on the Cisco Unified IP Phone 7965G and

7945G

The Cisco Unified IP Phone includes the following configuration menus:

¢ Network Configuration menu—Provides options for viewing and making a variety of network
settings. For more information, see the “Network Configuration Menu” section on page 4-5.

e Device Configuration menu—Provides access to sub-menus from which you can view a variety of
non network-related settings. For more information, see the “Device Configuration Menu” section
on page 4-11.

e Security Configuration menu—Provides options for displaying and modifying security settings. For
more information, see the “Security Configuration Menu” section on page 4-31.

Before you can change option settings on the Network Configuration menu, you must unlock options for
editing. See the “Unlocking and Locking Options™ section on page 4-3 for instructions.

For information about the keys you can use to edit or change option settings, see the “Editing Values”
section on page 4-3.

You can control whether a phone user has access to phone settings by using the Settings Access field in
the Cisco Unified Communications Manager Administration Phone Configuration window.
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B Configuration Menus on the Cisco Unified IP Phone 7965G and 7945G

Related Topics
e Displaying a Configuration Menu, page 4-2
¢ Unlocking and Locking Options, page 4-3
e Editing Values, page 4-3
e Overview of Options Configurable from a Phone, page 4-4
e Network Configuration Menu, page 4-5
e Device Configuration Menu, page 4-11

e Security Configuration Menu, page 4-31

Displaying a Configuration Menu

S

Note

Step 1
Step 2

Step 3
Step 4

To display a configuration menu, perform the following steps.

You can control whether a phone has access to the Settings menu or to options on this menu by using
the Settings Access field in the Cisco Unified Communications Manager Administration Phone
Configuration window. The Settings Access field accepts these values:

e Enabled—Allows access to the Settings menu.

e Disabled—Prevents access to the Settings menu.

¢ Restricted—Allows access to the User Preferences menu and allows volume changes to be saved.

Prevents access to other options on the Settings menu.

If you cannot access an option on the Settings menu, check the Settings Access field.

Procedure

Press the Settings button to access the Settings menu.

Perform one of these actions to display the desired menu:
¢ Use the Navigation button to select the desired menu and then press the Select softkey.
¢ Use the keypad on the phone to enter the number that corresponds to the menu.

To display a submenu, repeat Step 2.

To exit a menu, press the Exit softkey.

Related Topics
e Unlocking and Locking Options, page 4-3
e Editing Values, page 4-3
e Overview of Options Configurable from a Phone, page 4-4
e Network Configuration Menu, page 4-5
e Device Configuration Menu, page 4-11

e Security Configuration Menu, page 4-31
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Configuration Menus on the Cisco Unified IP Phone 7965G and 79456

Unlocking and Locking Options

Note

A

Configuration options that can be changed from a phone are locked by default to prevent users from
making changes that could affect the operation of a phone. You must unlock these options before you
can change them.

When options are inaccessible for modification, a locked padlock icon & appears on the
configuration menus. When options are unlocked and accessible for modification, an unlocked é
padlock icon appears on these menus.

To unlock or lock options, press **#. This action either locks or unlocks the options, depending on the
previous state.

If a Settings Menu password has been provisioned, SIP phones present an “Enter password” prompt after
you enter **#.

Make sure to lock options after you have made your changes.

Caution

Do not press **# to unlock options and then immediately press **# again to lock options. The phone
will interpret this sequence as **#%** which will reset the phone. To lock options after unlocking them,
wait at least 10 seconds before you press **# again.

Related Topics
¢ Displaying a Configuration Menu, page 4-2
e Editing Values, page 4-3
e Overview of Options Configurable from a Phone, page 4-4
e Network Configuration Menu, page 4-5

e Device Configuration Menu, page 4-11

Editing Values

When you edit the value of an option setting, follow these guidelines:
e Use the keys on the keypad to enter numbers and letters.

e To enter letters by using the keypad, use a corresponding number key. Press the key one or more
times to display a particular letter. For example, press the 2 key once for “a,” twice quickly for “b,”
and three times quickly for “c.” After you pause, the cursor automatically advances to allow you to
enter the next letter.

e To enter a period (for example, in an IP address), press the . (period) softkey or press * on the
keypad.

e Press the << softkey if you make a mistake. This softkey deletes the character to the left of the
cursor.

¢ Press the Cancel softkey before pressing the Save softkey to discard any changes that you have
made.
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M Overview of Options Configurable from a Phone

~

Note

The Cisco Unified IP Phone provides several methods you can use to reset or restore option settings, if
necessary. For more information, see the “Resetting or Restoring the Cisco Unified IP Phone” section

on page 9-14.

Related Topics
e Displaying a Configuration Menu, page 4-2
¢ Unlocking and Locking Options, page 4-3
e Overview of Options Configurable from a Phone, page 4-4
e Network Configuration Menu, page 4-5
e Device Configuration Menu, page 4-11

e Security Configuration Menu, page 4-31

Overview of Options Configurable from a Phone

The settings that you can change on a phone fall into several categories, as shown in Table 4-1. For a
detailed explanation of each setting and instructions for changing them, see the “Network Configuration

Menu” section on page 4-5.

Note  There are several options on various configuration menus that are for display only or that you can
configure from Cisco Unified Communications Manager. These options also are also described in this
chapter.

Table 4-1 Settings Configurable from the Phone
Network Configuration Menu
Category Description Option

DHCP settings

Dynamic Host Configuration Protocol (DHCP) automatically assigns
IP address to devices when you connect them to the network. Cisco
Unified IP Phones enable DHCP by default.

DHCP Enabled

DHCP Address Released

IP settings

If you do not use DHCP in your network, you can make IP settings
manually.

Domain Name

IP Address

Subnet Mask

Default Router 1-5

DNS Server 1-5

TFTP settings

If you do not use DHCP to direct the phone to a TFTP server, you must
manually assign a TFTP server. You can also assign an alternative
TFTP server to use instead of the one assigned by DHCP.

TFTP Server 1

Alternate TFTP

TFTP Server 2
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Table 4-1 Settings Configurable from the Phone (continued)
Network Configuration Menu

Category Description Option
VLAN settings e Admin. VLAN ID allows you to change the administrative VLAN |Admin. VLAN ID

used by the phone. PC VLAN

e PC VLAN allows PCs plugged in behind the phone to interoperate

with third-party switches that do not strip VLAN tags on the

native VLAN for that port.
Port settings Allow you to set the speed and duplex of the network and access ports. |SW Port Configuration

PC Port Configuration

Related Topics
e Displaying a Configuration Menu, page 4-2
¢ Unlocking and Locking Options, page 4-3
e Editing Values, page 4-3
e Network Configuration Menu, page 4-5

e Device Configuration Menu, page 4-11

Network Configuration Menu

The Network Configuration menu provides options for viewing and making a variety of network
settings. Table 4-2 describes these options and, where applicable, explains how to change them.

For information about how to access the Network Configuration menu, see the “Displaying a
Configuration Menu” section on page 4-2.

Note  The phone also has a Network Configuration menu that you access directly from the Settings menu. For
information about the options on that menu, see the “Network Configuration” section on page 4-27.

Before you can change an option on this menu, you must unlock options as described in the “Unlocking
and Locking Options” section on page 4-3. The Edit, Yes, or No softkeys for changing network
configuration options appear only if options are unlocked.

For information about the keys you can use to edit options, see the “Editing Values” section on page 4-3.

Table 4-2 Network Configuration Menu Options

Option Description To Change

DHCP Server IP address of the Dynamic Host Configuration Protocol (DHCP) |Display only—Cannot configure.
server from which the phone obtains its IP address.

BOOTP Server Indicates whether the phone obtains its configuration from a Display only—Cannot configure.
Bootstrap Protocol (BootP) server instead of from a DHCP server.

MAC Address Unique Media Access Control (MAC) address of the phone. Display only—Cannot configure.

Host Name Unique host name that the DHCP server assigned to the phone. Display only—Cannot configure.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
I oL-14641-01 .m



Chapter4  Configuring Settings on the Cisco Unified IP Phone

Bl Network Configuration Menu

Table 4-2 Network Configuration Menu Options (continued)
Option Description To Change
Domain Name Name of the Domain Name System (DNS) domain in which the 1. Unlock network configuration

phone resides.

options.

Set the DHCP Enabled option
to No.

Scroll to the Domain Name
option, press the Edit softkey,
and then enter a new domain
name.

Press the Validate softkey and
then press the Save softkey.

IP Address

Internet Protocol (IP) address of the phone.

If you assign an IP address with this option, you must also assign
a subnet mask and default router. See the Subnet Mask and Default
Router options in this table.

Unlock network configuration
options.

Set the DHCP Enabled option
to No.

Scroll to the IP Address
option, press the Edit softkey,
and then enter a new IP
Address.

Press the Validate softkey and
then press the Save softkey.

Subnet Mask

Subnet mask used by the phone.

Unlock network configuration
options.

Set the DHCP Enabled option
to No.

Scroll to the Subnet Mask
option, press the Edit softkey,
and then enter a new subnet
mask.

Press the Validate softkey and
then press the Save softkey.
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Table 4-2 Network Configuration Menu Options (continued)

Option

Description

To Change

TFTP Server 1

Primary Trivial File Transfer Protocol (TFTP) server used by the
phone. If you are not using DHCP in your network and you want
to change this server, you must use the TFTP Server 1 option.

If you set the Alternate TFTP option to yes, you must enter a
non-zero value for the TFTP Server 1 option.

If neither the primary TFTP server nor the backup TFTP server is
listed in the CTL file on the phone, you must unlock the CTL file
before you can save changes to the TFTP Server 1 option. In this
case, the phone will delete the CTL file when you save changes to
the TFTP Server 1 option.

For information about the CTL file, refer to Cisco Unified
Communications Manager Security Guide. For information about
unlocking the CTL file, see the “Security Configuration Menu”
section on page 4-31.

1.

Unlock the CTL file, if
necessary.

If DHCP is enabled, set the
Alternate TFTP option to Yes.

Scroll to the TFTP Server 1
option, press the Edit softkey,
and then enter a new TFTP
server IP address.

Press the Validate softkey,
and then press the Save
softkey.

TFTP Server 2

Optional backup TFTP server that the phone uses if the primary
TFTP server is unavailable.

If neither the primary TFTP server nor the backup TFTP server is
listed in the CTL file on the phone, you must unlock the CTL file
before you can save changes to the TFTP Server 2 option. In this
case, the phone will delete the CTL file when you save changes to
the TFTP Server 2 option.

For information about the CTL file, refer to Cisco Unified
Communications Manager Security Guide. For information about
unlocking the CTL file, see to the “Security Configuration Menu”
section on page 4-31.

Unlock the CTL file, if
necessary.

Unlock network configuration
options.

Enter an IP address for the
TFTP Server 1 option.

Scroll to the TFTP Server 2
option, press the Edit softkey,
and then enter a new backup
TFTP server IP address.

Press the Validate softkey,
and then press the Save
softkey.

Default Router 1
Default Router 2
Default Router 3
Default Router 4
Default Router 5

Default router used by the phone (Default Router 1) and optional
backup routers (Default Router 2-5).

Unlock network configuration
options.

Set the DHCP Enabled option
to No.

Scroll to the appropriate
Default Router option, press
the Edit softkey, and then
enter a new router IP address.

Press the Validate softkey.

5. Repeat Steps 3 and 4 as needed
to assign backup routers.
6. Press the Save softkey.
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Table 4-2 Network Configuration Menu Options (continued)
Option Description To Change
DNS Server 1 Primary Domain Name System (DNS) server (DNS Server 1) and | 1. Unlock network configuration
DNS Server 2 optional backup DNS servers (DNS Server 2-5) used by the options.
hone. .
DNS Server 3 P 2, tSf:;\lthe DHCP Enabled option
o No.

DNS Server 4
DNS Server 5

3. Scroll to the appropriate DNS
Server option, press the Edit
softkey, and then enter a new
DNS server IP address.

4. Press the Validate softkey.

5. Repeat Steps 3 and 4 as needed
to assign backup DNS servers.

6. Press the Save softkey.

Operational VLAN
ID

Auxiliary Virtual Local Area Network (VLAN) configured on a
Cisco Catalyst switch in which the phone is a member.

If the phone has not received an auxiliary VLAN, this option
indicates the Administrative VLAN.

If neither the auxiliary VLAN nor the Administrative VLAN are
configured, this option is blank.

The phone obtains its Operational
VLAN ID via Cisco Discovery
Protocol (CDP) from the switch to
which the phone is attached. To
assign a VLAN ID manually, use
the Admin VLAN ID option.

Admin. VLAN ID

Auxiliary VLAN in which the phone is a member.

Used only if the phone does not receive an auxiliary VLAN from
the switch; otherwise it is ignored.

1. Unlock network configuration
options.

2. Scroll tothe Admin. VLANID
option, press the Edit softkey,
and then enter a new Admin
VLAN setting.

3. Press the Validate softkey and
then press the Save softkey.

DHCP Enabled

Indicates whether DHCP is being used by the phone.

1. Unlock network configuration
options.

2. Scroll to the DHCP Enabled
option and press the No
softkey to disable DHCP, or
press the Yes softkey to enable
DHCP.

3. Press the Save softkey.
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Table 4-2 Network Configuration Menu Options (continued)

Option Description To Change

DHCP Address Releases the IP address assigned by DHCP. 1. Unlock network configuration
Released options.

Scroll to the DHCP Address
Released option and press the
Yes softkey to release the IP
address assigned by DHCP, or
press the No softkey if you do
not want to release this IP
address.

Press the Save softkey.

Alternate TFTP

Indicates whether the phone is using an alternative TFTP server.

Unlock network configuration
options.

Scroll to the Alternate TFTP
option and press the Yes
softkey if the phone should use
an alternative TFTP server;
otherwise, press the No

softkey.
3. Press the Save softkey.
SW Port Speed and duplex of the network port (labeled 10/100/1000 SW). | 1. Unlock network configuration
Configuration Valid values: options.
e Auto Negotiate 2. Scroll to the SW Port
Configuration option and then
e 10 Half—10-BaseT/half duple
upiex press the Edit softkey.
e 10 Full—10-BaseT/full duplex .
3. Scroll to the setting that you
e 100 Half—100-BaseT/half duplex want and then press the Select
e 100 Full—100-BaseT/full duplex softkey.
e 1000 Full—1000-BaseT/full duplex 4. Press the Save softkey.
If the phone is connected to a switch, configure the port on the
switch to the same speed/duplex as the phone, or configure both to
auto-negotiate.
If you change the setting of this option, you should change the PC
Port Configuration option to the same setting. This ensures that the
PC receives the full benefits of the network operating speed.
Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Table 4-2 Network Configuration Menu Options (continued)
Option Description To Change
PC Port Speed and duplex of the access port (labeled 10/100/1000 PC). 1. Unlock network configuration
Configuration Valid values: options.
e Auto Negotiate 2. Scroll to the PC Port
« 10 Half—10-BaseT/half duplex Configuration option and then
press the Edit softkey.
e 10 Full—10-BaseT/full duplex .
3. Scroll to the setting that you
e 100 Half—100-BaseT/half duplex want and then press the Select
e 100 Full—100-BaseT/full duplex softkey.
e 1000 Full—1000-BaseT/full duplex 4. Press the Save softkey.
If the phone is connected to a switch, configure the port on the
switch to the same speed/duplex as the phone, or configure both to
auto-negotiate.
If you change the setting of this option, you should change the SW
Port Configuration option to the same setting. This ensures that the
PC receives the full benefits of the network operating speed.
Connection Time, in seconds, after a failover that the link between the phone |Use Cisco Unified

Monitor Duration

and a Cisco Unified Communications Manager server must remain
stable (with no link-flapping) before the phone falls back from
SRST to the Cisco Unified Communications Manager server

Communications Manager
Administration to modify.

PC VLAN

Allows the phone to interoperate with 3rd party switches that do
not support a voice VLAN. The Admin VLAN ID option must be
set before you can change this option.

Unlock network configuration
options.

Make sure the Admin VLAN
ID option is set.

Scroll to the PC VLAN
option, press the Edit softkey,
and then enter a new PC
VLAN setting.

Press the Validate softkey and
then press the Save softkey.

Related Topics
e Displaying a Configuration Menu, page 4-2
e Unlocking and Locking Options, page 4-3
e Editing Values, page 4-3
e Overview of Options Configurable from a Phone, page 4-4

e Device Configuration Menu, page 4-11
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Device Configuration Menu

The Device Configuration menu provides access to nine sub-menus from which you can view a variety
of settings that are specified in the configuration file for a phone. (The phone downloads the
configuration file from the TFTP server.) These sub-menus are:

CallManager Configuration menu, page 4-11
SIP Configuration Menu (SIP Phones Only), page 4-13
HTTP Configuration Menu, page 4-16
Locale Configuration Menu, page 4-17

UI Configuration Menu, page 4-18

Media Configuration Menu, page 4-20
Power Save Configuration Menu, page 4-23
Ethernet Configuration Menu, page 4-24
Security Configuration Menu, page 4-25
QoS Configuration Menu, page 4-26
Network Configuration, page 4-27

For instructions about how to access the Device Configuration menu and its sub-menus, see the
“Displaying a Configuration Menu” section on page 4-2.

CallManager Configuration menu

The CallManager Configuration menu contains these options:

Communications Manager 1
Communications Manager 2
Communications Manager 3
Communications Manager 4

Communications Manager 5

These options show the Cisco Unified Communications Manager servers that are available for
processing calls from the phone, in prioritized order. To change these options, use Cisco Unified
Communications Manager Administration, Cisco Unified CM Group Configuration.

| oL-14641-01
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For an available Cisco Unified Communications Manager server, an option on the CallManager
Configuration menu will show the Cisco Unified Communications Manager server IP address or name
and one of the states shown in Table 4-3.

Table 4-3 Cisco Unified Communications Manager Server States

State Description

Active Cisco Unified Communications Manager server from
which the phone is currently receiving call-processing
services

Standby Cisco Unified Communications Manager server to

which the phone switches if the current server
becomes unavailable

Blank No current connection to this Cisco
Unified Communications Manager server

An option may also display one of more of the designations or icons shown in Table 4-4.

Table 4-4 Cisco Unified Communications Manager Server Designations
Designation Description
SRST ¢ Indicates a Survivable Remote Site Telephony

router capable of providing

Cisco Unified Communications Manager
functionality with a limited feature set. This
router assumes control of call processing if all
other Cisco Unified Communications Manager
servers become unreachable. The SRST

Cisco Unified Communications Manager always
appears last in the list of servers, even if it is
active. For more information, refer to Cisco
Unified Communications Manager
Administration Guide.

You configure an SRST router address in the
Cisco Unified Communications Manager
Administration SRST Reference Configuration
window (choose System > SRST). You
configure an SRST reference in the Device Pool
Configuration window (choose System > Device
Pool).

TFTP Indicates that the phone was unable to register with a
Cisco Unified Communications Manager listed in its
configuration file, and it registered with the TFTP
server instead.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Table 4-4 Cisco Unified Communications Manager Server Designations (continued)

Designation Description

Indicates that the connection to the Cisco
Unified Communications Manager is authenticated.
For more information about authentication, refer to

(Authentication icon) Cisco Unified Communications Manager Security
Guide.
Indicates that the connection to the Cisco
é Unified Communications Manager is authenticated
and encrypted. For more information about
(Encryption icon) authentication and encryption, refer to Cisco Unified

Communications Manager Security Guide.

SIP Configuration Menu (SIP Phones Only)

The SIP Configuration menu is available on SIP phones. This menu contains these sub-menus:
e SIP General Configuration Menu, page 4-13
e Line Settings Menu, page 4-15

SIP General Configuration Menu

The SIP General Configuration menu displays information about the configurable SIP parameters on a
SIP phone. Table 4-5 describes the options in this menu.

Table 4-5 SIP General Configuration Menu Options

Option Description To Change

Preferred CODEC | Displays the CODEC to use when a call is initiated. This value |Display only—cannot configure.
will always be set to none.

Out of Band DTMF |Displays the configuration of the out-of-band signaling (for |Display only—cannot configure.
tone detection on the IP side of a gateway). The Cisco Unified
IP phone (SIP) supports out-of-band signaling by using the
AVT tone method. This value will always be set to avt.

Register with Proxy |Displays if the phone must register with a proxy server during |Display only—cannot configure.
initialization. This value will always be set to true.

Register Expires Displays the amount of time, in seconds, after which a From Cisco Unified Communications
registration request expires. Manager Administration, choose
Device >

Device Settings > SIP Profile.

Phone Label Displays the text that is displayed on the top right status line |Display only—cannot configure.
of the LCD on the phone. This text is for end-user display only
and has no effect on caller identification or messaging. This
value will always be set to null.
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Table 4-5 SIP General Configuration Menu Options (continued)
Option Description To Change
Enable VAD Displays if voice activation detection (VAD) is enabled. From Cisco Unified Communications

Manager Administration, choose
Device >
Device Settings > SIP Profile.

Start Media Port

Displays the start Real-Time Transport Protocol (RTP) range
for media.

From Cisco Unified Communications
Manager Administration, choose
Device >

Device Settings > SIP Profile.

End Media Port

Displays the end Real-Time Transport Protocol (RTP) range
for media.

From Cisco Unified Communications
Manager Administration, choose
Device >

Device Settings > SIP Profile.

Backup Proxy

Displays the IP address of the backup proxy server or gateway.
This value will always be set to USECommunications
Manager.

Display only—cannot configure.

Backup Proxy Port

Displays the port number of the backup proxy server or
gateway. This value will always be set to 5060.

Display only—cannot configure.

Emergency Proxy

Displays the IP address of the emergency proxy server or
gateway. This value will always be set to
USECommunications Manager.

Display only—cannot configure.

Emergency Proxy
Port

Displays the port number of the emergency proxy server or
gateway. This value will always be set to 5060.

Display only—cannot configure.

Outbound Proxy

Displays the IP address of the outbound proxy server. This
value will always be set to USECommunications Manager.

Display only—cannot configure.

Outbound Proxy
Port

Displays the port number of the outbound proxy server. This
value will always be set to 5060.

Display only—cannot configure.

NAT Enabled Displays if Network Address Translation (NAT) is enabled. |Display only—cannot configure.
This value will always be set to false.
NAT Address Displays the WAN IP address of the NAT or firewall server. |Display only—cannot configure.

This value will always be set to null.

Call Statistics

Displays if call statistics are enabled on the phone.

From Cisco Unified Communications
Manager Administration, choose
Device >

Device Settings > SIP Profile.

Related Topics
e Displaying a Configuration Menu, page 4-2

e Device Configuration Menu, page 4-11
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Line Settings Menu

The Line Settings menu displays information that relates to the configurable parameters for each of the
lines on a SIP phone. Table 4-6 describes the options in this menu.

Table 4-6 Line Settings Menu Options

Option Description To Change

Name Displays the lines and the number used to register each |Use Cisco Unified Communications
line. Manager to modify.

Short Name Displays the short name configured for the line. Use Cisco Unified Communications

Manager Administration to modify.

Authentication Name Displays the name used by the phone for authentication if |Use Cisco Unified Communications
a registration is challenged by the call control server Manager Administration to modify.
during initialization.

Display Name Displays the identification the phone uses for display for |Use Cisco Unified Communications
caller identification purposes. Manager Administration to modify.
Proxy Address Displays the IP address of the proxy server that will be  |Display only—Cannot configure.

used by the phone. This value will always be set to
USECommunications Manager.

Proxy Port Displays the port number of the proxy server that will be |Display only—Cannot configure.
used by the phone. This value will always be set to 5060.

Shared Line Displays if the line is part of a shared line (Yes) or not  |Display only—Cannot configure.
(No).

Related Topics
e Displaying a Configuration Menu, page 4-2

e Device Configuration Menu, page 4-11

Call Preferences Menu

The Call Preferences menu displays settings that relate to the settings for the call preferences on a SIP
phone. Table 4-7 describes the options in this menu.

Table 4-7 Call Preferences Menu Options
Option Description To Change
Caller ID Blocking Indicates whether caller ID blocking is enabled (Yes) |From Cisco Unified Communications
or disabled (No) for the phone. Manager Administration, choose Device >

Device Settings > SIP Profile.

Anonymous Call Block |Indicates whether anonymous call block is enabled |From Cisco Unified Communications
(Yes) or disabled (No) for the phone. Manager Administration, choose Device >
Device Settings > SIP Profile.

Call Waiting Displays a sub-menu that indicates whether call Use Cisco Unified Communications
Preferences waiting is enabled (Yes) or disabled (No) for each  |Manager Administration to modify.
line.
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Table 4-7

Call Preferences Menu Options (continued)

Option

Description

To Change

Call Hold Ringback

Indicates whether the call hold ringback feature is
enabled (Yes) or disabled (No) for the phone.

From Cisco Unified Communications
Manager Administration, choose Device >
Device Settings > SIP Profile.

Stutter Msg Waiting

Indicates whether stutter message waiting is enabled
(Yes) or disabled (No) for the phone.

From Cisco Unified Communications
Manager Administration, choose Device >
Device Settings > SIP Profile.

Call Logs BLF Enabled

Indicates whether BLF for call logs is enabled (Yes)
or disabled (No) for the phone.

Use Cisco Unified Communications
Manager Administration to modify.

Auto Answer

Displays a sub-menu that indicates whether auto

From Cisco Unified Communications

Preferences answer is enabled (Yes) or disabled (No) for the each |Manager Administration, choose Call
line. Routing > Directory Number.
Speed Dials Displays a sub-menu that displays the lines available |From Cisco Unified Communications

on the phone. Select a line to see the speed dial label
and number assigned to that line.

Manager Administration, choose
Device > Phone > Add a New Speed Dial.

Related Topics

Displaying a Configuration Menu, page 4-2

Device Configuration Menu, page 4-11

HTTP Configuration Menu

The HTTP Configuration menu displays the URLs of servers from which the phone obtains a variety of
information. This menu also displays information about the idle display on the phone.

Table 4-8 describes the options on the HTTP Configuration menu.

Table 4-8

HTTP Configuration Menu Options

Option

Description

To Change

Directories URL

URL of the server from which the phone obtains directory
information.

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone Configuration.

Services URL

URL of the server from which the phone obtains Cisco
Unified IP Phone services.

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone Configuration.

Messages URL

URL of the server from which the phone obtains message
services.

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone Configuration.

Information URL

URL of the help text that appears on the phone.

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone Configuration.

Authentication
URL

URL that the phone uses to validate requests made to the
phone web server.

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone Configuration.
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HTTP Configuration Menu Options (continued)

Device Configuration Menu

Option

Description

To Change

Proxy Server URL

URL of proxy server, which makes HTTP requests to
non-local host addresses on behalf of the phone HTTP

client and provides responses from the non-local host to the

phone HTTP client.

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone Configuration.

Idle URL

URL of an XML service that the phone displays when the
phone has not been used for the time specified in the Idle
URL Time option and no menu is open. For example, you
could use the Idle URL option and the Idle URL Timer
option to display a stock quote or a calendar on the LCD
screen when the phone has not been used for 5 minutes.

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone Configuration.

Idle URL Time

Number of seconds that the phone has not been used and no
menu is open before the XML service specified in the Idle
URL option is activated.

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone Configuration.

Locale Configuration Menu

Table 4-9

The Locale Configuration menu displays information about the user locale and the network locale used
by the phone. Table 4-9 describes the options on this menu.

Locale Configuration Menu Options

Option

Description

To Change

User Locale

User locale associated with the phone user. The user
locale identifies a set of detailed information to support
users, including language, font, date and time formatting,
and alphanumeric keyboard text information.

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone Configuration.

User Locale
Version

Version of the user locale loaded on the phone.

Display only—cannot configure.

User Locale Char
Set

Character set that the phone uses for the user locale.

Display only—cannot configure.

Network Locale

Network locale associated with the phone user. The
network locale identifies a set of detailed information that
supports the phone in a specific location, including
definitions of the tones and cadences used by the phone.

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone Configuration.

Network Locale
Version

Version of the network locale loaded on the phone.

Display only—cannot configure.

NTP Configuration
(SIP phones only)

Provides access to the NTP Configuration Menu. For
more information, see the “NTP Configuration Menu
(SIP Phones Only)” section on page 4-18

From Cisco Unified Communications
Manager Administration, choose System >
Phone NTP Reference.
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NTP Configuration Menu (SIP Phones Only)

The NTP Configuration menu displays information about the NTP server and mode configuration used
by SIP phones. Table 4-10 describes the options on this menu.

Table 4-10 NTP Configuration Menu Options
Option Description To Change
NTP Server 1 IP address of the primary NTP server. Use Cisco Unified Communications
Manager Administration to modify.
NTP Server 2 IP address of the secondary or backup NTP server. Use Cisco Unified Communications
Manager Administration to modify.
NTP Mode 1 Primary server mode. Supported modes are Directed Use Cisco Unified Communications
Broadcast, Unicast, Multicast, Any cast. Manager Administration to modify.
NTP Mode 2 Secondary server mode. Supported modes are Directed Display only—cannot configure.
Broadcast, Unicast, Multicast, Any cast.

Ul Configuration Menu

The UI configuration menu displays the status of various user interface features on the phone. Table 4-11
describes the options on this menu.

Table 4-11 Ul Configuration Menu Options

Option Description To Change

Auto Line Select Indicates whether the phone shifts the call focus to From Cisco Unified Communications
incoming calls on all lines. Manager Administration, choose

When this option is disabled, the phone only shifts the call Device > Phone > Phone Configuration.

focus to incoming calls on the line that is in use. When this
option is enabled, the phone shifts the call focus to the line
with the most recent incoming call.

Default: Disabled

BLF for Call Lists |Indicates whether the Busy Lamp Field (BLF) is enabled |From Cisco Unified Communications
for call lists. Manager Administration, choose
System > Enterprise Parameters.

Reverting Focus Indicates whether the phone shifts the call focus on the From Cisco Unified Communications
Priority phone screen to an incoming call or a reverting hold call. |Manager Administration, choose System
Settings include: > Device Pool.
Lower—Focus priority given to incoming calls. See also: Hold Reversion.

Higher—Focus priority given to reverting calls.

Even—Focus priority given to the first call.
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Ul Configuration Menu Options (continued)

Device Configuration Menu I

Option

Description

To Change

Auto Call Select

Indicates whether the phone automatically shifts the call
focus to an incoming call on the same line when the user is
already on a call.

When this option is enabled, the phone shifts the call focus
to the most recent incoming call.

When this option is disabled, all automatic focus changes,
including Auto Line Select, are disabled regardless of their
setting.

Default: Enabled

From Cisco Unified Communications
Manager Administration, choose Device
> Phone > Phone Configuration.

“more” Softkey
Timer

Indicates the number of seconds that additional softkeys
are displayed after the user presses more. If this timer
expires before the user presses another softkey, the display
reverts to the initial softkeys.

Range: 5 to 30; O represents an infinite timer.

Default: 5

From Cisco Unified Communications
Manager Administration, choose Device >
Phone > Phone Configuration.

Wideband Headset |Indicates whether the user can configure the Wideband From Cisco Unified Communications
UI Control Headset option in the phone user interface. Manager Administration, choose Device
v . > Phone > Phone Configuration.
alues:
e Enabled—The user can configure the Wideband
Headset option in the Audio Preferences menu on the
phone (choose & > User Preferences > Audio
Preferences> Wideband Headset).
e Disabled—The value of the Wideband Headset option
in Cisco Unified Communications Manager
Administration gets used (see Media Configuration
Menu, page 4-20).
Default: Enabled
Personalization Indicates whether the user can configure ringtones and From Cisco Unified Communications
wallpaper images. Manager Administration, choose
Default: Enabled Device > Phone > Phone Configuration.
Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Media Configuration Menu

The Media Configuration menu displays whether the headset, speakerphone, and video capability are
enabled on the phone. This menu also displays options for recording tones that the phone may play to

indicate that a call may be recorded. Table 4-12 describes the options on this menu.

Table 4-12 Media Configuration Menu Options
Option Description To Change
Headset Enabled Indicates whether the Headset button is enabled on the From Cisco Unified Communications
phone. Manager Administration, choose
Device > Phone > Phone
Configuration.
Speaker Enabled Indicates whether the speakerphone is enabled on the From Cisco Unified Communications

phone.

Manager Administration, choose
Device > Phone > Phone
Configuration.

Video Capability
Enabled

Indicates whether the phone can participate in video calls
when connected to an appropriately equipped computer.

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone
Configuration.

Recording Tone

Indicates whether a recording tone (often referred to as a
beep tone) is enabled or disabled for the phone. If the
recording tone option is enabled, the phone plays the beep
tone in both directions of every call, regardless of whether
the call actually gets recorded. The beep tone first sounds
when a call is answered.

You may want to notify your users if you enable this option.

Default: Disabled

Related Parameters:
e Recording Tone Local Volume
e Recording Tone Remote Volume
e Recording Tone Duration

Other related parameters—Beep tone frequency in hz, the
length of the beep tone (called duration), and how often the
beep tone plays (called interval)—are defined on a

per-Network Locale basis in the xml file that defines tones.
This xml file is usually named tones.xml or g3-tones.xml.

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone
Configuration.
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Table 4-12

Media Configuration Menu Options (continued)

Device Configuration Menu

Option

Description

To Change

Recording Tone
Local Volume

Indicates the loudness setting for the beep tone that is
received by the party whose phone has the Recording Tone
option enabled.

This setting applies for each listening device (handset,
speakerphone, headset).

Range: 0 percent (no tone) to 100 percent (same level as
current volume setting on the phone).

Default: 100

See also: Recording Tone

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone
Configuration.

Recording Tone
Remote Volume

Indicates the loudness setting for the beep tone that the
remote party receives. The remote party is the party who is
on a call with the party whose phone has the Recording Tone
option enabled.

Range: 0 percent to 100 percent. (0 percent is —-66 dBM and
100 percent is —3 dBM.)

Default: 84 percent (—10dBM)

See also: Recording Tone

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone
Configuration.

Recording Tone
Duration

Indicates the length of time in milliseconds that the beep
tone plays.

If the value you configure here is less than one third the
interval, then this value overrides the default provided by
the Network Locale.

Range: 0 to 3000

Note For some Network Locales that use a complex

cadence, this setting applies only to the first beep
tone.

See also: Recording Tone

From Cisco Unified Communications
Manager Administration, choose
Device > Phone > Phone
Configuration.
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Table 4-12 Media Configuration Menu Options (continued)

Option Description To Change

Wideband Headset |Indicates whether wideband is enabled or disabled for the e If Wideband Headset UI Control is
headset. enabled, you or the user can use the

phone and choose @& > User
Preferences > Audio Preferences >
Wideband Headset.

e If Wideband Headset UI Control is
disabled, from Cisco Unified
Communications Manager
Administration, choose Device >
Phone > Phone Configuration to set
this value.

Default: Disabled

Note If you allowed this option to be
user controllable (in the
Wideband Headset UI Control
option), the user-configured value
takes precedence.

Enterprise Enables/disables Cisco Unified IP Phones to advertise the |From Cisco Unified Communications
Advertise G.722 G.722 codec to Cisco Unified Communications Manager. If |Manager Administration, choose System
Codec enabled (default), and if each endpoint in the attempted call |> Enterprise Parameters.

supports G.722 in its capabilities set, Cisco Unified
Communications Manager will choose G.722 for the call.

Note  When a phone is registered with a Cisco Unified
Communications Manager that does not support
this setting, the default is “Disabled.”

Device Advertise  |Allows you to override the Enterprise Advertise G.722 From Cisco Unified Communications
G.722 Codec Codec on a per-phone basis. Manager Administration, choose Device

The default is “Use System Default,” which means the value > Phone.

configured for the Enterprise Advertise G.722 Codec
parameter gets used.
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Power Save Configuration Menu

Table 4-13

Device Configuration Menu

The Power Save Configuration menu displays the settings that control when the LCD screen on a phone
turns off to conserve power. Table 4-13 describes the options on this menu.

For detailed information about configuring these settings, see the “Automatically Disabling the Cisco

Unified IP Phone Screen” section on page 6-8.

Power Save Configuration Menu Options

Option

Description

To Change

Display On Time

Time each day that the LCD screen turns on automatically
(except on the days specified in the Days Display Not
Active field).

From Cisco Unified Communications
Manager Administration, choose Device >
Phone > Phone Configuration.

Display On
Duration

Length of time that the LCD screen remains on after
turning on at the time shown in the Display On Time
option.

From Cisco Unified Communications
Manager Administration, choose Device >
Phone > Phone Configuration.

Display Idle
Timeout

Length of time that the phone is idle before the display
turns off. Applies only when the display was off as
scheduled and was turned on by an end-user (by pressing a
button on the phone or lifting the handset).

From Cisco Unified Communications
Manager Administration, choose Device >
Phone > Phone Configuration.

Days Display Not
Active

Days that the display does not turn on automatically at the
time specified in the Display On Time option.

From Cisco Unified Communications
Manager Administration, choose Device >
Phone > Phone Configuration.

Display On If
Incoming Call

Indicates whether the LCD screen automatically
illuminates when a call is received.

From Cisco Unified Communications
Manager Administration, choose Device >
Phone > Phone Configuration.
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Ethernet Configuration Menu

The Ethernet Configuration menu includes the options that are described in Table 4-14.

Table 4-14 Ethernet Configuration Menu Option

Option Description To Change

Span to PC Port |Indicates whether the phone will forward packets transmitted |From Cisco Unified Communications
and received on the network port to the access port. Manager Administration, choose Device >

Enable this option if an application that requires monitoring Phone > Phone Configuration.

of the phone’s traffic is being run on the access port. These
applications include monitoring and recording applications
(common in call center environments) and network packet

capture tools that are used for diagnostic purposes.

Forwarding Indicates whether the internal switch begins forwarding From Cisco Unified Communications
Delay packets between the PC port and switched port on the phone |Manager Administration, choose Device >
when the phone becomes active. Phone > Phone Configuration.

e When forwarding delay is set to disabled, the internal
switch begins forwarding packets immediately.

e When forwarding delay is set to enabled, the internal
switch waits eight seconds before forwarding packets
between the PC port and the switch port.

Default is disabled.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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~

Note

Table 4-15

Device Configuration Menu

The Security Configuration menu that you display from the Device Configuration menu displays settings

that relate to security for the phone.

The phone also has a Security Configuration menu that you access directly from the Settings menu. For
information about the security options on that menu, see the “Security Configuration Menu” section on

page 4-31.

Table 4-15 describes the options on the Security Configuration menu.

Security Configuration Menu Options

Option

Description

To Change

PC Port Disabled

Indicates whether the access port on the phone is enabled or
disabled.

Note If disabled, video will not work on this phone, even

if video is enabled.

From Cisco Unified Communications
Manager Administration, choose Device
> Phone > Phone Configuration.

GARP Enabled Indicates whether the phone learns MAC addresses from  |From Cisco Unified Communications
Gratuitous Address Resolution Protocol (ARP) responses. |Manager Administration, choose Device
Disabling the phone’s ability to accept Gratuitous ARP will |> Phone > Phone Configuration.
prevent applications that use this mechanism to monitor
and record voice streams from working. If voice monitoring
is not desired, set this option to No (disabled).
Voice VLAN Indicates whether the phone allows a device attached to the |From Cisco Unified Communications
Enabled access port to access the Voice VLAN. Setting this option |Manager Administration, choose Device
to No (disabled) prevents the attached PC from sending and |> Phone > Phone Configuration.
receiving data on the Voice VLAN. This setting also
prevents the PC from receiving data sent and received by
the phone. Set this setting to Yes (enabled) if an application
that requires monitoring of the phone’s traffic is running on
the PC. These applications include monitoring and
recording applications and network monitoring software.
Web Access Indicates whether web access is enabled (Yes) or disabled |From Cisco Unified Communications
Enabled (No) for the phone. Manager Administration, choose Device

> Phone > Phone Configuration.

Security Mode

Displays the security mode that is set for the phone.

Use Cisco Unified Communications
Manager Administration to modify.

Logging Display

For use by the Cisco Technical Assistance Center (TAC), if necessary.

| oL-14641-01
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QoS Configuration Menu

The QoS Configuration menu displays information that relates to quality of service (QoS) for the phone.
Table 4-16 describes the options on this menu.

Table 4-16 QoS Configuration Menu Options

Option Description To Change

DSCP For Call Differentiated Services Code Point (DSCP) IP From Cisco Unified Communications Manager

Control classification for call control signaling. Administration, choose System > Enterprise
Parameters.

DSCP For DSCP IP classification for any phone configuration |From Cisco Unified Communications Manager

Configuration transfer. Administration, choose System > Enterprise
Parameters.

DSCP For Services |DSCP IP classification for phone-based services. |From Cisco Unified Communications Manager
Administration, choose System > Enterprise
Parameters.

Related Topics
e Displaying a Configuration Menu, page 4-2
e Network Configuration Menu, page 4-5
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Network Configuration

The Network Configuration menu displays device-specific network configuration settings on the phone.
Table 4-17 describes the options in this menu.

~

Note  The phone also has a Network Configuration menu that you access directly from the Settings menu. For
information about the options on that menu, see the “Network Configuration Menu” section on page 4-5.

Table 4-17 Network Configuration Menu Options

Option Description To Change

Load Server Used to optimize installation time for phone firmware |From Cisco Unified Communications
upgrades and offload the WAN by storing images Manager Administration, choose
locally, negating the need to traverse the WAN link for |Device > Phone > Phone
each phone's upgrade. Configuration.

You can set the Load Server to another TFTP server IP
address or name (other than the TFTP Server 1 or TFTP
Server 2) from which the phone firmware can be
retrieved for phone upgrades. When the Load Server
option is set, the phone contacts the designated server
for the firmware upgrade.

Note The Load Server option allows you to specify
an alternate TFTP server for phone upgrades
only. The phone continues to use TFTP Server
1 or TFTP Server 2 to obtain configuration
files. The Load Server option does not provide
management of the process and of the files,
such as file transfer, compression, or deletion.

RTP Control Indicates whether the phone supports the Real-Time From Cisco Unified Communications
Protocol Control Protocol (RTCP). Settings include: Manager Administration, choose
e Enabled Dev1c.e > Pl}one > Phone
Configuration.

¢ Disabled—default

If this feature is disabled, several call statistic values
display as 0. For additional information, see the
following sections:

e Call Statistics Screen, page 7-11

e Streaming Statistics, page 8-11
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Table 4-17 Network Configuration Menu Options (continued)

Option Description To Change

CDP: PC Port Indicates whether CDP is supported on the PC port From Cisco Unified Communications
(default is enabled). Manager Administration, choose
Enable CDP on the PC port when Cisco VT Device > Phone.

Advantage/Unified Video Advantage (CVTA) is
connected to the PC port. CVTA does not work without
CDP interaction with the phone.

Note  When CDP is disabled in Cisco Unified
Communications Manager, a warning is
displayed, indicating that disabling CDP on the
PC port prevents CVTA from working.

Note The current PC and switch port CDP values are
shown on the Settings menu.

CDP: SW Port Indicates whether CDP is supported on the switch port |From Cisco Unified Communications
(default is enabled). Manager Administration, choose
e Enable CDP on the switch port for VLAN Device > Phone.

assignment for the phone, power negotiation, QoS
management, and 802.1x security.

e Enable CDP on the switch port when the phone is
connected to a Cisco switch.

Note  When CDP is disabled in Cisco Unified
Communications Manager, a warning is
presented, indicating that CDP should be
disabled on the switch port only if the phone is
connected to a non-Cisco switch.

Note  The current PC and switch port CDP values are
shown on the Settings menu.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Table 4-17 Network Configuration Menu Options (continued)

Option Description To Change

Peer Firmware The Peer Firmware Sharing feature provides these From Cisco Unified Communications
Sharing advantages in high speed campus LAN settings: Manager Administration, choose

e Limits congestion on TFTP transfers to centralized Dev1c.e > Pl.lone > Phone
Configuration.
TFTP servers

e Eliminates the need to manually control firmware
upgrades

e Reduces phone downtime during upgrades when
large numbers of devices are reset simultaneously

Peer Firmware Sharing may also aid in firmware
upgrades in branch/remote office deployment scenarios
over bandwidth-limited WAN links.

When enabled, it allows the phone to discover like
phones on the subnet that are requesting the files that
make up the firmware image, and to automatically
assemble transfer hierarchies on a per-file basis. The
individual files making up the firmware image are
retrieved from the TFTP server by only the root phone
in the hierarchy, and are then rapidly transferred down
the transfer hierarchy to the other phones on the subnet
using TCP connections.

This menu option indicates whether the phone supports
Peer Firmware Sharing. Settings include:

e Enabled
e Disabled—default
Log Server Indicates the IP address and port of the remote logging |From Cisco Unified Communications
machine to which the phone sends log messages. These |Manager Administration, choose
log messages help in debugging the Peer Firmware Device > Phone > Phone
Sharing feature. Configuration.

Note The remote logging setting does not affect the
sharing log messages sent to the phone log.

LLDP: PC Port Enables and disables Link Layer Discovery Protocol  |From Cisco Unified Communications
(LLDP) on the PC port. Use this setting to force the Manager Administration, choose
phone to use a specific discovery protocol, which Device > Phone > Phone
should match the protocol supported by the switch. Configuration.

Settings include:
¢ Enabled—default
e Disabled

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Table 4-17 Network Configuration Menu Options (continued)

Option Description To Change

LLDP-MED: SW  |Enables and disables Link Layer Discovery Protocol |From Cisco Unified Communications
Port Media Endpoint Discovery (LLDP-MED) on the Manager Administration, choose

switch port. Use this setting to force the phone to use a |Device > Phone > Phone
specific discovery protocol, which should match the Configuration
protocol supported by the switch. Settings include:

e Enabled—default

e Disabled
LLDP Power Advertises the phone’s power priority to the switch, From Cisco Unified Communications
Priority enabling the switch to appropriately provide power to |Manager Administration, choose
the phones. Settings include: Device > Phone > Phone
e Unknown—default Configuration
e Low
e High
e (Critical
LLDP Asset ID Identifies the asset ID assigned to the phone for From Cisco Unified Communications
inventory management. Manager Administration, choose
Device > Phone > Phone
Configuration

Related Topics
e Displaying a Configuration Menu, page 4-2
e Network Configuration Menu, page 4-5
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Security Configuration Menu

The Security Configuration that you access directly from the Settings menu provides information about
various security setting. It also provides access to the CTL File menu and the Trust List menu, if a CTL

Note

Table 4-18

file is installed on the phone.

Security Configuration Menu

For information about how to access the Security Configuration menu and its sub-menus, see the
“Displaying a Configuration Menu” section on page 4-2.

The phone also has a Security Configuration menu that you access from the Device menu. For
information about the security options on that menu, see the “Security Configuration Menu” section on

page 4-25.

Table 4-18 describes the options in the security configuration menu.

Security Menu Settings

Option

Description

To Change

Web Access Enabled

Indicates whether web access is enabled (Yes)
or disabled (No) for the phone.

From Cisco Unified Communications Manager
Administration, choose Device > Phone > Phone
Configuration.

Security Mode

Displays the security mode that is set for the
phone.

From Cisco Unified Communications Manager
Administration, choose Device > Phone > Phone
Configuration.

MIC Indicates whether a manufacturing installed For information about how to manage the MIC for
certificate (used for the security features) is your phone, refer to the “Using the Certificate
installed on the phone (Yes) or is not installed |Authority Proxy Function” chapter in Cisco
on the phone (No). Unified Communications Manager Security Guide.

LSC Indicates whether a locally significant For information about how to manage the LSC for
certificate (used for the security features) is your phone, refer to the “Using the Certificate
installed on the phone (Yes) or is not installed |Authority Proxy Function” chapter in Cisco
on the phone (No). Unified Communications Manager Security Guide.

CTL File Displays the MDS5 hash of the certificate trust |For more information about this file, refer to the
list (CTL) file that is installed in the phone. If |“Configuring the Cisco CTL Client” section in
no CTL file is installed on the phone, this field |Cisco Unified Communications Manager Security
displays No. (If security is configured for the |Guide.
pl;lone, hthe ETL f11]§: installs automatically If a CTL file is installed on the phone, also provides
when the phone reboots or resets). access to the CTL File screen. For more

information, see the “CTL File Menu” section on
page 4-32.
Trust List If a CTL file is installed on the phone, provides |For more information, see the “Trust List Menu”

access to the Trust List menu.

section on page 4-33.

CAPF Server

Displays the IP address and the port of the
CAPF that the phone uses.

For more information about this server, refer to the
“Using the Certificate Authority Proxy Function”
section in Cisco Unified Communications Manager
Security Guide.
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Table 4-18 Security Menu Settings (continued)

Option Description To Change

802.1X Allows you to enable 802.1X authentication |See the “802.1X Authentication and Status” section
Authentication for this phone. on page 4-34.

802.1X Displays real-time status progress of the Display only—Cannot configure.

Authentication Status |802.1X authentication transaction.

CTL File Menu

The CTL File screen includes the options that are described in Table 4-19.

If a CTL file is installed on the phone, you can access the CTL File menu by pressing the Settings button
and choosing Security Configuration > CTL File.

Table 4-19 CTL File Settings

Option Description To Change

CTL File Displays the MDS5 hash of the certificate trust list ~ |For more information about the CTL file, refer
(CTL) file that is installed in the phone. If security is |to the “Configuring the Cisco CTL Client”
configured for the phone, the CTL file installs section in Cisco Unified Communications
automatically when the phone reboots or resets. Manager Security Guide.

¢ A locked padlock icon 8 in this option
indicates that the CTL file is locked.

e Anunlocked padlock icon 2 indicates that the
CTL file is unlocked.

CAPF Server IP address of the CAPF server used by the phone.  |For more information about this server, refer
Also displays a certificate icon if a certificate is to the “Using the Certificate Authority Proxy
installed for this server. Function” section in Cisco

Unified Communications Manager Security
Guide.

Communications IP address of a Cisco Unified Communications For information about changing these options,

Manager / TFTP Manager and TFTP server used by the phone. Also |[see the “Network Configuration Menu”

Server displays a certificate icon if a certificate is section on page 4-5.

installed for this server.

If neither the primary TFTP (TFTP Server 1) server
nor the backup TFTP server (TFTP Server 2) is
listed in the CTL file, you must unlock the CTL file
before you can save changes that you make to the
TFTP Server 1 option or to the TFTP Server 2 option
on the Network Configuration menu.

Unlocking the CTL File

To unlock the CTL file from the Security Configuration menu, follow these steps:

Procedure

Step1  Press **# to unlock options on the CTL File menu.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
[ 4-32 | oL-14641-01 |



| Chapter4

Configuring Settings on the Cisco Unified IP Phone

Step 2
Step 3

Security Configuration Menu

If you decide not to continue, press **# again to lock options on this menu.

Highlight the CTL option.
Press the Unlock softkey to unlock the CTL file.

After you change and save the TFTP Server 1 or the TFTP Server 2 option, the CTL file will be locked

automatically.
S
Note  When you press the Unlock softkey, it changes to Lock. If you decide not to change the TFTP

Server 1 or TFTP Server 2 option, press the Lock softkey to lock the CTL file.

Trust List Menu

Table 4-20

The Trust List menu displays information about all of the servers that the phone trusts and includes the

options that are described in Table 4-20.

If a CTL file is installed on the phone, you can access the Trust List menu by pressing the Settings button

and choosing Security Configuration > Trust List.

Trust List Menu Settings

Option

Description

To Change

CAPF Server

IP address of the CAPF used by the phone. Also
displays a certificate icon if a certificate is
installed for this server.

For more information about these settings,
refer to the “Configuring the Cisco CTL
Client” section in Cisco

Unified Communications Manager Security
Guide.

Communications
Manager / TFPT
Server

IP address of a Cisco Unified Communications
Manager and TFTP server used by the phone. Also
displays a certificate icon if a certificate is
installed for this server.

For more information about these settings,
refer to the “Configuring the Cisco CTL
Client” section in Cisco

Unified Communications Manager Security
Guide.

SRST Router

IP address of the trusted SRST router that is
available to the phone, if such a device has been
configured in Cisco Unified Communications
Manager Administration. Also displays a certificate
icon if a certificate is installed for this server.

For more information about these settings,
refer to the “Configuring the Cisco CTL
Client” section in Cisco

Unified Communications Manager Security
Guide.
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802.1X Authentication and Status

The 802.1X Authentication and 802.1X Authentication Status menus allow you to enable 802.1X
authentication and monitor its progress. These options are described in Table 4-21 and Table 4-22.

You can access the 802.1X Authentication settings by pressing the Settings button and choosing
Security Configuration > 802.1X Authentication and Security Configuration > 802.1X
Authentication Status.

Table 4-21 802.1X Authentication Settings
Option Description To Change
Device Determines whether 802.1X authentication is 1. Choose Settings > Security Configuration
Authentication enabled: > 802.1X Authentication > Device
¢ Enabled—Phone uses 802.1X authentication Authentication.
to request network access. 2. Set the Device Authentication option to
« Disabled—Default setting in which the phone Enabled or Disabled.
uses CDP to acquire VLAN and network 3. Press the Save softkey.
access.
EAP-MDS5 Specifies a password for use with 802.1X Choose Settings > Security Configuration >

authentication using the following menu options
(described in the following rows):

e Device ID
e Shared Secret

e Realm

802.1X Authentication > EAP-MDS5.

Device ID—Derivative of the phone’s model
number and unique MAC address displayed in this
format: CP-<model>-SEP-<MAC>

Display only—Cannot configure.

Shared Secret—Choose a password to use on the
phone and on the authentication server. The
password must be between 6 and 32 characters,
consisting of any combination of numbers or
letters.

Note If you disable 802.1X authentication or
perform a factory reset of the phone, the

shared secret is deleted.

1. Choose EAP-MDS5 > Shared Secret.
2. Enter the shared secret.
3. Press Save.

See the “Troubleshooting Cisco Unified IP
Phone Security” section on page 9-9 for
assistance in recovering from a deleted shared
secret.

Realm—Indicates the user network domain,
always set as Network

Display only—Cannot configure.
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Table 4-22 describes 802.1X Authentication Real-Time Status.

Table 4-22 802.1X Authentication Real-Time Status

Option Description To Change

802.1X Authentication |Real-time progress of the 802.1X authentication status, Display only—Cannot configure.
Status displaying one of the following states:

e Disabled—802.1X is disabled and transaction was not
attempted

e Disconnected—Physical link is down or disconnected

e Connecting—Trying to discover or acquire the
authenticator

e Acquired—Authenticator acquired, awaiting
authentication to begin

e Authenticating—Authentication in progress

e Authenticated—Authentication successful or implicit
authentication due to timeouts

e Held—Authentication failed, waiting before next attempt
(approximately 60 seconds)

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Configuring Features, Templates, Services, and
Users

After you install Cisco Unified IP Phones in your network, configure their network settings, and add
them to Cisco Unified Communications Manager, you must use Cisco Unified Communications
Manager Administration to configure telephony features, optionally modify phone templates, set up
services, and assign users.

This chapter provides an overview of these configuration and setup procedures. Cisco Unified
Communications Manager documentation provides detailed instructions for these procedures.

For suggestions about how to provide users with information about features, and what information to
provide, see Appendix A, “Providing Information to Users Via a Website.”

For information about setting up phones in non-English environments, see Appendix C, “Supporting
International Users.”

This chapter includes the following topics:
e Telephony Features Available for the Phone, page 5-2
¢ Configuring Corporate and Personal Directories, page 5-14
e Modifying Phone Button Templates, page 5-15
e Configuring Softkey Templates, page 5-15
e Setting Up Services, page 5-16
e Adding Users to Cisco Unified Communications Manager, page 5-16

e Managing the User Options Web Pages, page 5-17

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Telephony Features Available for the Phone

After you add Cisco Unified IP Phones to Cisco Unified Communications Manager, you can add
functionality to the phones. Table 5-1 includes a list of supported telephony features, many of which you
configure by using Cisco Unified Communications Manager Administration. The Configuration
Reference column lists Cisco Unified Communications Manager documentation that contains

Note

configuration procedures and related information.

For information about using most of these features on the phone, refer to Cisco Unified IP Phone 7965G
and 7945G Guide. For a comprehensive listing of features on the phone, refer to Cisco Unified IP Phone

Features A—Z.

Cisco Unified Communications Manager Administration also provides several service parameters that
you can use to configure various telephony functions. For more information about service parameters
and the functions that they control, refer to Cisco Unified Communications Manager Administration

Guide.
Table 5-1 Telephony Features for the Cisco Unified IP Phone
Feature Description Configuration Reference
Abbreviated dialing |Allows users to speed dial a phone number by entering |For more information, refer to:

an assigned index code (1-99) on the phone keypad.

Users assign index codes from the User Options web
pages.

e Cisco Unified Communications Manager
Administration Guide, “Cisco Unified IP
Phone Configuration” chapter.

e Cisco Unified Communications Manager
System Guide, “Cisco Unified IP Phone”
chapter.

Anonymous Call
Block

(SIP phones only)

Allows a user to reject calls from anonymous callers.

Cisco Unified Communications Manager
Administration Guide, “SIP Profile
Configuration” chapter.

Message Waiting

Defines directory numbers for message-waiting on and
message-waiting off indicator. A directly connected
voice-messaging system uses the specified directory
number to set or to clear a message-waiting indication
for a particular Cisco Unified IP Phone.

For more information, refer to:

e Cisco Unified Communications Manager
Administration Guide, “Message
Waiting Configuration” chapter.

e Cisco Unified Communications Manager
System Guide, “Voice Mail Connectivity
to Cisco Unified Communications
Manager” chapter.

Audible Message
Waiting Indicator
(AMWI)

A stutter tone from the handset, headset, or
speakerphone indicates that a user has one or more new
voice messages on a line.

Note The stutter tone is line-specific. You hear it only

when using the line with the waiting messages.

For more information, refer to Cisco Unified
Communications Manager System Guide,
“Cisco Unified IP Phones” chapter.
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Telephony Features Available for the Phone
Table 5-1 Telephony Features for the Cisco Unified IP Phone (continued)
Feature Description Configuration Reference

Auto Answer

Connects incoming calls automatically after a ring or
two.

Auto Answer works with either the speakerphone or the
headset.

For more information, refer to Cisco Unified
Communications Manager Administration
Guide, “Directory Number Configuration”
chapter.

Auto-pickup

Allows a user to use one-touch, pickup functionality for
call pickup, group call pickup, and other group call
pickup.

For more information, refer to the Cisco
Unified Communications Manager Features
and Services Guide, “Call Pickup Group”
chapter.

Barge

Allows a user to join a non-private call on a shared
phone line. Barge features include cBarge and Barge.

e cBarge adds a user to a call and converts it into a
conference, allowing the user and other parties to
access conference features.

e Barge adds a user to a call but does not convert the
call into a conference.

The phones support Barge in two conference modes:

e Built-in conference bridge at the target device (the
phone that is being barged). This mode uses the
Barge softkey.

e Shared conference bridge. This mode uses the
cBarge softkey.

For more information, refer to:

® Cisco Unified Communications Manager
Administration Guide, “Cisco Unified IP
Phone Configuration” chapter.

e Cisco Unified Communications Manager
System Guide, “Cisco Unified IP
Phones” chapter.

e Cisco Unified Communications Manager
Features and Services Guide, “Barge
and Privacy” chapter.

Block external to
external transfer

Prevents users from transferring an external call to
another external number.

For more information, refer to Cisco Unified
Communications Manager Features and
Services Guide, “External Call Transfer
Restrictions” chapter.

Busy Lamp Field
(BLF) speed dial

Allows a user to monitor the call state of a directory
number (DN) associated with a speed-dial button.

For more information, refer to Cisco Unified
Communications Manager Features and
Services Guide, “Presence” chapter.

Call display Determines the information that will display for calling |For more information, refer to:
restrictions f)r colnnzc'te(ihhnesl,ldependlng on the parties who are e Cisco Unified Communications Manager
mvolved m the call. Administration Guide, “Cisco Unified IP
Phone Configuration” chapter.
e Cisco Unified Communications Manager
System Guide, “Understanding Route
Plans” chapter.
e Cisco Unified Communications Manager
Features and Services Guide, “Call
Display Restrictions” chapter.
Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Table 5-1

Telephony Features for the Cisco Unified IP Phone (continued)

Feature

Description

Configuration Reference

Call forward

Allows users to redirect incoming calls to another
number. Call forward options include Call Forward All,
Call Forward Busy, Call Forward No Answer, and Call
Forward No Coverage.

For more information, refer to:

e Cisco Unified Communications Manager
Administration Guide, “Directory
Number Configuration” chapter.

e Cisco Unified Communications Manager
System Guide, “Cisco Unified IP
Phones” chapter.

e “Specifying Options that Appear on the
User Options Web Pages” section on
page 5-17

Call forward

Allows you to specify information that appears on a

For more information, refer to:

configurable phone when a call is forwarded. This information can . . Lo
. : . ® Cisco Unified Communications Manager
display include the caller name, caller number, redirected . . R, .
.. . Administration Guide, “Cisco Unified IP
number, and original dialed number. . .
Phone Configuration” chapter.
e Cisco Unified Communications Manager
System Guide, “Cisco Unified IP
Phones” chapter.
Call forward Allows you to override Call Forward All (CFA) in cases |For more information, refer to “Cisco

destination override

where the CFA target places a call to the CFA initiator.
This feature allows the CFA target to reach the CFA
initiator for important calls. The override works whether
the CFA target phone number is internal or external.

Unified Communications Manager System
Guide”, “Cisco Unified IP Phones” and
"Understanding Directory Numbers"
sections.

Call park

Allows users to park (temporarily store) a call and then
retrieve the call by using another phone in the Cisco
Unified Communications Manager system.

For more information, refer to the Cisco
Unified Communications Manager Features
and Services Guide, “Call Park” chapter.

Call pickup

Allows users to redirect a call that is ringing on another
phone within their pickup group to their phone.

You can configure an audio and/or visual alert for the
primary line on the phone. This alert notifies the users
that a call is ringing in their pickup group.

For more information, refer to the Cisco
Unified Communications Manager
Administration Guide, “Call Pickup Group
Configuration” chapter.

Call recording

Allows a supervisor to record an active call. The user
might hear an intermittent tone (beep tone) during a call
when it is being recorded.

The intercom feature is disabled when a call is
being monitored or recorded.

Note

For more information, refer to the Cisco
Unified Communications Manager Features
and Services Guide, “Monitoring and
Recording” chapter.

Call waiting

Indicates (and allows users to answer) an incoming call
that rings while on another call. Displays incoming call
information on the phone screen.

For more information, refer to the Cisco
Unified Communications Manager
Administration Guide, “Cisco Unified IP
Phone Configuration” chapter.

l_ Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1

0L-14641-01



| Chapter5

Configuring Features, Templates, Services, and Users

Telephony Features Available for the Phone

Table 5-1 Telephony Features for the Cisco Unified IP Phone (continued)
Feature Description Configuration Reference
Caller ID Displays caller identification such as a phone number, |For more information, refer to:

name, or other descriptive text on the phone screen.

e Cisco Unified Communications Manager
Administration Guide, “Directory
Number Configuration chapter” chapter.

e Cisco Unified Communications Manager
System Guide, “Understanding Route
Plans” chapter.

e Cisco Unified Communications Manager
Features and Services Guide, “Call
Display Restrictions” chapter.

Caller ID Blocking

Blocks a user’s phone numbers or e-mail addresses.

For more information, refer to:

* Cisco Unified Communications Manager
System Guide, "Understanding Route
Plans" chapter.

e Cisco Unified Communications Manager
Administration Guide, "Directory
Number Configuration" chapter.

e Cisco Unified Communications Manager
Administration Guide, "SIP Profile
Configuration" chapter.

Cisco Call Back

Provides users with an audio and visual alert on the
phone when a busy or unavailable party becomes
available.

For more information, refer to:

e Cisco Unified Communications Manager
System Guide, “Cisco Unified IP
Phones” chapter.

* Cisco Unified Communications Manager
Features and Services Guide, “Cisco
Call Back” chapter.

Cisco Unified
Communications
Manager Assistant

Enables managers and their assistants to work together
more effectively by providing a call-routing service,
enhancements to phone capabilities for the manager,
and desktop interfaces that are primarily used by the
assistant.

For more information, refer to the Cisco
Unified Communications Manager Features
and Services Guide, “Cisco Unified
Communications Manager Assistant With
Proxy Line Support” and “Cisco Unified
Communications Manager Assistant With
Shared Line Support” chapters.

Client matter codes
(CMC)

Enables a user to specify that a call relates to a specific
client matter.

For more information, refer to: the Cisco
Unified Communications Manager Features
and Services Guide, “Client Matter Codes

SCCP phones 7
E)nly) P and Forced Authorization Codes” chapter.
Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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B Telephony Features Available for the Phone

Table 5-1 Telephony Features for the Cisco Unified IP Phone (continued)
Feature Description Configuration Reference
Conference e Allows a user to talk simultaneously with multiple | ¢ For more information, refer to

parties by calling each participant individually.
Conference features include Conference, Join,
cBarge, and Meet-Me.

e Allows a non-initiator in a standard (ad hoc)
conference to add or remove participants; also
allows any conference participant to join together
two standard conferences on the same line.

Cisco Unified Communications
Manager System Guide,

“Cisco Unified IP Phones” and
“Conference Bridges” chapters.

e The service parameter, Advance Adhoc
Conference, (disabled by default in
Cisco Unified Communications Manager
Administration) allows you to enable
these features.

Note  Be sure to inform your users whether

these features are activated.

Configurable call
forward display

Allows you to specify information that appears on a
phone when a call is forwarded. This information can
include the caller name, caller number, redirected
number, and original dialed number.

For more information, refer to:

® Cisco Unified Communications Manager
Administration Guide, “Directory
Number Configuration” chapter.

* Cisco Unified Communications Manager
System Guide, “Cisco Unified IP
Phones” chapter.

Directed Call Park

Allows a user to direct an active call to an available
directed call park number. After pressing Transfer, the
user dials the directed call park number to store the call.

A Call Park BLF button provides speed dial access to
the directed call park number and indicates that the
directed call park number is available or unavailable.

Note If you implement Directed Call Park, avoid
configuring the Park softkey. This prevents

users from confusing the two Call Park features.

For more information refer to:

e Cisco Unified Communications Manager
Features and Services Guide, “Call Park
and Directed Call Park” chapter.

Direct transfer

(SCCP phones
only)

Allows users to connect two calls to each other (without
remaining on the line).

For more information, refer to Cisco Unified
Communications Manager System Guide,
“Cisco Unified IP Phones” chapter.
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Table 5-1

Telephony Features Available for the Phone

Telephony Features for the Cisco Unified IP Phone (continued)

Feature

Description

Configuration Reference

Do Not Disturb
(DND)

When DND is turned on, no audible rings occur during
the ringing-in state of a call.

You can configure the phone to have a softkey template
with a DND softkey or a phone-button template with
DND as one of the selected features.

The following DND-related parameters are configurable
in Cisco Unified Communications Manager
Administration:

e Do Not Disturb—This checkbox allows you to
enable DND on a per-phone basis. Choose Device >
Phone > Phone Configuration.

e DND Incoming Call Alert—Choose the type of
alert to play on a phone for incoming calls when
DND is active. This parameter is located on both the
Common Phone Profile window and the Phone
configuration window (Phone Configuration value
takes precedence).

e Include DND In BLF Status—Enables DND status
to override busy/idle state.

The user can use Cisco Unified
Communications Manager User Options pages
to enable/disable DND, and to change DND
Incoming Call Alert and DND Timeout settings.

Note

Cisco Unified Communications Manager
Features and Services Guide, “Do Not Disturb”
chapter.

Extension Mobility

(SCCP phones
only)

Allows a user to temporarily apply a phone number and
user profile settings to a shared Cisco Unified IP Phone
by logging into the Extension Mobility service on that

phone.

Extension Mobility can be useful if users work from a
variety of locations within your company or if they
share a workspace with coworkers.

For more information, refer to the Cisco
Unified Communications Manager Features
and Services Guide, “Cisco Unified
Communications Manager Extension
Mobility” chapter.

Fast Dial Service

Allows a user to enter a Fast Dial code to place a call.
Fast Dial codes can be assigned to phone numbers or
Personal Address Book entries. (See “Services” in this
table.)

For more information, refer to:

* Cisco Unified Communications Manager
Administration Guide, “Cisco Unified IP
Phone Services Configuration” chapter.

® Cisco Unified Communications Manager
System Guide, “Cisco Unified IP Phone
Services” chapter.

Forced
authorization codes
(FAC)

(SCCP phones
only)

Controls the types of calls that certain users can place.

For more information, refer to the Cisco
Unified Communications Manager Features
and Services Guide, “Client Matter Codes
and Forced Authorization Codes” chapter.
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Table 5-1

Telephony Features for the Cisco Unified IP Phone (continued)

Feature

Description

Configuration Reference

Group call pickup

Allows a user to answer a call ringing on a phone in
another group by using a group pickup code.

For more information, refer to the Cisco
Unified Communications Manager Features
and Services Guide, “Call Pickup Group”
chapter.

Hold

Allows the user to move a connected call from an active
state to a held state.

e Requires no configuration, unless you
want to use music on hold. See
“Music-on-Hold” in this table for
information.

e See also: “Hold Reversion” in this table.

Hold Reversion

Limits the amount of time that a call can be on hold
before reverting back to the phone that put the call on
hold and alerting the user.

Reverting calls are distinguished from incoming calls by
a single ring (or beep, depending on the new call
indicator setting for the line). This notification repeats
at intervals if not resumed.

A call that triggers Hold Reversion also displays an
animated icon in the call bubble and a brief message on
the status line.

You can configure call focus priority to favor incoming
or reverting calls.

For more information about configuring this
feature, refer to Cisco Unified
Communications Manager Features and
Services Guide, “Hold Reversion” chapter.

Hunt Group

Provides load sharing for calls to a main directory
number. A hunt group contains a series of directory
numbers that can answer the incoming calls. When the
first directory number in the hunt group is busy, the
system hunts in a predetermined sequence for the next
available directory number in the group and directs the
call to that phone.

For more information, refer to:

e Cisco Unified Communications Manager
Administration Guide, “Hunt Group
Configuration” chapter.

® Cisco Unified Communications Manager
System Guide, “Understanding Route
Plans” chapter.

Immediate Divert

Allows a user to transfer a ringing, connected, or held
call directly to a voice-messaging system. When a call
is diverted, the line becomes available to make or
receive new calls.

For more information, refer to the

Unified Communications Manager Features
and Services Guide, “Immediate Divert”
chapter.
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Telephony Features Available for the Phone

Table 5-1 Telephony Features for the Cisco Unified IP Phone (continued)
Feature Description Configuration Reference
Intercom Allows users to place and receive intercom calls using | ® Cisco Unified CallManager Feature and
programmable phone buttons. You can configure Services Guide, Release 6.1, “Intercom
intercom line buttons to: chapter”
¢ Directly dial a specific intercom extension. e Cisco Unified CallManager Feature and
e Initiate an intercom call and then prompt the user to Servzceis Gmde,. Release 6.1, “Cisco
Lo Extension Mobility” chapter
enter a valid intercom number.
)
Note  If your user logs into the same phone on a daily
basis using their Cisco Extension Mobility
profile, assign the phone button template that
contains intercom information to their profile,
and assign the phone as the default intercom
device for the intercom line.
Join Allows users to join two or more calls that are on one |For more information refer to the Cisco
line to create a conference call and remain on the call. |Unified Communications Manager System
(SCCP phones : . . ’
Guide, “Cisco Unified IP Phones” chapter.
only)
Join Across Lines |Allows users to apply the Join feature to calls that are on |For more information:
(SCCP phones multiple phone lines. e See the Configuring Softkey Templates,
only) page 5-15.

Refer to Cisco Unified Communications
Manager System Guide, “Cisco Unified IP
Phones” chapter.

Log out of hunt
groups

Allows users to log out of a hunt group and temporarily
block calls from ringing their phone when they are not
available to take calls. Logging out of hunt groups does
not prevent non-hunt group calls from ringing their
phone.

For more information
e See the Configuring Softkey Templates,
page 5-15.

® Cisco Unified Communications Manager
System Guide, “Understanding Route
Plans” chapter.

Malicious Call

Allows users to notify the system administrator about

For more information refer to:

1(§/<I,gt11]f)1cat10n suspicious calls that are received. e Cisco Unified Communications Manager
( ) System Guide, “Cisco Unified IP
(SCCP phones Phones” chapter.
only) e Cisco Unified Communications Manager
Features and Services Guide,
“Malicious Call Identification” chapter.
Meet-Me Allows a user to host a Meet-Me conference in which  |For more information refer to Cisco Unified
conference other participants call a predetermined number at a Communications Manager Administration
scheduled time. Guide, “Meet-Me Number/Pattern
Configuration” and "Conference Bridges"
chapters.
Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Table 5-1

Telephony Features for the Cisco Unified IP Phone (continued)

Feature

Description

Configuration Reference

Message waiting
indicator

A light on the handset that indicates that a user has one
or more new voice messages.

For more information refer to:

e Cisco Unified Communications Manager
Administration Guide, “Message
Waiting Configuration” chapter.

e Cisco Unified Communications Manager
System Guide, “Voice Mail Connectivity
to Cisco Unified Communications
Manager” chapter.

Mobile Connect

Enables users to manage business calls using a single
phone number and pick up in-progress calls on the
desktop phone and mobile phone.

For more information, refer to the Cisco
Unified Communications Manager Features
and Services Guide, “Mobile Connect and
Mobile Voice Access” chapter.

Mobile Voice

Extends Mobile Connect capabilities by allowing users

For more information, refer to the Cisco

Access to access an interactive voice response (IVR) system to |Unified Communications Manager Features
originate a call from a remote device such as a cellular |and Services Guide, “Mobile Connect and
phone. Mobile Voice Access” chapter.

Multilevel Provides a method of prioritizing calls within your For more information refer to Cisco Unified

Precedence and phone system. Use this feature when users work in an  |Communications Manager Features and

Preemption environment where they need to make and receive Services Guide, “Multilevel Precedence and

(MLPP) urgent or critical calls. Preemption” chapter.

(SCCP phones

only)

Music-on- hold

Plays music while callers are on hold.

For more information refer to the Cisco
Unified Communications Manager Features
and Services Guide, “Music On Hold”
chapter.

Onhook call
transfer

Allows a user to press a single Transfer softkey and then
go onhook to complete a call transfer.

For more information refer to Cisco Unified
Communications Manager System Guide,
“Cisco Unified IP Phones” chapter.

Other group pickup

Allows a user to answer a call ringing on a phone in
another group that is associated with the user's group.

For more information refer to the Cisco
Unified Communications Manager Features
and Services Guide, “Call Pickup” chapter.

Presence-enabled
directories

Allows a user to monitor the call state of another
directory number (DN) listed in call logs, speed dials,
and corporate directories. The Busy Lamp Field (BLF)
for the DN displays the call state.

For more information, refer to Cisco Unified
Communications Manager Features and
Services Guide, “Presence” chapter.

Private Line
Automated
Ringdown (PLAR)

(SIP phones only)

The Cisco Unified Communications Manager
administrator can configure a phone number that the
Cisco Unified IP Phone dials as soon as the handset
goes off hook. This can be useful for phones that are

designated for calling emergency or “hotline” numbers.

Refer to Cisco Unified Communications
Manager System Guide, “SIP Dial Rules
Configuration” chapter.
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Telephony Features Available for the Phone
Table 5-1 Telephony Features for the Cisco Unified IP Phone (continued)
Feature Description Configuration Reference
Privacy Prevents users who share a line from adding themselves |For more information refer to:

to a call and from viewing information on their phone
screens about the call of the other user.

e Cisco Unified Communications Manager
Administration Guide, “Cisco Unified IP
Phone Configuration” chapter.

e Cisco Unified Communications Manager
System Guide, “Cisco Unified IP
Phones” chapter.

e Cisco Unified Communications Manager
Features and Services Guide “Barge and
Privacy” chapter.

Quality Reporting

Allows users to use the QRT softkey on a phone to

For more information refer to:

Tool (QRT) submit i.nformation .about problem phone calls. QRT.can e Cisco Unified Communications Manager
be configured for either of two user modes, depending e .
. . . 5 System Guide, “Cisco Unified IP
upon the amount of user interaction desired with QRT. »
Phones” chapter.
e Cisco Unified Communications Manager
Features and Services Guide, “Quality
Report Tool” chapter.
Redial Allows users to call the most recently dialed phone Requires no configuration.

number by pressing a softkey.

Ring setting

Identifies ring type used for a line when a phone has
another active call.

For more information refer to:

* Cisco Unified Communications Manager
Administration Guide, “Directory
Number Configuration” chapter.

e “Creating Custom Phone Rings” section
on page 6-2.

Secure Conference

e Allows secure phones to place conference calls by
using a secured conference bridge.

e As new participants are added by using Confrn,
Join, cBarge, Barge softkeys or MeetMe
conferencing, the secure call icon displays as long
as all participants use secure phones.

e The Conference List displays the security level of
each conference participant. Initiators can remove
non-secure participants from the Conference List.
(Non-initiators can add or remove conference
participants if the Advanced Adhoc Conference
Enabled parameter is set.)

For more information about security, see the
“Overview of Supported Security Features”
section.

For additional information, refer to these:

e Cisco Unified Communications Manager
System Guide, “Conference Bridges”
chapter

e Cisco Unified Communications Manager
Administration Guide, “Conference
Bridge Configuration” chapter

® Cisco Unified Communications Manager
Security Guide.
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B Telephony Features Available for the Phone

Table 5-1 Telephony Features for the Cisco Unified IP Phone (continued)
Feature Description Configuration Reference
Services Allows you to use the Cisco Unified IP Phone Services |For more information refer to:

Configuration menu in Cisco Unified Communications
Manager Administration to define and maintain the list
of phone services to which users can subscribe.

e Cisco Unified Communications Manager
Administration Guide, “Cisco Unified IP
Phone Configuration” chapter.

e Cisco Unified Communications Manager
System Guide, “Cisco Unified IP Phone
Services” chapter.

Services URL
button

Allows users to access services from a programmable
button rather than by using the Services menu on a
phone.

For more information refer to:

® Cisco Unified Communications Manager
Administration Guide, “Cisco Unified IP
Phone Configuration” chapter.

® Cisco Unified Communications Manager
System Guide, “Cisco Unified IP Phone
Services” chapter.

Shared line

Allows a user to have several phones that share the same
phone number or allows a user to share a phone number
with a coworker.

For more information refer to Cisco Unified
Communications Manager System Guide,
“Cisco Unified IP Phones” chapter.

Silent Monitoring

Allows a supervisor to silently monitor an active call.
The supervisor cannot be heard by either party on the
call. The user might hear an intermittent tone (beep
tone) during a call when it is being monitored.

The intercom feature is disabled when a call is
being monitored or recorded.

Note

For more information, refer to the Cisco
Unified Communications Manager Features
and Services Guide, “Monitoring and
Recording” chapter.

Single Button
Barge

(SCCP phones
only)

Allows users to press a line key to Barge or cBarge into
a remote-in-use call on a shared line.

For more information, refer to:

e Cisco Unified Communications Manager
Administration Guide, “Cisco Unified IP
Phone Configuration” chapter.

e Cisco Unified Communications Manager
System Guide, “Cisco Unified IP
Phones” chapter.

Cisco Unified Communications Manager
Features and Services Guide, “Barge and
Privacy” chapter.

Speed dialing

Dials a specified number that has been previously
stored.

For more information refer to:

e Cisco Unified Communications Manager
Administration Guide, “Cisco Unified IP
Phone Configuration” chapter.

® Cisco Unified Communications Manager
System Guide, “Cisco Unified IP
Phones” chapter.
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Telephony Features Available for the Phone

Table 5-1 Telephony Features for the Cisco Unified IP Phone (continued)

Feature Description Configuration Reference
Time-of-Day Restricts access to specified telephony features by time |For more information refer to:
Routing period.

e Cisco Unified Communications Manager
Administration Guide, “Time Period
Configuration” chapter.

e Cisco Unified Communications Manager
System Guide, “Time-of-Day Routing”
chapter.

Phone screen

Allows user to disable phone screen illumination on a

Refer to the Cisco Unified IP Phone Service

illumination phone, which would override other rules that determine |Application Development Notes at the

disabling when the phone screen gets illuminated. following location:
To provide this feature, you must implement the Display |http://www.cisco.com/en/US/products/sw/vo
URI, which includes configuring the length of time that |icesw/ps556/products_programming_referen
illumination remains disabled. ce_guides_list.html

Transfer Allows users to redirect connected calls from their Requires no configuration.

phones to another number.

Video mode

(SCCP phones
only)

Allows a user to select the video display mode for
viewing a video conference, depending on the modes
configured in the system.

For more information:

e Refer to Cisco Unified Communications
Manager Administration Guide,
“Conference Bridge Configuration”
chapter.

e Refer to Cisco Unified Communications
Manager System Guide, “Understanding
Video Telephony” chapter.

Video support

(SCCP phones
only)

Enable video support on the phone.

For more information refer to:

e Cisco Unified Communications Manager
Administration Guide, “Conference
Bridge Configuration” chapter.

e Cisco Unified Communications Manager
System Guide, “Understanding Video
Telephony” chapter.

e Cisco VT Advantage Administration
Guide, “Overview of Cisco VT
Advantage” chapter.

Voice messaging
system

Enables callers to leave messages if calls are
unanswered.

For more information refer to:

e Cisco Unified Communications Manager
Administration Guide, “Cisco
Voice-Mail Port Configuration” chapter.

* Cisco Unified Communications Manager
System Guide, “Voice Mail Connectivity
to Cisco Unified Communications
Manager” chapter.
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W Configuring Corporate and Personal Directories

Configuring Corporate and Personal Directories

The Directories button on the Cisco Unified IP Phone 7965G and 7945G gives users access to several
directories. These directories can include:

e Corporate Directory—Allows a user to look up phone numbers for co-workers.

To support this feature, you must configure corporate directories. See the “Configuring Corporate
Directories” section on page 5-14 for more information.

e Personal Directory—Allows a user to store a set of personal numbers.

To support this feature, you must provide the user with software to configure the personal directory.
See the “Configuring Personal Directory” section on page 5-14 for more information.

Configuring Corporate Directories

Cisco Unified Communications Manager uses a Lightweight Directory Access Protocol (LDAP)
directory to store authentication and authorization information about users of Cisco Unified
Communications Manager applications that interface with Cisco Unified Communications Manager.
Authentication establishes a user’s right to access the system. Authorization identifies the telephony
resources that a user is permitted to use, such as a specific telephone extension.

For more information, refer to the “LDAP System”, “LDAP Directory”, and “LDAP Authentication”
chapters in the Cisco Unified Communications Manager Guide.

After the LDAP directory configuration completes, users can use the Corporate Directory service on
their Cisco Unified IP Phone to look up users in the corporate directory.

Configuring Personal Directory

Personal Directory consists of the following features:
e Personal Address Book (PAB)
e Personal Fast Dials (Fast Dials)
e Address Book Synchronization Tool (TABSynch)
Users can access Personal Directory features by these methods:

e From a web browser—Users can access the PAB and Fast Dials features from the Cisco Unified
Communications Manager User Options web pages

e From the Cisco Unified IP Phone—Users can choose Directories > Personal Directory to access
the PAB and Fast Dials features from their phones

e From a Microsoft Windows application—Users can use the TABSynch tool to synchronize their
PABs with Microsoft Outlook.

To configure Personal Directory from a web browser, users must access their User Options web pages.
You must provide users with a URL and login information.

To synchronize with Microsoft Outlook, users must install the TABSynch utility, which is provided by
you. To obtain the TABSynch software to distribute to users, choose Application > Plugins from
Cisco Unified Communications Manager Administration, then locate and click Cisco IP Phone Address
Book Synchronizer.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Modifying Phone Button Templates

Phone button templates let you assign speed dials and features to programmable line buttons.

While both SCCP and SIP phones support speed-dial buttons, support for call features on buttons
depends on the call control protocol:

e On SCCP phones, call handling features that can be assigned to buttons include call forward, redial,
hold, conferencing, and so on.

¢ On SIP phones, only the Do Not Disturb (DND) feature can be assigned to a button.

Ideally, you modify templates before registering phones on the network. In this way, you can access
customized phone button template options from Cisco Unified Communications Manager during
registration.

To modify a phone button template, choose Device > Device Settings > Phone Button Template from
Cisco Unified Communications Manager Administration. To assign a phone button template to a phone,
use the Phone Button Template field in the Cisco Unified Communications Manager Administration
Phone Configuration window. Refer to Cisco Unified Communications Manager Administration Guide
and Cisco Unified Communications Manager System Guide for more information.

The default Cisco Unified IP Phone 7965G template that ships with the phone uses buttons 1 and 2 for
lines and assigns buttons 3 through 6 as speed dial.

The default Cisco Unified IP Phone 7945G template that ships with the phone uses buttons 1 and 2 for
lines.

To avoid confusion for users, do not assign a feature to a button and a softkey at the same time.

The recommended standard Cisco Unified IP Phone 7965G template uses buttons 1 and 2 for lines,
assigns button 3 as speed dial, and buttons 4 through 6 as Hold, Conference, and Transfer, respectively.

The recommended standard Cisco Unified IP Phone 7945G template uses buttons 1 and 2 for lines.

For more information about softkey templates, see Configuring Softkey Templates, page 5-15.

Configuring Softkey Templates

Using Cisco Unified Communications Manager Administration, you can manage softkeys that are
associated with applications that are supported by the Cisco Unified IP Phone 7965G and 7945G.
Cisco Unified Communications Manager supports two types of softkey templates: standard and
nonstandard. Standard softkey templates include Standard User, Standard Feature, Standard IPMA
Assistant, Standard IPMA Manager, and Standard IPMA Shared Mode Manager An application that
supports softkeys can have one or more standard softkey templates associated with it. You can modify
a standard softkey template by making a copy of it, giving it a new name, and making updates to that
copied softkey template. You can also modify a nonstandard softkey template.

To configure softkey templates, choose Device > Device Settings > Softkey Template from

Cisco Unified Communications Manager Administration. To assign a softkey template to a phone, use
the Softkey Template field in the Cisco Unified Communications Manager Administration Phone
Configuration page. Refer to Cisco Unified Communications Manager Administration Guide and Cisco
Unified Communications Manager System Guide for more information.
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Setting Up Services

The Services button on the Cisco Unified IP Phone gives users access to Cisco Unified IP Phone
Services. You can also assign services to the programmable buttons on the phone (refer to Cisco Unified
IP Phone 7965G and 7945G Guide for more information). These services comprise XML applications
that enable the display of interactive content with text and graphics on the phone. Examples of services
include local movie times, stock quotes, and weather reports.

Before a user can access any service:

¢ You must use Cisco Unified Communications Manager Administration to configure available
services.

e The user must subscribe to services by using the Cisco Unified IP Phone User Options application.
This web-based application provides a graphical user interface (GUI) for limited, end-user
configuration of IP Phone applications.

Before you set up services, gather the URLSs for the sites that you want to set up and verify that users can
access those sites from your corporate IP telephony network.

To set up these services, choose Device > Device Settings > Phone Services from

Cisco Unified Communications Manager Administration. Refer to Cisco Unified Communications
Manager Administration Guide and to Cisco Unified Communications Manager System Guide for more
information.

After you configure these services, verify that your users have access to the Cisco Unified
Communications Manager IP Phone Options web-based application, from which they can select and
subscribe to configured services. See the “How Users Subscribe to Services and Configure Phone
Features” section on page A-3 for a summary of the information that you must provide to end users.

Adding Users to Cisco Unified Communications Manager

Adding users to Cisco Unified Communications Manager allows you to display and maintain
information about users and allows each user to perform these tasks:

e Access the corporate directory and other customized directories from a Cisco Unified IP Phone
¢ Create a personal directory
e Set up speed dial and call forwarding numbers
e Subscribe to services that are accessible from a Cisco Unified IP Phone
You can add users to Cisco Unified Communications Manager using either of these methods:

e To add users individually, choose User Management > End User from
Cisco Unified Communications Manager Administration.

Refer to Cisco Unified Communications Manager Administration Guide for more information about
adding users. Refer to Cisco Unified Communications Manager System Guide for details about user
information.

e To add users in batches, use the Bulk Administration Tool. This method also enables you to set an
identical default password for all users.

Refer to Cisco Unified Communications Manager Bulk Administration Guide for details.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Managing the User Options Web Pages

From the User Options web page, users can customize and control several phone features and settings.
For detailed information about the User Options web pages, refer to Cisco Unified IP Phone 7965G and
7945G Guide.

Giving Users Access to the User Options Web Pages

Before a user can access the User Options web pages, you must use Cisco Unified Communications
Manager Administration to add the user to a standard Cisco Unified Communications Manager end user
group. To do so, choose User Management > User Group. You must also associate appropriate phones
with the user. To perform these procedures, from Cisco Unified Communications Manager
Administration, choose User Management > End User.

For additional information, refer to Cisco Unified Communications Manager Administration Guide,
“End User Configuration” section.

Specifying Options that Appear on the User Options Web Pages

Note

Step 1

Step 2

Most options that are on the User Options web pages appear by default. However, the following options
must be set by the system administrator by using Enterprise Parameters Configuration settings in Cisco
Unified Communications Manager Administration:

¢ Show Ring Settings
e Show Line Text Label Settings

e Show Call Forwarding

The settings apply to all User Options web pages at your site.

To specify the options that appear on the User Options web pages, follow these steps:

Procedure

From Cisco Unified Communications Manager Administration, choose System > Enterprise
Parameters.

The Enterprise Parameters Configuration window appears.

In the CCMUser Parameters area, specify whether a parameter appears on the User Options web pages
by choosing one of these values from the Parameter Value drop-down list box for the parameter:

¢ True—Option displays on the User Options web pages (default).

e False—Option does not display on the User Options web pages.

e Show All Settings—All call forward settings display on the User Options web pages (default).

e Hide All Settings—No call forward settings display on the User Options web pages.

¢ Show Only Call Forward All—Only call forward all calls displays on the User Options web pages.
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Customizing the Cisco Unified IP Phone

This chapter explains how you customize configuration files, phone ring sounds, background images,
and other phone features.

This chapter includes these topics:
e Customizing and Modifying Configuration Files, page 6-1
¢ Creating Custom Phone Rings, page 6-2
e Creating Custom Background Images, page 6-4
e Configuring Wideband Codec, page 6-6
¢ Configuring the Idle Display, page 6-7
e Automatically Disabling the Cisco Unified IP Phone Screen, page 6-8

Customizing and Modifying Configuration Files

You can modify configuration files (for example, edit the xml files) and add customized files (for
example, custom ring tones, call back tones, phone backgrounds) to the TFTP directory. You can modify
files and add customized files to the TFTP directory in Cisco Unified Communications Operating
System Administration, from the TFTP Server File Upload window. Refer to Cisco Unified
Communications Operating System Administration Guide for information about how to upload files to
the TFTP folder on a Cisco Unified Communications Manager server.

You can obtain a copy of the Ringlist.xml and List.xml files from the system using the following admin
command-line interface (CLI) “file” commands:

e admin:file

- file list*

file view™
— file search*
- file get*

- file dump*
- file tail*

— file delete*

| oL-14641-01
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Creating Custom Phone Rings

The Cisco Unified IP Phone ships with two default ring types that are implemented in hardware: Chirpl
and Chirp2. Cisco Unified Communications Manager also provides a default set of additional phone ring
sounds that are implemented in software as pulse code modulation (PCM) files. The PCM files, along
with an XML file (named Ringlist.xml) that describes the ring list options that are available at your site,
exist in the TFTP directory on each Cisco Unified Communications Manager server.

For more information, see the “Cisco TFTP” chapter in Cisco Unified Communications Manager System
Guide and the “Software Upgrades” chapter in Cisco Unified Communications Operating System
Administration Guide.

The following sections describe how you can customize the phone rings that are available at your site
by creating PCM files and editing the Ringlist.xml file:

e Ringlist.xml File Format Requirements, page 6-2
e PCM File Requirements for Custom Ring Types, page 6-3
e Configuring a Custom Phone Ring, page 6-3

Ringlist.xml File Format Requirements

Note

The Ringlist.xml file defines an XML object that contains a list of phone ring types. This file can include
up to 50 ring types. Each ring type contains a pointer to the PCM file that is used for that ring type and
the text that will appear on the Ring Type menu on a Cisco Unified IP Phone for that ring. The

Cisco TFTP server for each Cisco Unified Communications Manager contains this file.

The CiscolPPhoneRinglist XML object uses the following simple tag set to describe the information:
<CiscoIPPhoneRingList>
<Ring>
<DisplayName/>
<FileName/>
</Ring>
</CiscoIPPhoneRingList>

The following characteristics apply to the definition names. You must include the required DisplayName
and FileName for each phone ring type.

e DisplayName defines the name of the custom ring for the associated PCM file that will display on
the Ring Type menu of the Cisco Unified IP Phone.

e FileName specifies the name of the PCM file for the custom ring to associate with DisplayName.

The DisplayName and FileName fields must not exceed 25 characters.

This example shows a Ringlist.xml file that defines two phone ring types:

<CiscoIPPhoneRingList>
<Ring>
<DisplayName>Analog Synth 1</DisplayName>
<FileName>Analogl.raw</FileName>
</Ring>
<Ring>
<DisplayName>Analog Synth 2</DisplayName>
<FileName>Analog2.raw</FileName>
</Ring>
</CiscoIPPhoneRingList>
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PCM File Requirements for Custom Ring Types

The PCM files for the rings must meet the following requirements for proper playback on
Cisco Unified IP Phones:

e Raw PCM (no header)

e 8000 samples per second

e 8 bits per sample

e ulLaw compression

e Maximum ring size—16080 samples

e Minimum ring size—240 samples

e Number of samples in the ring is evenly divisible by 240.
¢ Ring starts and ends at the zero crossing.

e To create PCM files for custom phone rings, you can use any standard audio editing packages that
support these file format requirements.

Configuring a Custom Phone Ring

Step 1

Step 2

Step 3

Step 4
Step 5

To create custom phone rings for the Cisco Unified IP Phone 7965G and 7945G, follow these steps:

Procedure

Create a PCM file for each custom ring (one ring per file). Ensure the PCM files comply with the format
guidelines that are listed in the “PCM File Requirements for Custom Ring Types” section on page 6-3.

Upload the new PCM files that you created to the Cisco TFTP server for each Cisco Unified
Communications Manager in your cluster. For more information, see the “Software Upgrades” chapter
in Cisco Unified Communications Operating System Administration Guide.

Use a text editor to edit the Ringlist.xml file. See the “Ringlist.xml File Format Requirements” section
on page 6-2 for information about how to format this file and for a sample Ringlist.xml file.

Save your modifications and close the Ringlist.xml file.

To cache the new Ringlist.xml file, stop and start the TFTP service by using Cisco Unified Serviceability
or disable and re-enable the “Enable Caching of Constant and Bin Files at Startup” TFTP service
parameter (located in the Advanced Service Parameters).
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Creating Custom Background Images

You can provide users with a choice of background images for the LCD screen on their phones. Users
can select a background image by choosing Settings > User Preferences > Background Images on the
phone.

The image choices that users see come from PNG images and an XML file (called List.xml) that are
stored on the TFTP server used by the phone. By storing your own PNG files and editing the XML file
on the TFTP server, you can designate the background images from which users can choose. In this way,
you can provide custom images, such as your company logo.

The following sections describe how you can customize the background images that are available at your
site by creating your own PNG files and editing the List.xml file:

e List.xml File Format Requirements, page 6-4.
e PNG File Requirements for Custom Background Images, page 6-5.
e Configuring a Custom Background Image, page 6-5

List.xml File Format Requirements

Tip

The List.xml file defines an XML object that contains a list of background images. The List.xml file is
stored in the following subdirectory on the TFTP server:

/Desktops/320x212x16

If you are manually creating the directory structure and the List.xml file, you must ensure that the
directories and files can be accessed by the user\CCMService, which is used by the TFTP service.

For more information, see the “Cisco TFTP” chapter in Cisco Unified Communications Manager System
Guide and the “Software Upgrades” chapter in Cisco Unified Communications Operating System
Administration Guide.

The List.xml file can include up to 50 background images. The images are in the order that they appear
in the Background Images menu on the phone. For each image, the List.xml file contains one element
type, called Imageltem. The Imageltem element includes these two attributes:

¢ Image—Uniform resource identifier (URI) that specifies where the phone obtains the thumbnail
image that will appear on the Background Images menu on a Phone.

¢ URI—URI that specifies where the phone obtains the full size image.

The following example shows a List.xml file that defines two images. The required Image and URL
attributes must be included for each image. The TFTP URI that is shown in the example is the only
supported method for linking to full size and thumbnail images. HTTP URL support is not provided.

List.xml Example

<CiscoIPPhoneImageList>

<Imageltem Image="TFTP:Desktops/320x212x16/TN-Fountain.png”
URL="TFTP:Desktops/320x212x16/Fountain.png” />

<Imageltem Image="TFTP:Desktops/320x212x16/TN-FullMoon.png”
URL="TFTP:Desktops/320x212x16/FullMoon.png” />
</CiscoIPPhoneImageList>
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The Cisco Unified IP Phone firmware includes a default background image. This image is not defined
in the List.xml file. The default image is always the first image that appears in the Background Images
menu on the phone.

PNG File Requirements for Custom Background Images

Each background image requires two PNG files:
e Full size image—Version that appears on the on the phone.

¢ Thumbnail image—Version that appears on the Background Images screen from which users can
select an image. Must be 25% of the size of the full size image.

Tip Many graphics programs provide a feature that will resize a graphic. An easy way to create a thumbnail
image is to first create and save the full size image, then use the sizing feature in the graphics program
to create a version of that image that is 25% of the original size. Save the thumbnail version by using a
different name.

The PNG files for background images must meet the following requirements for proper display on the
Cisco Unified IP Phone:

e Full size image—320 pixels (width) X 212 pixels (height).
e Thumbnail image—80 pixels (width) X 53 pixels (height).

e Color palette—Includes up to 16-bit color (65535 colors). You can use more than 16-bit color, but
the phone will reduce the color palette to 16-bit before displaying the image. For best results, reduce
the color palette of an image to 16-bit when you create a PNG file.

e

Tip If you are using a graphics program that supports a posterize feature for specifying the number
of tonal levels per color channel, set the number of tonal levels per channel to 40 (40 red X 40
green X 40 blue = 64000 colors). This is as close as you can posterize to 65535 colors without
exceeding the maximum.

Configuring a Custom Background Image

To create custom background images for the Cisco Unified IP Phone, follow these steps:

Procedure

Step 1 Create two PNG files for each image (a full size version and a thumbnail version). Ensure the PNG files
comply with the format guidelines that are listed in the “PNG File Requirements for Custom Background
Images” section on page 6-5.

Step2  Upload the new PNG files that you created to the following subdirectory in the TFTP server for the Cisco
Unified Communications Manager:

/Desktops/320x212x16
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Step 3

Step 4

Step 5

Step 6

~

Note  The file name and subdirectory parameters are case sensitive. Be sure to use the forward slash
“/” when you specify the subdirectory path.

To upload the files, choose Software Upgrades > Upload TFTP Server File in Cisco Unified
Communications Operating System Administration. For more information, see the “Software Upgrades”
chapter in Cisco Unified Communications Operating System Administration Guide.

You must also copy the customized images and files to the other TFTP servers that the phone may
contact to obtain these files.

S
Note  Cisco recommends that you also store backup copies of custom image files in another location.

You can use these backup copies if the customized files are overwritten when you upgrade
Cisco Unified Communications Manager.

Use a text editor to edit the List.xml file. See the “List.xml File Format Requirements” section on
page 6-4 for the location of this file, formatting requirements, and a sample file.

Save your modifications and close the List.xml file.

~

Note  When you upgrade Cisco Unified Communications Manager, a default List.xml file will replace
your customized List.xml file. After you customize the List.xml file, make a copy of the file and
store it in another location. After upgrading Cisco Unified Communications Manager, replace
the default List.xml file with your stored copy.

To cache the new List.xml file, stop and start the TFTP service by using Cisco Unified Communications
Manager Serviceability or disable and re-enable the Enable Caching of Constant and Bin Files at Startup
TFTP service parameter (located in the Advanced Service Parameters).

Configuring Wideband Codec

If Cisco Unified Communications Manager has been configured to use G.722 (G.722 is enabled by
default for the Cisco Unified IP Phone 7965G and 7945G) and if the far endpoint supports G.722, the
call connects using the G.722 codec in place of G.711. This situation occurs regardless of whether the
user has enabled a wideband headset or wideband handset, but if either the headset or handset is enabled,
the user may notice greater audio sensitivity during the call. Greater sensitivity means improved audio
clarity but also means that more background noise can be heard by the far endpoint—noise such as
rustling papers or nearby conversations. Even without a wideband headset or handset, some users may
prefer the additional sensitivity of G.722. Other users may be distracted by the additional sensitivity of
G.722.

The following parameters in Cisco Unified Communications Manager Administration affect whether
wideband is supported for this Cisco Unified Communications Manager server or a specific phone:

e Advertise G.722 Codec—From Cisco Unified Communications Manager Administration, choose
System > Enterprise Parameters. The default value of this enterprise parameter is True, which
means that all Cisco Unified IP Phone Models 7942G, 7962G, 7945G, 7965G, and 7975G that are
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registered to this Cisco Unified Communications Manager will advertise G.722 to Cisco Unified
Communications Manager. If each endpoint in the attempted call supports G.722 in its capabilities set,
Cisco Unified Communications Manager will choose that codec for the call.

e Advertise G.722 Codec—From Cisco Unified Communications Manager Administration, choose
Device > Phone. The default value of this product-specific parameter is to use the value specified
in the enterprise parameter. If you want to override this on a per-phone basis, choose Enabled or
Disabled in the Advertise G.722 Codec parameter on the Product Specific Configuration area of the
Phone Configuration window.

Configuring the Idle Display

You can specify an idle display that appears on the phone LCD screen. The idle display is an XML
service that the phone invokes when the phone has been idle (not in use) for a designated period and no
feature menu is open.

XML services that can be used as idle displays include company logos, product pictures, and stock
quotes.

Configuring the idle display consists of these general steps.
1. Formatting an image for display on the phone.
2. Configure Cisco Unified Communications Manager to display the image on the phone.

For detailed instructions about creating and displaying the idle display, refer to Creating Idle URL
Graphics on Cisco Unified IP Phone at this URL:

http://www.cisco.com/warp/public/788/AVVID/idle-url.html

In addition, you can refer to Cisco Unified Communications Manager Administration Guide or to Cisco
Unified Communications Manager Bulk Administration Guide for the following information:

e Specifying the URL of the idle display XML service:

- For a single phone—Idle field on the Cisco Unified Communications Manager Phone
Configuration page

— For multiple phones simultaneously—URL Idle field on the Cisco Unified Communications
Manager Enterprise Parameters Configuration page, or the Idle field in the Bulk Administration
Tool (BAT)

e Specifying the length of time that the phone is not used before the idle display XML service is
invoked:

— For a single phone—Idle Timer field on the Cisco Unified Communications Manager Phone
Configuration page

— For multiple phones simultaneously—URL Idle Time field on the
Cisco Unified Communications Manager Enterprise Parameters Configuration page, or the Idle
Timer field in the Bulk Administration Tool (BAT)

From a phone, you can see settings for the idle display XML service URL and the length of time that the
phone is not used before this service is invoked. To see these settings, choose Settings > Device
Configuration and scroll to the Idle URL and the Idle URL Time parameters.
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Automatically Disabling the Cisco Unified IP Phone Screen

To conserve power and ensure the longevity of the LCD screen on the phone, you can set the LCD to
turn off when it is not needed.

You can configure settings in Cisco Unified Communications Manager Administration to turn off the
display at a designated time on some days and all day on other days. For example, you may choose to
turn off the display after business hours on weekdays and all day on Saturdays and Sundays.

When the display is off, the LCD screen is dark and disabled, and the Display button lights. You can
take any of these actions to turn on the display any time it is off:

e Press any button on the phone.

If you press a button other than the Display button, the phone will take the action designated by that
button in addition to turning on the display.

e Lift the handset.

When you turn the display on, it remains on until the phone has remained idle for a designated length of
time, then it turns off automatically.

Table 6-1 explains the Cisco Unified Communications Manager Administration fields that control when
the display turns on and off. You configure these fields in Cisco Unified Communications Manager
Administration in the Product Specific Configuration page. (You access this page by choosing Device >
Phone from Cisco Unified Communications Manager Administration.)

You can view the display settings for a phone from the Power Save Configuration menu on the phone.
For more information, see the “Power Save Configuration Menu” section on page 4-23.

Table 6-1 Display On and Off Configuration Fields

Field Description

Days Display Not |Days that the display does not turn on automatically at the
Active time specified in the Display On Time field.

Choose the day or days from the drop-down list. To choose
more than one day, Ctrl-click each day that you want.

Display On Time |Time each day that the display turns on automatically
(except on the days specified in the Days Display Not
Active field).

Enter the time in this field in 24 hour format, where 0:00 is
midnight.

For example, to automatically turn the display on at
7:00 a.m., (0700), enter 7:00. To turn the display on at
2:00 p.m. (1400), enter 14:00.

If this field is blank, the display will automatically turn on
at 0:00.
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Table 6-1 Display On and Off Configuration Fields (continued)

Field Description

Display On Length of time that the display remains on after turning on
Duration at the time specified in the Display On Time field.

Enter the value in this field in the format hours:minutes.

For example, to keep the display on for 4 hours and 30
minutes after it turns on automatically, enter 4:30.

If this field is blank, the phone will turn off at the end of
the day (0:00).

Note If Display On Time is 0:00 and the display on
duration is blank (or 24:00), the display will remain
on continuously.

Display Idle Length of time that the phone is idle before the display
Timeout turns off. Applies only when the display was off as
scheduled and was turned on by an end-user (by pressing a
button on the phone or lifting the handset).

Enter the value in this field in the format hours:minutes.

For example, to turn the display off when the phone is idle
for 1 hour and 30 minutes after an end-user turns the
display on, enter 1:30.

The default value is 0:30.

Display On If Disable/enable automatic illumination of the LCD screen
Incoming Call when a call is received.

Default: Disabled
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Viewing Model Information, Status, and
Statistics on the Cisco Unified IP Phone

This chapter describes how to use the following menus and screens on the Cisco Unified IP Phone 7965G
and 7945G to view model information, status messages, network statistics, and firmware information for
the phone:

e Model Information screen—Displays hardware and software information about the phone. For more
information, see the “Model Information Screen” section on page 7-2.

e Status menu—Provides access to screens that display the status messages, network statistics, and
firmware versions. For more information, see the “Status Menu” section on page 7-2.

e (Call Statistics screen—Displays counters and statistics for the current call. For more information,
see the o.

You can use the information on these screens to monitor the operation of a phone and to assist with
troubleshooting.

You can also obtain much of this information, and obtain other related information, remotely through
the phone’s web page. For more information, see Chapter 8, “Monitoring the Cisco Unified IP Phone
Remotely.”

For more information about troubleshooting the Cisco Unified IP Phone 7965G and 7945G, see
Chapter 9, “Troubleshooting and Maintenance.”

This chapter includes these topics:
e Model Information Screen, page 7-2
e Status Menu, page 7-2
e (Call Statistics Screen, page 7-11
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Model Information Screen

The Model Information screen includes the options that are described in Table 7-1.

Table 7-1

To display the Model Information screen, press the Settings button and then select Model Information.

To exit the Model Information screen, press the Exit softkey.

Model Information Settings

Option

Description

To Change

Model Number

Model number of the phone.

Display only—Cannot configure.

MAC Address

MAC address of the phone.

Display only—Cannot configure.

Load File

Identifier of the factory-installed load running on
the phone.

Display only—Cannot configure.

Boot Load ID

Identifier of the factory-installed load running on
the phone.

Display only—Cannot configure.

Serial Number

Serial number of the phone.

Display only—Cannot configure.

CTL

Displays the MD5 hash of the certificate trust list
(CTL) file that is installed in the phone. If no CTL
file is installed on the phone, this field displays No.
(If security is configured for the phone, the CTL file
installs automatically when the phone reboots or
resets).

For more information about this file, refer to
Cisco Unified Communications Manager
Security Guide.

MIC Indicates whether a manufacturing installed For information about how to manage the MIC
certificate (used for the security features) is installed |for your phone, refer to the “Using the Certificate
on the phone (Yes) or is not installed on the phone |Authority Proxy Function” section in Cisco
(No). Unified Communications Manager Security

Guide.
LSC Indicates whether a locally significant certificate For information about how to manage the LSC

(used for the security features) is installed on the
phone (Yes) or is not installed on the phone (No).

for your phone, refer to the “Using the Certificate
Authority Proxy Function” section in Cisco
Unified Communications Manager Security

Guide.

Call Control
Protocol

Indicates whether the phone is running under SCCP
or SIP.

See the “Using Cisco Unified IP Phones with
Different Protocols” section on page 2-11.

Status Menu

The Status menu includes these options, which provide information about the phone and its operation:

e Status Messages—Displays the Status Messages screen, which shows a log of important system
messages. For more information, see the “Status Messages Screen” section on page 7-3.

e Network Statistics—Displays the Network Statistics screen, which shows Ethernet traffic statistics.
For more information, see the “Network Statistics Screen” section on page 7-9.

¢ Firmware Versions—Displays the Firmware Versions screen, which shows information about the
firmware running on the phone. For more information, see the “Firmware Versions Screen” section

on page 7-10.
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e Expansion Module(s)—(SCCP phones only) Displays the Expansion Module(s) screen, which
shows information about the Cisco Unified IP Phone Expansion Module 7914, if connected to the
phone. For more information, see the “Expansion Module(s) Screen (SCCP Phones Only)” section
on page 7-10.

To display the Status menu, press the Settings button and then select Status.

To exit the Status menu, press the Exit softkey.

Status Messages Screen

The Status Messages screen displays the 10 most recent status messages that the phone has generated.
You can access this screen at any time, even if the phone has not finished starting up. Table 7-2 describes
the status messages that might appear. This table also includes actions you can take to address errors.

To display the Status Messages screen, follow these steps:
Procedure
Step 1 Press the Settings button.

Step2  Select Status.
Step3  Select Status Messages.
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To remove current status messages, press the Clear softkey.

To exit the Status Messages screen, press the Exit softkey.

Table 7-2

Status Messages on the Cisco Unified IP Phone 7965G and 7945G

Message

Description

Possible Explanation and Action

BootP server used

The phone obtained its IP address from a

BootP server rather than a DHCP server.

None. This message is informational only.

CFG file not found |The name-based and default The configuration file for a phone is created when the
configuration file was not found on the |phone is added to the Cisco Unified Communications
TFTP Server. Manager database. If the phone has not been added to the
Cisco Unified Communications Manager database, the
TFTP server generates a CFG File Not Found Iresponse.
e Phone is not registered with
Cisco Unified Communications Manager.
You must manually add the phone to
Cisco Unified Communications Manager if you are not
allowing phones to auto-register. See the “Adding
Phones with Cisco Unified Communications Manager
Administration” section on page 2-11 for details.
e If you are using DHCP, verify that the DHCP server is
pointing to the correct TFTP server.
e If you are using static IP addresses, check
configuration of the TFTP server. See the “Network
Configuration Menu” section on page 4-5 for details on
assigning a TFTP server.
CFG TFTP Size The configuration file is too large for file |Power cycle the phone.
Error system on the phone.

Checksum Error

Downloaded software file is corrupted.

Obtain a new copy of the phone firmware and place it in the
TFTPPath directory. You should only copy files into this
directory when the TFTP server software is shut down,
otherwise the files may be corrupted.

CTL Installed

A certificate trust list (CTL) file is
installed in the phone.

None. This message is informational only.

For more information about the CTL file, refer to Cisco
Unified Communications Manager Security Guide.

CTL update failed

The phone could not update its certificate
trust list (CTL) file.

Problem with the CTL file on the TFTP server.

For more information, refer to Cisco
Unified Communications Manager Security Guide.

l_ Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1

0L-14641-01



| Chapter7 Viewing Model Information, Status, and Statistics on the Cisco Unified IP Phone

Status Menu 1l

Table 7-2 Status Messages on the Cisco Unified IP Phone 7965G and 7945G (continued)
Message Description Possible Explanation and Action
DHCP timeout DHCP server did not respond. e Network is busy—The errors should resolve

themselves when the network load reduces.

e No network connectivity between the DHCP server
and the phone—Verify the network connections.

e DHCP server is down—Check configuration of DHCP
server.

e Errors persist—Consider assigning a static IP address.
See the “Network Configuration Menu” section on
page 4-5 for details on assigning a static IP address.

Dialplan Parsing The phone could not parse the dialplan |Problem with the TFTP downloaded dialplan XML file.

Error XML file properly. For more information refer to the Cisco Unified

(SIP phones only) Communications Manager Administration Guide.
Disabled 802.1X Authentication is disabled on the |You can enable 802.1X authentication using the Settings >
phone. Security Configuration > 802.1X Authentication option

on the phone. For more information, see the “802.1X
Authentication and Status” section on page 4-34.

DNS timeout DNS server did not respond. e Network is busy—The errors should resolve
themselves when the network load reduces.

e No network connectivity between the DNS server and
the phone—Verify the network connections.

e DNS server is down—Check configuration of DNS
Server.

DNS unknown host |DNS could not resolve the name of the e Verify that the host names of the TFTP server or
TFTP server or Cisco Unified Cisco Unified Communications Manager are
Communications Manager. configured properly in DNS.

e Consider using IP addresses rather than host names.

Duplicate IP Another device is using the IP address e Ifthe phone has a static IP address, verify that you have
assigned to the phone. not assigned a duplicate IP address. See the “Network
Configuration Menu” section on page 4-5 section for
details.

e If you are using DHCP, check the DHCP server
configuration.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Table 7-2

Status Messages on the Cisco Unified IP Phone 7965G and 7945G (continued)

Message

Description

Possible Explanation and Action

Error update locale

One or more localization files could not
be found in the TFTPPath directory or
were not valid. The locale was not
changed.

Check that the following files are located within
subdirectories in the TFTPPath directory:

e Located in subdirectory with same name as network
locale:

— tones.xml

e Located in subdirectory with same name as user locale:

glyphs.xml

dictionary.xml

kate.xml

dictionary.xml

Failed

The phone attempted an 802.1X
transaction but authentication failed.

Authentication typically fails because of one of the
following:

¢ No shared secret is configured in the phone or
authentication server

e The shared secret configured in the phone and the
authentication server do not match

e Phone has not been configured in the authentication
server

File auth error

An error occurred when the phone tried
to validate the signature of a signed file.
This message includes the name of the
file that failed.

e The file is corrupted. If the file is a phone configuration
file, delete the phone from the
Cisco Unified Communications Manager database
using Cisco Unified Communications Manager
Administration. Then add the phone back to the
Cisco Unified Communications Manager database
using Cisco Unified Communications Manager
Administration.

e There is a problem with the CTL file and the key for the
server from which files are obtained is bad. In this case,
run the CTL client and update the CTL file, making
sure that the proper TFTP servers are included in this
file.

File not found

The phone cannot locate, on the TFTP
server, the phone load file that is
specified in the phone configuration file.

Make sure that the phone load file is on the TFTP server
and that the entry in the configuration file is correct.

IP address released

The phone has been configured to release
its IP address.

The phone remains idle until it is power cycled or you reset
the DHCP address. See the “Network Configuration Menu”
section on page 4-5 section for details.
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Status Messages on the Cisco Unified IP Phone 7965G and 7945G (continued)

Message

Description

Possible Explanation and Action

Load Auth Failed

The phone could not load a configuration
file.

Check that:

e A good version of the configuration file exists on the
applicable server.

e The phone load file being downloaded has not been
altered or renamed.

e The phone load type is compatible; for example, you
cannot place a DEV load configuration file on a
REL-signed phone.

Load ID incorrect

Load ID of the software file is of the
wrong type.

Check the load ID assigned to the phone (from
Cisco Unified Communications Manager, choose Device >
Phone). Verify that the load ID is entered correctly.

Load rejected HC

The application that was downloaded is
not compatible with the phone’s
hardware.

Occurs if you were attempting to install a version of
software on this phone that did not support hardware
changes on this newer phone.

Check the load ID assigned to the phone (from

Cisco Unified Communications Manager, choose Device >
Phone). Re-enter the load displayed on the phone. See the
“Firmware Versions Screen” section on page 7-10 to verify
the phone setting.

Load Server is
invalid

Indicates an invalid TFTP server
IP address or name in the Load Server
option.

The Load Server setting is not valid. The Load Server
specifies a TFTP server IP address or name from which the
phone firmware can be retrieved for upgrades on the
phones.

Check the Load Server entry (from
Cisco Unified Communications Manager Administration
choose Device > Phone).

No CTL installed

A certificate trust list (CTL) file is not
installed in the phone.

Occurs if security is not configured. If security is
configured, because the CTL file does not exist on the
TFTP server.

For more information, refer to Cisco Unified
Communications Manager Security Guide.

No default router

DHCP or static configuration did not
specify a default router.

e If the phone has a static IP address, verify that the
default router has been configured. See the “Network
Configuration Menu” section on page 4-5 section for
details.

e If you are using DHCP, the DHCP server has not
provided a default router. Check the DHCP server
configuration.
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Table 7-2

Status Messages on the Cisco Unified IP Phone 7965G and 7945G (continued)

Message

Description

Possible Explanation and Action

No DNS server IP

A name was specified but DHCP or static
IP configuration did not specify a DNS
server address.

e If the phone has a static IP address, verify that the DNS
server has been configured. See the “Network
Configuration Menu” section on page 4-5 section for
details.

e If you are using DHCP, the DHCP server has not
provided a DNS server. Check the DHCP server
configuration.

Programming Error

The phone failed during programming.

Attempt to resolve this error by power cycling the phone. If
the problem persists, contact Cisco technical support for
additional assistance.

Successful — MD5

The phone attempted an 802.1X
transaction and authentication achieved.

The phone achieved 802.1X authentication.

TFTP access error

TFTP server is pointing to a directory
that does not exist.

e If you are using DHCP, verify that the DHCP server is
pointing to the correct TFTP server.

e If you are using static IP addresses, check
configuration of TFTP server. See the “Network
Configuration Menu” section on page 4-5 for details on
assigning a TFTP server.

TFTP Error

The phone does not recognize an error
code provided by the TFTP server.

Contact the Cisco TAC.

TFTP file not found

The requested load file (.bin) was not
found in the TFTPPath directory.

Check the load ID assigned to the phone (from Cisco
Unified Communications Manager, choose Device >
Phone). Verify that the TFTPPath directory contains a .bin
file with this load ID as the name.

TFTP server not
authorized

The specified TFTP server could not be
found in the phone’s CTL.

e DHCP server has wrong configuration file for TFTP
server.

e The CTL file was made and then the TFTP server
address changed. In this case, regenerate the CTL file.

TFTP timeout

TFTP server did not respond.

e Network is busy—The errors should resolve
themselves when the network load reduces.

¢ No network connectivity between the TFTP server and
the phone—Verify the network connections.

e TFTP server is down—Check configuration of TFTP
Server.

Timed Out

Supplicant attempted 802.1X transaction
but timed out due the absence of an
authenticator.

Authentication typically times out if 802.1X authentication
is not configured on the switch.

Version error

The name of the phone load file is
incorrect.

Make sure that the phone load file has the correct name.

XmlDefault.cnf.xml,
or .cnf.xml
corresponding to the
phone device name

Name of the configuration file.

None. This is an informational message indicating the
name of the configuration file for the phone.
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Step 1
Step 2
Step 3

Status Menu 1l

The Network Statistics screen displays information about the phone and network performance. Table 7-3
describes the information that appears in this screen.

To display the Network Statistics screen, follow these steps:

Procedure

Press the Settings button.

Select Status.

Select Network Statistics.

To reset the Rx Frames, Tx Frames, and Rx Broadcasts statistics to 0, press the Clear softkey.

To exit the Network Statistics screen, press the Exit softkey.

Table 7-3 Network Statistics Message Components
Item Description
Rx Frames Number of packets received by the phone

Tx Frames

Number of packets sent by the phone

Rx Broadcasts

Number of broadcast packets received by the phone

One of the following values:

Initialized
TCP-timeout
CM-closed-TCP
TCP-Bad-ACK
CM-reset-TCP
CM-aborted-TCP
CM-NAKed
KeepaliveTO
Failback
Phone-Keypad
Phone-Re-I1P
Reset-Reset
Reset-Restart
Phone-Reg-Rej
Load Rejected HC
CM-ICMP-Unreach
Phone-Abort

Cause of the last reset of the phone

Elapsed Time

Amount of time that has elapsed since the phone last rebooted

Port 1

Link state and connection of the PC port (for example, auto 100
Mb Full-Duplex means that the PC portis in a link up state and has
auto-negotiated a full-duplex, 100-Mbps connection)
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Table 7-3 Network Statistics Message Components (continued)

ltem Description

Port 2 Link state and connection of the Network port

DHCP BOUND Phone is bound to the DHCP server, DHCP parameters are
acceptable, and the phone has received a DHCPACK message.

Firmware Versions Screen

The Firmware Versions screen displays information about the firmware version that is running on the
phone. Table 7-4 explains the information that is displayed on this screen.

To display the Firmware Version screen, follow these steps:

Procedure

Step1  Press the Settings button.
Step2  Select Status.

Step3  Select Firmware Versions.

To exit the Firmware Version screen, press the Exit softkey.

Table 7-4 Firmware Version Information

Item Description

Load File Load file running on the phone

App Load ID Identifies the JAR file running on the phone

JVM Load ID Identifies the Java Virtual Machine (JVM) running on the phone

OS Load ID Identifies the operating system running on the phone

Boot Load ID Identifies the factory-installed load running on the phone

Expansion Module 1 Identifies the load running on the Expansion Module(s), if connected to and
Expansion Module 2 SCCP phone

DSP Load ID Identifies the digital signal processor (DSP) software version used

Expansion Module(s) Screen (SCCP Phones Only)

The Expansion Module(s) screen displays information about each Cisco Unified IP Phone Expansion
Module 7914 that is connected to the phone. This screen appears on SCCP phones only.

Table 7-5 explains the information that is displayed on this screen for each connected expansion module.
You can use this information to troubleshoot the expansion module, if necessary. In the Expansion
Module(s) screen, a statistic preceded by “A” is for the first expansion module. A statistic preceded by
“B” is for the second expansion module.

To display the Expansion Module(s) screen, follow these steps:
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Step 2
Step 3
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Procedure

Press the Settings button.
Select Status.

Select Expansion Module(s).

To exit the Expansion Module(s) screen, press the Exit softkey.

Table 7-5 Expansion Module Statistics

Item Description

Link State Overall expansion module status

RX Discarded Bytes Number of bytes discarded due to errors

RX Length Err Number of packets discarded due to improper length

RX Checksum Err Number of packets discarded due to invalid checksum information

RX Invalid Message Number of packets that have been discarded because a message was invalid
or unsupported

TX Retransmit Number of packets that have been retransmitted to the expansion module

TX Buffer Full Number of packets discarded because the expansion module was not able
to accept new messages

Call Statistics Screen

Step 1

You can access the Call Statistics screen on the phone to display counters, statistics, and voice-quality
metrics in the following ways:

e During call—You can view the call information by rapidly pressing the ? button twice.

e After the call—You can view the call information captured during the last call by displaying the Call
Statistics screen.

S

Note  You can also remotely view the call statistics information by using a web browser to access the
Streaming Statistics web page. This web page contains additional RTCP statistics not available
on the phone. For more information about remote monitoring, see Chapter 8, “Monitoring the
Cisco Unified IP Phone Remotely.”

A single call can have multiple voice streams, but data is captured for only the last voice stream. A voice
stream is a packet stream between two endpoints. If one endpoint is put on hold, the voice stream stops
even though the call is still connected. When the call resumes, a new voice packet stream begins, and
the new call data overwrites the former call data.

To display the Call Statistics screen for information about the last voice stream, follow these steps:

Procedure

Press the Settings button.
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Step 2
Step 3

Select Status.
Select Call Statistics.

The Call Statistics screen displays these items:

Table 7-6 Call Statistics Items

ltem Description

Rcvr Codec Type of voice stream received (RTP streaming audio from codec): G.729,
G.728/iLBC, G.711 u-law, G.711 A-law, or Lin16k.

Sender Codec Type of voice stream transmitted (RTP streaming audio from codec):
G.729, G.728/iLBC, G.711 u-law, G.711 A-law, or Lin16k.

Rcvr Size Size of voice packets, in milliseconds, in the receiving voice stream (RTP

streaming audio).

Sender Size

Size of voice packets, in milliseconds, in the transmitting voice stream.

Rcvr Packets

Number of RTP voice packets received since voice stream was opened.

Note  This number is not necessarily identical to the number of RTP voice
packets received since the call began because the call might have

been placed on hold.

Sender Packets

Number of RTP voice packets transmitted since voice stream was opened.

Note  This number is not necessarily identical to the number of RTP voice
packets transmitted since the call began because the call might have

been placed on hold.

Avg Jitter Estimated average RTP packet jitter (dynamic delay that a packet
encounters when going through the network) observed since the receiving
voice stream was opened.

Max Jitter Maximum jitter observed since the receiving voice stream was opened.

Rcvr Discarded

Number of RTP packets in the receiving voice stream that have been
discarded (bad packets, too late, and so on).

Note The phone will discard payload type 19 comfort noise packets that
are generated by Cisco Gateways, which will increment this

counter.

Rcvr Lost Packets

Missing RTP packets (lost in transit).

Voice Quality Metrics

MOS LQK

Score that is an objective estimate of the mean opinion score (MOS) for
listening quality (LQK) that rates from 5 (excellent) to 1 (bad). This score
is based on audible concealment events due to frame loss in the preceding
8-second interval of the voice stream. For more information, see the
“Monitoring the Voice Quality of Calls” section on page 9-16.

Note The MOS LQK score can vary based on the type of codec that the

Cisco Unified IP Phone uses.

Avg MOS LQK

Average MOS LQK score observed for the entire voice stream.

Min MOS LQK

Lowest MOS LQK score observed from start of the voice stream.
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Table 7-6 Call Statistics Items (continued)

ltem Description

Max MOS LQK Baseline or highest MOS LQK score observed from start of the voice
stream.

These codecs provide the following maximum MOS LQK score under
normal conditions with no frame loss:

e G.711 gives 4.5
e (G.722 gives 4.5
e G.728/iLBC gives 3.9
e G.729 A/AB gives 3.8

MOS LQK Version Version of the Cisco proprietary algorithm used to calculate MOS LQK
scores.

Cumulative Conceal Total number of concealment frames divided by total number of speech

Ratio frames received from start of the voice stream.

Interval Conceal Ratio Ratio of concealment frames to speech frames in preceding 3-second
interval of active speech. If using voice activity detection (VAD), a longer
interval might be required to accumulate 3 seconds of active speech.

Max Conceal Ratio Highest interval concealment ratio from start of the voice stream.

Conceal Secs Number of seconds that have concealment events (lost frames) from the
start of the voice stream (includes severely concealed seconds).

Severely Conceal Secs Number of seconds that have more than 5 percent concealment events (lost
frames) from the start of the voice stream.

Latency Estimate of the network latency, expressed in milliseconds. Represents a
running average of the round-trip delay, measured when RTCP receiver
report blocks are received.
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Monitoring the Cisco Unified IP Phone Remotely

Each Cisco Unified IP Phone has a web page from which you can view a variety of information about
the phone, including:

¢ Device information

e Network configuration information
e Network statistics

e Device logs

e Streaming statistics

This chapter describes the information that you can obtain from the phone’s web page. You can use this
information to remotely monitor the operation of a phone and to assist with troubleshooting.

You can also obtain much of this information directly from a phone. For more information, see
Chapter 7, “Viewing Model Information, Status, and Statistics on the Cisco Unified IP Phone.”

For more information about troubleshooting the Cisco Unified IP Phone 7965G and 7945G, see
Chapter 9, “Troubleshooting and Maintenance.”

This chapter includes these topics:
e Accessing the Web Page for a Phone, page 8-2
e Disabling and Enabling Web Page Access, page 8-3
e Device Information, page 8-3
e Network Configuration, page 8-4
e Network Statistics, page 8-8
e Device Logs, page 8-11
e Streaming Statistics, page 8-11
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Accessing the Web Page for a Phone

To access the web page for a Cisco Unified IP Phone, perform these steps.

~

Note

Step 1

Step 2

If you cannot access the web page, it may be disabled. See the “Disabling and Enabling Web Page
Access” section on page 8-3 for more information.

Procedure

Obtain the IP address of the Cisco Unified IP Phone using one of these methods:

Search for the phone in Cisco Unified Communications Manager by choosing Device > Phone.
Phones registered with Cisco Unified Communications Manager display the IP address on the Find
and List Phones window and at the top of the Phone Configuration window.

On the Cisco Unified IP Phone, press the Settings button, choose Network Configuration, and then
scroll to the IP Address option.

Open a web browser and enter the following URL, where IP_address is the IP address of the
Cisco Unified IP Phone:

http://IP_address

The web page for a Cisco Unified IP Phone 7965G and 7945G includes these hyperlinks:

Device Information—Displays device settings and related information for the phone. For more
information, see the “Device Information” section on page 8-3.

Network Configuration—Displays network configuration information and information about other
phone settings. For more information, see the “Network Configuration” section on page §-4.

Network Statistics—Includes the following hyperlinks, which provide information about network
traffic:

— Ethernet Information—Displays information about Ethernet traffic. For more information,
see the “Network Statistics” section on page 8-8.

— Access—Displays information about network traffic to and from the PC port on the phone. For
more information, see the “Network Statistics” section on page 8-8.

— Network—Displays information about network traffic to and from the network port on the
phone. For more information, see the “Network Statistics” section on page 8§-8.

Device Logs—Includes the following hyperlinks, which provide information that you can use for
troubleshooting:

— Console Logs—Includes hyperlinks to individual log files. For more information, see the
“Device Logs” section on page 8-11.

— Core Dumps—Includes hyperlinks to individual dump files.

- Status Messages—Displays up to the 10 most recent status messages that the phone has
generated since it was last powered up. For more information, see the “Device Logs” section on
page 8-11.

— Debug Display—Displays messages that might be useful to the Cisco TAC if you require
assistance with troubleshooting. For more information, see the “Device Logs” section on
page 8-11.
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¢ Streaming Statistics—Includes the Stream 1, Stream 2, Stream 3, Stream 4, and Stream 5
hyperlinks, which display a variety of streaming statistics. For more information, see the “Streaming
Statistics” section on page 8-11.

Disabling and Enabling Web Page Access

Step 1
Step 2
Step 3
Step 4

Step 5

For security purposes, you may choose to prevent access to the web pages for a phone. If you do so, you
will prevent access to the web pages that are described in this chapter and to the phone’s User Options
web pages.

To control access to the web pages for a phone, follow these steps from Cisco Unified Communications
Manager Administration.

Procedure

Choose Device > Phone.
Specify the criteria to find the phone and click Find, or click Find to display a list of all phones.
Click the device name to open the Phone Configuration window for the device.
From the Web Access drop-down list box, choose one of these options:
¢ Disabled—Prevents access to web pages for a phone.
e Enabled—Allows access to web pages for a phone.

Click Update.

~

Note  Some features, such as Cisco Quality Report Tool, do not function properly without access to
the phone web pages. Disabling web access also affects any serviceability application that relies
on web access.

Device Information

The Device Information area on a phone’s web page displays device settings and related information for
the phone. Table 8-1 describes these items.

To display the Device Information area, access the web page for the phone as described in the
“Accessing the Web Page for a Phone” section on page 8-2, and then click the Device Information
hyperlink.

Table 8-1 Device Information Area Iltems

Item Description

MAC Address Media Access Control (MAC) address of the phone

Host Name Unique, fixed name that is automatically assigned to the phone based on its
MAC address

Phone DN Directory number assigned to the phone
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Table 8-1 Device Information Area Items (continued)
ltem Description
App Load ID Identifier of the firmware running on the phone

Boot Load ID

Identifier of the factory-installed load running on the phone

Version

Version of the firmware running on the phone

Expansion Module 1

Phone load ID for the first Cisco Unified IP Phone Expansion Module 7914,
if connected to a SCCP phone

Expansion Module 2

Phone load ID for the second Cisco Unified IP Phone Expansion Module
7914, if connected to a SCCP phone

Hardware Revision

Revision value of the phone hardware

Serial Number

Serial number of the phone

Model Number

Model number of the phone

Message Waiting

Indicates if there is a voice message waiting on any line for this phone

UDI

Displays the following Cisco Unique Device Identifier (UDI) information
about the phone:

e Device Type—Indicates hardware type. For example, phone displays for
all phone models

e Device Description—Displays the name of the phone associated with the
indicated model type

¢ Product Identifier—Specifies the phone model
e Version Identifierl—Represents the hardware version of the phone

e Serial Number—Displays the phone’s unique serial number

Time Time obtained from the Date/Time Group in Cisco Unified Communications
Manager to which the phone belongs

Time Zone Timezone obtained from the Date/Time Group in Cisco Unified
Communications Manager to which the phone belongs

Date Date obtained from the Date/Time Group in Cisco Unified Communications

Manager to which the phone belongs

1. The Version Identifier field might display blank if using an older model Cisco Unified IP Phone because the hardware does
not provide this information.

The Network Configuration area on a phone’s web page displays network configuration information and
information about other phone settings. Table 8-2 describes this information.

You can view and set many of these items from the Network Configuration Menu and the Device
Configuration Menu on the Cisco Unified IP Phone. For more information, see Chapter 5, “Configuring
Features, Templates, Services, and Users.”
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To display the Network Configuration area, access the web page for the phone as described in the
“Accessing the Web Page for a Phone” section on page 8-2, and then click the Network Configuration

hyperlink.
Table 8-2 Network Configuration Area Items
ltem Description

DHCP Server

IP address of the Dynamic Host Configuration Protocol (DHCP) server from

which the phone obtains its IP address.

BOOTP Server

Indicates whether the phone obtains its configuration from a Bootstrap
Protocol (BootP) server.

MAC Address

Media Access Control (MAC) address of the phone.

Host Name

Host name that the DHCP server assigned to the phone.

Domain Name

Name of the Domain Name System (DNS) domain in which the phone
resides.

IP Address

Internet Protocol (IP) address of the phone.

Subnet Mask

Subnet mask used by the phone.

TFTP Server 1

Primary Trivial File Transfer Protocol (TFTP) server used by the phone.

Default Router 1-5

Default router used by the phone (Default Router 1) and optional backup
routers (Default Router 2-5).

DNS Server 1-5

Primary Domain Name System (DNS) server (DNS Server 1) and optional
backup DNS servers (DNS Server 2-5) used by the phone.

Operational VLAN ID

Auxiliary Virtual Local Area Network (VLAN) configured on a Cisco
Catalyst switch in which the phone is a member.

Admin. VLAN ID

Auxiliary VLAN in which the phone is a member.
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Table 8-2 Network Configuration Area Items (continued)

Item

Description

CallManager 1-5

Host names or IP addresses, in prioritized order, of the

Cisco Unified Communications Manager servers with which the phone can
register. An item can also show the IP address of an SRST router that is
capable of providing limited Cisco Unified Communications Manager
functionality, if such a router is available.

For an available server, an item will show the
Cisco Unified Communications Manager server IP address and one of the
following states:

e Active—Cisco Unified Communications Manager server from which the
phone is currently receiving call-processing services.

e Standby—Cisco Unified Communications Manager server to which the
phone switches if the current server becomes unavailable.

e Blank—No current connection to this Cisco Unified Communications
Manager server.

An item may also include the Survivable Remote Site Telephony (SRST)
designation, which identifies an SRST router capable of providing

Cisco Unified Communications Manager functionality with a limited feature
set. This router assumes control of call processing if all other

Cisco Unified Communications Manager servers become unreachable. The
SRST Cisco Unified Communications Manager always appears last in the list
of servers, even if it is active. You configure the SRST router address in the
Device Pool section in Cisco Unified Communications Manager
Configuration window.

Information URL

URL of the help text that appears on the phone.

Directories URL

URL of the server from which the phone obtains directory information.

Messages URL

URL of the server from which the phone obtains message services.

Services URL

URL of the server from which the phone obtains Cisco Unified IP Phone
services.

DHCP Enabled

Indicates whether DHCP is being used by the phone.

DHCP Address
Released

Indicates the setting of the DHCP Address Released option on the phone’s
Network Configuration menu.

Alternate TFTP

Indicates whether the phone is using an alternative TFTP server.

Idle URL

URL that the phone displays when the phone has not been used for the time
specified by Idle URL Time, and no menu is open.

Idle URL Time

Number of seconds that the phone has not been used and no menu is open
before the XML service specified by Idle URL is activated.

Proxy Server URL

URL of proxy server, which makes HTTP requests to non-local host
addresses on behalf of the phone HTTP client and provides responses from
the non-local host to the phone HTTP client.

Authentication URL

URL that the phone uses to validate requests made to the phone web server.
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Network Configuration

Table 8-2 Network Configuration Area Items (continued)

ltem Description

SW Port Configuration |Speed and duplex of the switch port, where:
e A—Auto Negotiate

e 10H—10-BaseT/half duplex

e 10F—10-BaseT/full duplex

e 100H—100-BaseT/half duplex

¢ 100F—100-BaseT/full duplex

e 1000H—1000-BaseT/half duplex

e 1000F—1000-BaseT/full duplex

e No Link—No connection to the switch port

PC Port Configuration |Speed and duplex of the switch port, where:
e A—Auto Negotiate
10H—10-BaseT/half duplex

e 10F—10-BaseT/full duplex

e 100H—100-BaseT/half duplex

e 100F—100-BaseT/full duplex

¢ 1000H—1000-BaseT/half duplex

e 1000F—1000-BaseT/full duplex

¢ No Link—No connection to the PC port

TFTP Server 2 Backup TFTP server that the phone uses if the primary TFTP server is
unavailable.
User Locale User locale associated with the phone user. Identifies a set of detailed

information to support users, including language, font, date and time
formatting, and alphanumeric keyboard text information.

Network Locale Network locale associated with the phone user. Identifies a set of detailed
information to support the phone in a specific location, including definitions
of the tones and cadences used by the phone.

Headset enabled Indicates whether the Headset button is enabled on the phone.

User Locale Version Version of the user locale loaded on the phone.

Network Locale Version of the network locale loaded on the phone.

Version

PC Port Disabled Indicates whether the PC port on the phone is enabled or disabled.

Speaker Enabled Indicates whether the speakerphone is enabled on the phone.

GARP Enabled Indicates whether the phone learns MAC addresses from Gratuitous ARP
responses.

Video Capability Indicates whether the phone can participate in video calls when connected to

Enabled an appropriately equipped PC.

Voice VLAN Enabled |Indicates whether the phone allows a device attached to the PC port to access
the Voice VLAN.
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Table 8-2 Network Configuration Area Items (continued)
ltem Description
Auto Line Select Indicates whether the phone shifts the call focus to incoming calls on all lines.

DSCEP for Call Control |DSCP IP classification for call control signaling.

DSCP for DSCP IP classification for any phone configuration transfer.
Configuration

DSCEP for Services DSCEP IP classification for phone-based services.

Security Mode Displays the security mode that is set for the phone.

Web Access Enabled  |Indicates whether web access is enabled (Yes) or disabled (No) for the phone.

Span to PC Port Indicates whether the phone will forward packets transmitted and received on
the network port to the access port.

PC VLAN VLAN used to identify and remove 802.1P/Q tags from packets sent to the
PC.

Forwarding Delay Indicates whether the internal switch begins forwarding packets between the
PC port and switched port on the phone when the phone becomes active.

CDP: PC Port Indicates whether CDP is supported on the PC port.

CDP: SW Port Indicates whether CDP is supported on the switch xport.

LLDP-MED: SW Port |Indicates whether Link Layer Discovery Protocol Media Endpoint Discovery
(LLDP-MED) is enabled on the switch port.

LLDP: PC Port Indicates whether Link Layer Discovery Protocol (LLDP) is enabled on the
PC port.

LLDP Power Priority |Advertises the phone’s power priority to the switch, enabling the switch to
appropriately provide power to the phones. Settings include:

¢ Unknown—default
e Low
e High

e Critical

LLDP Asset ID Identifies the asset ID assigned to the phone for inventory management.

Network Statistics

These network statistics areas on a phone’s web page provide information about network traffic on the
phone:

e Ethernet Information area—Displays information about Ethernet traffic. Table 8-3 describes the
items in this area.

e Access area—Displays information about network traffic to and from the PC port on the phone.
Table 8-4 describes the items in this area.

e Network area—Displays information about network traffic to and from the network port on the
phone. Table 8-4 describes the items in this area.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Network Statistics W

To display a network statistics area, access the web page for the phone as described in the “Accessing
the Web Page for a Phone” section on page 8-2, and then click the Ethernet Information, the Access,
and or the Network hyperlink.

Table 8-3 Ethernet Information Area Items
ltem Description
Tx Frames Total number of packets transmitted by the phone

Tx broadcast

Total number of broadcast packets transmitted by the phone

Tx multicast

Total number of multicast packets transmitted by the phone

Tx unicast

Total number of unicast packets transmitted by the phone

Rx Frames

Total number of packets received by the phone

Rx broadcast

Total number of broadcast packets received by the phone

Rx multicast

Total number of multicast packets received by the phone

Rx unicast Total number of unicast packets received by the phone

RxPacketNoDes Total number of shed packets caused by no Direct Memory Access (DMA)
descriptor

Table 8-4 Access Area and Network Area ltems

ltem Description

Rx totalPkt

Total number of packets received by the phone

Rx crcErr

Total number of packets received with CRC failed

Rx alignErr

Total number of packets received between 64 and 1522 bytes in length that
have a bad Frame Check Sequence (FCS)

Rx multicast

Total number of multicast packets received by the phone

Rx broadcast

Total number of broadcast packets received by the phone

Rx unicast

Total number of unicast packets received by the phone

Rx shortErr

Total number of FCS error packets or Align error packets received that are
less than 64 bytes in size

Rx shortGood

Total number of good packets received that are less than 64 bytes size

Rx longGood

Total number of good packets received that are greater than 1522 bytes in size

Rx longErr Total number of FCS error packets or Align error packets received that are
greater than 1522 bytes in size
Rx size64 Total number of packets received, including bad packets, that are between 0

and 64 bytes in size

Rx size65to127

Total number of packets received, including bad packets, that are between 65
and 127 bytes in size

Rx sizel128t0255

Total number of packets received, including bad packets, that are between
128 and 255 bytes in size

Rx size256to511

Total number of packets received, including bad packets, that are between
256 and 511 bytes in size
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Table 8-4

Access Area and Network Area Items (continued)

Item

Description

Rx size512t01023

Total number of packets received, including bad packets, that are between
512 and 1023 bytes in size

Rx size1024to1518

Total number of packets received, including bad packets, that are between
1024 and 1518 bytes in size

Rx tokenDrop

Total number of packets dropped due to lack of resources (for example, FIFO
overflow)

Tx excessDefer

Total number of packets delayed from transmitting due to medium being busy

Tx lateCollision

Number of times that collisions occurred later than 512 bit times after the
start of packet transmission

Tx totalGoodPkt

Total number of good packets (multicast, broadcast, and unicast) received by
the phone

Tx Collisions

Total number of collisions that occurred while a packet was being transmitted

Tx excessLength

Total number of packets not transmitted because the packet experienced 16
transmission attempts

Tx broadcast

Total number of broadcast packets transmitted by the phone

Tx multicast

Total number of multicast packets transmitted by the phone

LLDP FramesOutTotal

Total number of LLDP frames sent out from the phone

LLDP AgeoutsTotal Total number of LLDP frames that have been time out in cache

LLDP Total number of LLDP frames that are discarded when any of the mandatory
FramesDiscardedTotal |TLVs is missing or out of order or contains out of range string length.
LLDP Total number of LLDP frames that received with one or more detectable
FramesInErrorsTotal  |errors

LLDP FramesInTotal |Total number of LLDP frames received on the phone.

LLDP Total number of LLDP TLVs that are discarded.

TLVDiscardedTotal

LLDP Total number of LLDP TLVs that are not recognized on the phone.
TLVUnrecognizedTot

al

CDP Neighbor Device
ID

Identifier of a device connected to this port discovered by CDP protocol.

CDP Neighbor IP
Address

IP address of the neighbor device discovered by CDP protocol.

CDP Neighbor Port

Neighbor device port to which the phone is connected discovered by CDP
protocol.

LLDP Neighbor
Device ID

Identifier of a device connected to this port discovered by LLDP protocol.

LLDP Neighbor IP
Address

IP address of the neighbor device discovered by LLDP protocol.

LLDP Neighbor Port

Neighbor device port to which the phone is connected discovered by LLDP
protocol.
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Device Logs

The Device Logs area on a phone’s web page provides information you can use to help monitor and

troubleshoot the phone.

e Console Logs—Includes hyperlinks to individual log files. The console log files include debug and
error messages received on the phone.

e Core Dumps—Includes hyperlinks to individual dump files.

e Status Messages area—Displays up to the 10 most recent status messages that the phone has
generated since it was last powered up. You can also see this information from the Status Messages
screen on the phone. Table 7-2 describes the status messages that can appear.

To display the Status Messages, access the web page for the phone as described in the “Accessing
the Web Page for a Phone” section on page 8-2, and then click the Status Messages hyperlink.

e Debug Display area—Displays debug messages that might be useful to Cisco TAC if you require

assistance with troubleshooting.

Streaming Statistics

A Cisco Unified IP Phone can stream information to and from up to three devices simultaneously. A
phone streams information when it is on a a call or running a service that sends or receives audio or data.

The streaming statistics areas on a phone’s web page provide information about the streams. Most calls
use only one stream (Stream 1), but some calls use two or three stream. For example, a barged call uses

Stream 1 and Stream 2.

To display a Streaming Statistics area, access the web page for the phone as described in the “Accessing
the Web Page for a Phone” section on page 8-2, and then click the Stream 1, the Stream 2, the Stream
3, the Stream 4, or the Stream 5 hyperlink.

Table 8-5 describes the items in the Streaming Statistics areas.

Table 8-5 Streaming Statistics Area Items

Item

Description

Remote Address

IP address and UDP port of the destination of the stream.

Local Address

IP address and UPD port of the phone.

Start Time

Internal time stamp indicating when Cisco Unified Communications
Manager requested that the phone start transmitting packets.

Stream Status

Indication of whether streaming is active or not.

Host Name

Unique, fixed name that is automatically assigned to the phone based on its
MAC address.

Sender Packets

Total number of RTP data packets transmitted by the phone since starting this
connection. The value is O if the connection is set to receive only mode.

Sender Octets

Total number of payload octets transmitted in RTP data packets by the phone
since starting this connection. The value is 0 if the connection is set to receive
only mode.

Sender Codec

Type of audio encoding used for the transmitted stream.

Sender Reports Sent!

Number of times the RTCP Sender Reports have been sent.
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Table 8-5

Streaming Statistics Area Items (continued)

Item

Description

Sender Report Time
Sent!

Internal time stamp indicating when a RTCP Sender Report was sent.

Rcvr Lost Packets

Total number of RTP data packets that have been lost since starting receiving
data on this connection. Defined as the number of expected packets less the
number of packets actually received, where the number of received packets
includes any that are late or duplicate. The value displays as O if the
connection was set to send-only mode.

Avg Jitter Estimate of mean deviation of the RTP data packet inter-arrival time,
measured in milliseconds. The value displays as O if the connection was set
to send-only mode.

Rcvr Codec Type of audio encoding used for the received stream.

Rcvr Reports Sent!

Number of times the RTCP Receiver Reports have been sent.

Rcvr Report Time
Sent!

Internal time stamp indicating when a RTCP Receiver Report was sent.

Rcvr Packets

Total number of RTP data packets received by the phone since starting
receiving data on this connection. Includes packets received from different
sources if this is a multicast call. The value displays as 0 if the connection was
set to send-only mode.

Rcvr Octets

Total number of payload octets received in RTP data packets by the device
since starting reception on the connection. Includes packets received from
different sources if this is a multicast call. The value displays as O if the
connection was set to send-only mode.

MOS LQK

Score that is an objective estimate of the mean opinion score (MOS) for
listening quality (LQK) that rates from 5 (excellent) to 1 (bad). This score is
based on audible concealment events due to frame loss in the preceding
8-second interval of the voice stream. For more information, see the
“Monitoring the Voice Quality of Calls” section on page 9-16.

Note The MOS LQK score can vary based on the type of codec that the

Cisco Unified IP Phone uses.

Avg MOS LQK

Average MOS LQK score observed for the entire voice stream.

Min MOS LQK

Lowest MOS LQK score observed from start of the voice stream.

Max MOS LQK

Baseline or highest MOS LQK score observed from start of the voice stream.

These codecs provide the following maximum MOS LQK score under normal
conditions with no frame loss:

e G.711 gives 4.5
e G.722 gives 4.5
e G.728/iLBC gives 3.9
e G.729 A/AB gives 3.8

MOS LQK Version

Version of the Cisco proprietary algorithm used to calculate MOS LQK
scores.

Cumulative Conceal
Ratio

Total number of concealment frames divided by total number of speech
frames received from start of the voice stream.
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Streaming Statistics

Streaming Statistics Area Items (continued)

Item

Description

Interval Conceal Ratio

Ratio of concealment frames to speech frames in preceding 3-second interval
of active speech. If using voice activity detection (VAD), a longer interval
might be required to accumulate 3 seconds of active speech.

Max Conceal Ratio

Highest interval concealment ratio from start of the voice stream.

Conceal Secs

Number of seconds that have concealment events (lost frames) from the start
of the voice stream (includes severely concealed seconds).

Severely Conceal Secs

Number of seconds that have more than 5 percent concealment events (lost
frames) from the start of the voice stream.

Latency1 Estimate of the network latency, expressed in milliseconds. Represents a
running average of the round-trip delay, measured when RTCP receiver
report blocks are received.

Max Jitter Maximum value of instantaneous jitter, in milliseconds.

Sender Size

RTP packet size, in milliseconds, for the transmitted stream.

Sender Reports
Received!

Number of times RTCP Sender Reports have been received.

Sender Report Time
Received!

Last time at which an RTCP Sender Report was received.

Rcvr Size

RTP packet size, in milliseconds, for the received stream.

Rcvr Discarded

RTP packets received from network but discarded from jitter buffers.

Rcvr Reports
Received!

Number of times RTCP Receiver Reports have been received.

Rcvr Report Time
Received!

Last time at which an RTCP Receiver Report was received.

Voice Quality Metrics

MOS LQK

Score that is an objective estimate of the mean opinion score (MOS) for
listening quality (LQK) that rates from 5 (excellent) to 1 (bad). This score is
based on audible concealment events due to frame loss in the preceding
8-second interval of the voice stream. For more information, see the
“Monitoring the Voice Quality of Calls” section on page 9-16.

Note The MOS LQK score can vary based on the type of codec that the
Cisco Unified IP Phone uses.

Avg MOS LQK Average MOS LQK score observed for the entire voice stream.
Min MOS LQK Lowest MOS LQK score observed from start of the voice stream.
Max MOS LQK Baseline or highest MOS LQK score observed from start of the voice stream.

These codecs provide the following maximum MOS LQK score under normal
conditions with no frame loss:

e G.711 gives 4.5
e G.722 gives 4.5
e G.728/iLBC gives 3.9
e G.729 A/AB gives 3.8
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Table 8-5 Streaming Statistics Area Items (continued)

ltem Description

MOS LQK Version Version of the Cisco proprietary algorithm used to calculate MOS LQK
scores.

Cmltve Conceal Ratio |Total number of concealment frames divided by total number of speech
frames received from start of the voice stream.

Interval Conceal Ratio |Ratio of concealment frames to speech frames in preceding 3-second interval
of active speech. If using voice activity detection (VAD), a longer interval
might be required to accumulate 3 seconds of active speech.

Max Conceal Ratio Highest interval concealment ratio from start of the voice stream.

Conceal Secs Number of seconds that have concealment events (lost frames) from the start
of the voice stream (includes severely concealed seconds).

Severely Conceal Secs |Number of seconds that have more than 5 percent concealment events (lost
frames) from the start of the voice stream.

1. When the RTP Control Protocol is disabled, no data generates for this field and thus displays as 0.

Related Topics
e “Configuring Settings on the Cisco Unified IP Phone” chapter

e “Configuring Features, Templates, Services, and Users” chapter
e “Call Statistics Screen” section on page 7-11

e “Monitoring the Voice Quality of Calls” section on page 9-16
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Troubleshooting and Maintenance

This chapter provides information that can assist you in troubleshooting problems with your Cisco
Unified IP Phone 7965G and 7945G or with your IP telephony network. It also explains how to clean
and maintain your phone.

For additional troubleshooting information, refer to the Using the 79xx Status Information For
Troubleshooting tech note. That document is available to registered Cisco.com users at this URL:

http://www.cisco.com/warp/customer/788/AVVID/telecaster_trouble.html

If you need additional assistance to resolve an issue, see the “Obtaining Documentation, Obtaining
Support, and Security Guidelines” section on page Xiii.

This chapter includes these topics:
e Resolving Startup Problems, page 9-2
e Cisco Unified IP Phone Resets Unexpectedly, page 9-6
e Troubleshooting Cisco Unified IP Phone Security, page 9-9
¢ General Troubleshooting Tips, page 9-10

e General Troubleshooting Tips for the Cisco Unified IP Phone Expansion Module 7914 (SCCP
Phones Only), page 9-14

e Resetting or Restoring the Cisco Unified IP Phone, page 9-14
e Using the Quality Report Tool, page 9-16

e Monitoring the Voice Quality of Calls, page 9-16

¢ Where to Go for More Troubleshooting Information, page 9-18
¢ C(Cleaning the Cisco Unified IP Phone, page 9-19
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M Resolving Startup Problems

Resolving Startup Problems

After installing a Cisco Unified IP Phone into your network and adding it to Cisco Unified
Communications Manager, the phone should start up as described in the “Verifying the Phone Startup
Process” section on page 3-12. If the phone does not start up properly, see the following sections for
troubleshooting information:

e Symptom: The Cisco Unified IP Phone Does Not Go Through its Normal Startup Process, page 9-2

e Symptom: The Cisco Unified IP Phone Does Not Register with Cisco Unified Communications
Manager, page 9-3

e Symptom: Cisco Unified IP Phone Unable to Obtain IP Address, page 9-6

Symptom: The Cisco Unified IP Phone Does Not Go Through its Normal Startup
Process

When you connect a Cisco Unified IP Phone into the network port, the phone should go through its
normal startup process as described in the “Verifying the Phone Startup Process” section on page 3-12,
and the LCD screen should display information. If the phone does not go through the startup process,
the cause may be faulty cables, bad connections, network outages, lack of power, and so on. Or, the
phone may not be functional.

To determine whether the phone is functional, follow these suggestions to systematically eliminate these
other potential problems:

1. Verify that the network port is functional:
- Exchange the Ethernet cables with cables that you know are functional.

- Disconnect a functioning Cisco Unified IP Phone from another port and connect it to this
network port to verify the port is active.

— Connect the Cisco Unified IP Phone that will not start up to a different network port that is
known to be good.

— Connect the Cisco Unified IP Phone that will not start up directly to the port on the switch,
eliminating the patch panel connection in the office.

2. Verify that the phone is receiving power:
- If you are using external power, verify that the electrical outlet is functional.
— If you are using in-line power, use the external power supply instead.
— If you are using the external power supply, switch with a unit that you know to be functional.

— Make sure that the phone is connected to a switch that supports IEEE 802.3af Class 3 (15.4 W
in-line power at the switch port). For more information, see the “Providing Power to the Phone”
section on page 2-3.

3. If the phone still does not start up properly, power up the phone with the handset off-hook. When
the phone is powered up in this way, it attempts to launch a backup software image.

4. If the phone still does not start up properly, perform a factory reset of the phone. For instructions,
see the “Performing a Factory Reset” section on page 9-15.

If after attempting these solutions, the LCD screen on the Cisco Unified IP Phone does not display any
characters after at least five minutes, contact a Cisco technical support representative for additional
assistance.
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Symptom: The Cisco Unified IP Phone Does Not Register with Cisco
Unified Communications Manager

If the phone proceeds past the first stage of the startup process (LED buttons flashing on and off) but
continues to cycle through the messages displaying on the LCD screen, the phone is not starting up
properly. The phone cannot successfully start up unless it is connected to the Ethernet network and it
has registered with a Cisco Unified Communications Manager server.

These sections can assist you in determining the reason the phone is unable to start up properly:
e Identifying Error Messages, page 9-3
¢ Checking Network Connectivity, page 9-3
e Verifying TFTP Server Settings, page 9-3
e Verifying IP Addressing and Routing, page 9-4
e Verifying DNS Settings, page 9-4
e Verifying Cisco Unified Communications Manager Settings, page 9-4
e Cisco Unified Communications Manager and TFTP Services Are Not Running, page 9-4
e Creating a New Configuration File, page 9-5

e Registering the Phone with Cisco Unified Communications Manager, page 9-6

Identifying Error Messages

As the phone cycles through the startup process, you can access status messages that might provide you
with information about the cause of a problem. See the “Status Messages Screen” section on page 7-3
for instructions about accessing status messages and for a list of potential errors, their explanations, and
their solutions.

Checking Network Connectivity

If the network is down between the phone and the TFTP server or Cisco Unified Communications
Manager, the phone cannot start up properly. Ensure that the network is currently running.

Verifying TFTP Server Settings

You can determine the IP address of the TFTP server used by the phone by pressing the Settings button
on the phone, choosing Network Configuration, and scrolling to the TFTP Server 1 option.

If you have assigned a static IP address to the phone, you must manually enter a setting for the TFTP
Server 1 option. See the “Network Configuration Menu” section on page 4-5.

If you are using DHCP, the phone obtains the address for the TFTP server from the DHCP server. Check
the IP address configured in Option 150.

You can also enable the phone to use an alternate TFTP server. Such a setting is particularly useful if
the phone was recently moved from one location to another. See the “Network Configuration Menu”
section on page 4-5 for instructions.
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Verifying IP Addressing and Routing

You should verify the IP addressing and routing settings on the phone. If you are using DHCP, the DHCP
server should provide these values. If you have assigned a static IP address to the phone, you must enter
these values manually.

On the Cisco Unified IP Phone, press the Settings button, choose Network Configuration, and look at
the following options:

e DHCP Server—If you have assigned a static IP address to the phone, you do not need to enter a value
for the DHCP Server option. However, if you are using a DHCP server, this option must have a
value. If it does not, check your IP routing and VLAN configuration. Refer to Troubleshooting
Switch Port Problems, available at this URL: http://www.cisco.com/warp/customer/473/53.shtml

e [P Address, Subnet Mask, Default Router—If you have assigned a static IP address to the phone,
you must manually enter settings for these options. See the “Network Configuration Menu” section
on page 4-5 for instructions.

If you are using DHCP, check the IP addresses distributed by your DHCP server. Refer to Understanding
and Troubleshooting DHCP in Catalyst Switch or Enterprise Networks, available at this URL:
http://www.cisco.com/warp/customer/473/100.html#4 1

Verifying DNS Settings

If you are using DNS to refer to the TFTP server or to Cisco Unified Communications Manager, you
must ensure that you have specified a DNS server. Verify this setting by pressing the Settings button on
the phone, choosing Network Configuration, and scrolling to the DNS Server 1 option. You should
also verify that there is a CNAME entry in the DNS server for the TFTP server and for the

Cisco Unified Communications Manager system.

You must also ensure that DNS is configured to do reverse look-ups.

Verifying Cisco Unified Communications Manager Settings

On the Cisco Unified IP Phone, press the Settings button, choose Device Configuration, and look at
the CallManager Configuration options. The Cisco Unified IP Phone attempts to open a TCP
connection to all the Cisco Unified Communications Manager servers that are part of the assigned
Cisco Unified Communications Manager group. If none of these options contain IP addresses or show
Active or Standby, the phone is not properly registered with Cisco Unified Communications Manager.
See the “Registering the Phone with Cisco Unified Communications Manager” section on page 9-6 for
tips on resolving this problem.

Cisco Unified Communications Manager and TFTP Services Are Not Running

If the Cisco Unified Communications Manager or TFTP services are not running, phones may not be
able to start up properly. However, in such a situation, it is likely that you are experiencing a
system-wide failure, and other phones and devices are unable to start up properly.

If the Cisco Unified Communications Manager service is not running, all devices on the network that
rely on it to make phone calls will be affected. If the TFTP service is not running, many devices will not
be able to start up successfully.

To start a service, follow these steps:

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
[ 94 | oL-14641-01 |


http://www.cisco.com/warp/customer/473/53.shtml
http://www.cisco.com/warp/customer/473/100.html#41

| Chapter9 Troubleshooting and Maintenance

Step 1
Step 2

Step 3

Step 4

Note

Resolving Startup Problems [l

Procedure

From Cisco Unified Communications Manager Administration, choose Cisco Unified Serviceability
from the Navigation drop-down list and click Go.

Choose Tools > Control Center - Feature Services.
Choose the primary Cisco Unified Communications Manager server from the Server drop-down list.

The window displays the service names for the server that you chose, the status of the services, and a
service control panel to start or stop a service.

If a service has stopped, click its radio button and then click the Start button.

The Service Status symbol changes from a square to an arrow.

A service must be activated before it can be started or stopped. To activate a service, choose Tools >
Service Activation.

Creating a New Configuration File

Step 1

Step 2
Step 3

Step 4

Note

If you continue to have problems with a particular phone that other suggestions in this chapter do not
resolve, the configuration file may be corrupted.

To create a new configuration file, follow these steps:

Procedure

From Cisco Unified Communications Manager, choose Device > Phone > Find to locate the phone
experiencing problems.

Choose Delete to remove the phone from the Cisco Unified Communications Manager database.

Add the phone back to the Cisco Unified Communications Manager database. See the “Adding Phones
to the Cisco Unified Communications Manager Database” section on page 2-8 for details.

Power cycle the phone.

e When you remove a phone from the Cisco Unified Communications Manager database, its
configuration file is deleted from the Cisco Unified Communications Manager TFTP server. The
phone’s directory number or numbers remain in the Cisco Unified Communications Manager
database. They are called “unassigned DNs” and can be used for other devices. If unassigned DNs
are not used by other devices, delete them from the Cisco Unified Communications Manager
database. You can use the Route Plan Report to view and delete unassigned reference numbers.
Refer to Cisco Unified Communications Manager Administration Guide for more information.
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e Changing the buttons on a phone button template, or assigning a different phone button template to
a phone, may result in directory numbers that are no longer accessible from the phone. The directory
numbers are still assigned to the phone in the Cisco Unified Communications Manager database, but
there is no button on the phone with which calls can be answered. These directory numbers should
be removed from the phone and deleted if necessary.

Registering the Phone with Cisco Unified Communications Manager

A Cisco Unified IP Phone can register with a Cisco Unified Communications Manager server only if the
phone has been added to the server or if auto-registration is enabled. Review the information and
procedures in the “Adding Phones to the Cisco Unified Communications Manager Database” section on
page 2-8 to ensure that the phone has been added to the Cisco Unified Communications Manager
database.

To verify that the phone is in the Cisco Unified Communications Manager database, choose Device >
Phone > Find from Cisco Unified Communications Manager Administration to search for the phone

based on its MAC Address. For information about determining a MAC address, see the “Determining
the MAC Address of a Cisco Unified IP Phone” section on page 2-13.

If the phone is already in the Cisco Unified Communications Manager database, its configuration file
may be damaged. See the “Creating a New Configuration File” section on page 9-5 for assistance.

Symptom: Cisco Unified IP Phone Unable to Obtain IP Address

If a phone is unable to obtain an IP address when it starts up, the phone may be not be on the same
network or VLAN as the DHCP server, or the switch port to which the phone is connected may be
disabled.

Make sure that the network or VLAN to which the phone is connected has access to the DHCP server,
and make sure that the switch port is enabled.

Cisco Unified IP Phone Resets Unexpectedly

If users report that their phones are resetting during calls or while idle on their desk, you should
investigate the cause. If the network connection and Cisco Unified Communications Manager
connection are stable, a Cisco Unified IP Phone should not reset on its own.

Typically, a phone resets if it has problems connecting to the Ethernet network or to
Cisco Unified Communications Manager. These sections can help you identify the cause of a phone
resetting in your network:

e Verifying the Physical Connection, page 9-7

e Identifying Intermittent Network Outages, page 9-7

e Verifying DHCP Settings, page 9-7

e Checking Static IP Address Settings, page 9-7

e Verifying Voice VLAN Configuration, page 9-7

e Verifying that the Phones Have Not Been Intentionally Reset, page 9-8
e Eliminating DNS or Other Connectivity Errors, page 9-8
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e Checking Power Connection, page 9-8

Verifying the Physical Connection

Verify that the Ethernet connection to which the Cisco Unified IP Phone is connected is up. For example,
check whether the particular port or switch to which the phone is connected is down and that the switch
is not rebooting. Also make sure that there are no cable breaks.

Identifying Intermittent Network Qutages

Intermittent network outages affect data and voice traffic differently. Your network might have been
experiencing intermittent outages without detection. If so, data traffic can resend lost packets and verify
that packets are received and transmitted. However, voice traffic cannot recapture lost packets. Rather
than retransmitting a lost network connection, the phone resets and attempts to reconnect its network
connection.

If you are experiencing problems with the voice network, you should investigate whether an existing
problem is simply being exposed.

Verifying DHCP Settings

Follow this process to help determine if the phone has been properly configured to use DHCP:

1. Verify that you have properly configured the phone to use DHCP. See the “Network Configuration
Menu” section on page 4-5 for more information.

2. Verify that the DHCP server has been set up properly.
3. Verify the DHCP lease duration. Cisco recommends that you set it to 8 days.

Checking Static IP Address Settings

If the phone has been assigned a static IP address, verify that you have entered the correct settings. See
the “Network Configuration Menu” section on page 4-5 for more information.

Verifying Voice VLAN Configuration

If the Cisco Unified IP Phone appears to reset during heavy network usage (for example, following
extensive web surfing on a computer connected to same switch as phone), it is likely that you do not
have a voice VLAN configured.

Isolating the phones on a separate auxiliary VLAN increases the quality of the voice traffic. See the
“Understanding How the Cisco Unified IP Phone Interacts with the VLAN” section on page 2-2 for
details.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Verifying that the Phones Have Not Been Intentionally Reset

If you are not the only administrator with access to Cisco Unified Communications Manager, you should
verify that no one else has intentionally reset the phones.

You can check whether a Cisco Unified IP Phone received a command from
Cisco Unified Communications Manager to reset by pressing the Settings button on the phone and
choosing Status > Network Statistics. If the phone was recently reset one of these messages appears:

e Reset-Reset—Phone closed due to receiving a Reset/Reset from Cisco Unified Communications
Manager Administration.

¢ Reset-Restart—Phone closed due to receiving a Reset/Restart from Cisco Unified Communications
Manager Administration.

Eliminating DNS or Other Connectivity Errors

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

If the phone continues to reset, follow these steps to eliminate DNS or other connectivity errors:

Procedure

Use the Erase softkey to reset phone settings to their default values. See the “Resetting or Restoring the
Cisco Unified IP Phone” section on page 9-14 for details.

Modify DHCP and IP settings:
a. Disable DHCP. See the “Network Configuration Menu” section on page 4-5 for instructions.

b. Assign static IP values to the phone. See the “Network Configuration Menu” section on page 4-5
for instructions. Use the same default router setting used for other functioning Cisco Unified IP
Phones.

c. Assign TFTP server. See the “Network Configuration Menu” section on page 4-5 for instructions.
Use the same TFTP server used for other functioning Cisco Unified IP Phones.

On the Cisco Unified Communications Manager server, verify that the local host files have the correct
Cisco Unified Communications Manager server name mapped to the correct IP address.

From Cisco Unified Communications Manager, choose System > Server and verify that the server is
referred to by its IP address and not by its DNS name.

From Cisco Unified Communications Manager, choose Device > Phone and verify that you have
assigned the correct MAC address to this Cisco Unified IP Phone. For information about determining a
MAC address, see the “Determining the MAC Address of a Cisco Unified IP Phone” section on

page 2-13.

Power cycle the phone.

Checking Power Connection

In most cases, a phone will restart if it powers up by using external power but loses that connection and
switches to PoE. Similarly, a phone may restart if it powers up by using PoE and then gets connected to
an external power supply.
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Troubleshooting Cisco Unified IP Phone Security

Troubleshooting Cisco Unified IP Phone Security

Table 9-1 provides troubleshooting information for the security features on the Cisco Unified IP Phone.
For information relating to the solutions for any of these issues, and for additional troubleshooting
information about security, refer to Cisco Unified Communications Manager Security Guide.

Table 9-1

Cisco Unified IP Phone Security Troubleshooting

Problem

Possible Cause

CTL File Problems

Device authentication error.

CTL file does not have a Cisco Unified Communications
Manager certificate or has an incorrect certificate.

Phone cannot authenticate CTL file.

The security token that signed the updated CTL file does
not exist in the CTL file on the phone.

Phone cannot authenticate any of the

configuration files other than the CTL file.

There is a bad TFTP record.

Phone reports TFTP authorization failure.

e The TFTP address for the phone does not exist in the
CTL file.

e If you created a new CTL file with a new TFTP
record, the existing CTL file on the phone may not
contain a record for the new TFTP server.

Phone does not register with
Cisco Unified Communications Manager.

The CTL file does not contain the correct information for
the Cisco Unified Communications Manager server.

Phone does not request signed
configuration files.

The CTL file does not contain any TFTP entries with
certificates.

802.1X Enabled on Phone but Not Authenticating

Phone cannot obtain a DHCP-assigned IP
address.

Phone does not register with
Cisco Unified Communications Manager.

Phone status display as “Configuring IP” or
“Registering”.

802.1X Authentication Status displays as
“Held” (see the “802.1X Authentication
and Status” section on page 4-34 for more
details).

Status menu displays 802.1X status as
“Failed” (see the “Status Menu” section on
page 7-2 for more details).

These errors typically indicate that 802.1X
authentication is enabled on the phone, but the phone is
unable to authenticate.

1. Verify that you have properly configured the
required components (see the “Supporting 802.1X
Authentication on Cisco Unified IP Phones” section
on page 1-15 for more information).

2. Confirm that the shared secret is configured on the
phone (see the*“802.1X Authentication and Status”
section on page 4-34 for more information).

— Ifthe shared secret is configured, verify that you
have the same shared secret entered on the
authentication server.

— If the shared secret is not configured, enter it,
and ensure that it matches the one on the
authentication server.

| oL-14641-01

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1 g



Chapter9  Troubleshooting and Maintenance |

M General Troubleshooting Tips

Table 9-1 Cisco Unified IP Phone Security Troubleshooting (continued)

Problem Possible Cause
802.1X Not Enabled

Phone cannot obtain a DHCP-assigned IP | These errors typically indicate that 802.1X

address authentication is not enabled on the phone. To enable it,
see the “802.1X Authentication and Status” section on
page 4-34.

Phone does not register with
Cisco Unified Communications Manager

Phone status display as “Configuring IP” or
“Registering”

802.1X Authentication Status displays as
“Disabled”

Status menu displays DHCP status as
timing out
Factory Reset Deleted 802.1X Shared Secret

Phone cannot obtain a DHCP-assigned IP | These errors typically indicate that the phone has
address completed a factory reset (see the “Performing a Factory
Reset” section on page 9-15) while 802.1X was enabled.
A factory reset deletes the shared secret, which is

- — required for 802.1X authentication and network access.
Phone status display as “Configuring IP” or |4 resolve this, you have two options:
“Registering”

Phone does not register with
Cisco Unified Communications Manager

e Temporarily disable 802.1X authentication on the
switch.

Cannot access phone menus to verify

802.1X status )
e Temporarily move the phone to a network

environment that is not using 802.1X authentication.

Once the phone starts up normally in one of these
conditions, you can access the 802.1X configuration
menus and re-enter the shared secret (see the “802.1X
Authentication and Status” section on page 4-34).

General Troubleshooting Tips

Table 9-2 provides general troubleshooting information for the Cisco Unified IP Phone.

Table 9-2 Cisco Unified IP Phone Troubleshooting
Summary Explanation
Daisy-chaining IP phones Daisy chaining (connecting an IP phone to another IP phone through

the access port) is not supported. Each IP phone should directly
connect to a switch port.

Poor quality when calling In Cisco Unified Communications Manager, you can configure the
digital cell phones using the network to use the G.729 protocol (the defaultis G.711). When using
G.729 protocol G.729, calls between an IP phone and a digital cellular phone will

have poor voice quality. Use G.729 only when absolutely necessary.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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Table 9-2

General Troubleshooting Tips Il

Cisco Unified IP Phone Troubleshooting (continued)

Summary

Explanation

Prolonged broadcast storms
cause IP phones to reset, or be
unable to make or answer a call

A prolonged Layer 2 broadcast storm (lasting several minutes) on the
voice VLAN may cause IP phones to reset, lose an active call, or be
unable to initiate or answer a call. Phones may not come up until a
broadcast storm ends.

Moving a network connection
from the phone to a workstation

If you are powering your phone through the network connection, you
must be careful if you decide to unplug the phone’s network
connection and plug the cable into a desktop computer.

A

Caution  The computer’s network card cannot receive power
through the network connection; if power comes through
the connection, the network card can be destroyed. To
protect a network card, wait 10 seconds or longer after
unplugging the cable from the phone before plugging it
into a computer. This delay gives the switch enough time
to recognize that there is no longer a phone on the line and
to stop providing power to the cable.

Changing the telephone
configuration

By default, the network configuration options are locked to prevent
users from making changes that could impact their network
connectivity. You must unlock the network configuration options
before you can configure them. See the “Unlocking and Locking
Options” section on page 4-3 for details.

LCD display issues

If the display appears to have rolling lines or a wavy pattern, it might
be interacting with certain types of older fluorescent lights in the
building. Moving the phone away from the lights, or replacing the
lights, should resolve the problem.

Dual-Tone Multi-Frequency
(DTMF) delay

When you are on a call that requires keypad input, if you press the
keys too quickly, some of them might not be recognized.

Codec mismatch between the
phone and another device

The RxType and the TxType statistics show the codec that is being
used for a conversation between this Cisco Unified IP phone and the
other device. The values of these statistics should match. If they do
not, verify that the other device can handle the codec conversation,
or a transcoder is in place to handle the service.

See the “Call Statistics Screen” section on page 7-11 for information
about displaying these statistics.

Sound sample mismatch
between the phone and another
device

The RxSize and the TxSize statistics show the size of the voice
packets that are being used in a conversation between this

Cisco Unified IP phone and the other device. The values of these
statistics should match.

See the “Call Statistics Screen” section on page 7-11 for information
about displaying these statistics.
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Table 9-2 Cisco Unified IP Phone Troubleshooting (continued)

Summary

Explanation

Gaps in voice calls

Check the AvgJtr and the MaxJtr statistics. A large variance between
these statistics might indicate a problem with jitter on the network or
periodic high rates of network activity.

See the “Call Statistics Screen” section on page 7-11 for information
about displaying these statistics.

Loopback condition

A loopback condition can occur when the following conditions are
met:

e The SW Port Configuration option in the Network Configuration
menu on the phone is set to 10 Half
(10-BaseT/half duplex)

e The phone receives power from an external power supply
e The phone is powered down (the power supply is disconnected)

In this case, the switch port on the phone can become disabled and
the following message will appear in the switch console log:

HALF_DUX_COLLISION_EXCEED_THRESHOLD

To resolve this problem, re-enable the port from the switch.

One-way audio

When at least one person in a call does not receive audio, IP
connectivity between phones is not established. Check the
configurations in routers and switches to ensure that IP connectivity
is properly configures.

Peer Firmware Sharing fails.

If the Peer Firmware Sharing fails, the phone will default to using the
TFTP server to download firmware. Access the log messages stored
on the remote logging machine to help debug the Peer Firmware
Sharing feature.

Note These log messages are different than the log messages sent
to the phone log.

Cisco VT Advantage/Unified
Video Advantage (CVTA)

If you are having problems getting CVTA to work, make sure that the
PC Port is enabled, and that CDP is enabled on the PC port.

See Network Configuration Menu, page 4-5 for more information.
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General Troubleshooting Tips Il

Table 9-2 Cisco Unified IP Phone Troubleshooting (continued)

Summary

Explanation

Phone call cannot be
established

The phone does not have a DHCP IP address, is unable to register to
Cisco Unified Communications Manager, and shows a Configuring
IP or Registering message.

Verify the following:

1.
2,

The Ethernet cable is attached.

The Cisco CallManager service is running on the Cisco Unified
Communications Manager server.

Both phones are registered to the same Cisco Unified
Communications Manager.

Audio server debug and capture logs are enabled for both
phones. If needed, enable Java debug.

Call established with the iLBC
protocol does not show that the
iLBC codec is being used

Call statistics display does not show iLBC as the receiver/sender
codec.

1.

Check the following by using Cisco Unified Communications
Manager Administration:

— Both phones are in the iLBC device pool.
— The iLBC device pool is configured with the iLBC region.
— The iLBC region is configured with the iLBC codec.

Capture a sniffer trace between the phone and Cisco Unified
Communications Manager and verify that SCCP messages,
OpenReceiveChannel, and StationMediaTransmit messages
have media payload type value equal to 86. If so, the problem is
with the phone; otherwise, the problem is with the Cisco Unified
Communications Manager configuration.

Enable audio server debug and capture logs from both phones. If
needed, enable Java debug.
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General Troubleshooting Tips for the Cisco Unified IP Phone
Expansion Module 7914 (SCCP Phones Only)

Table 9-3 provides general troubleshooting information for the Cisco Unified IP Phone Expansion
Module 7914. This information applies to SCCP phones only because SIP phones do not support this

device.
Table 9-3 Cisco Unified IP Phone Expansion Module 7914 Troubleshooting
Problem Solution

No display on the Cisco Unified IP
Phone Expansion Module 7914.

Verify that all of the cable connections are correct.

Verify that you have power to the Cisco Unified IP Phone
Expansion Module 7914.

Lighted buttons on the first Cisco
Unified IP Phone Expansion Module
7914 are all red.

Verify that the Cisco Unified IP Phone Expansion Module
7914 is configured in Cisco Unified Communications
Manager.

Lighted buttons on the second Cisco
Unified IP Phone Expansion Module
7914 are all amber.

Verify that the Cisco Unified IP Phone Expansion Module
7914 is configured in Cisco Unified Communications
Manager.

Resetting or Restoring the Cisco Unified IP Phone

There are two methods for resetting or restoring the Cisco Unified IP Phone:

e Performing a Basic Reset, page 9-14

e Performing a Factory Reset, page 9-15

Performing a Basic Reset

Table 9-4

Performing a basic reset of a Cisco Unified IP Phone provides a way to recover if the phone experiences
an error and provides a way to reset or restore various configuration and security settings.

Table 9-4 describes the ways to perform a basic reset. You can reset a phone with any of these operations
any time after the phone has started up. Choose the operation that is appropriate for your situation.

Basic Reset Methods

Operation

Performing

Explanation

Restart phone

From the Main screen, press Settings to displays |Resets any user and network configuration

the Settings menu, then press **#%*,

Note This basic reset sequence also works from
any other screen that does not accept user

input.

changes that you have made but that the phone has
not written to its flash memory to previously saved
settings, then restarts the phone.
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Resetting or Restoring the Cisco Unified IP Phone W

Table 9-4 Basic Reset Methods (continued)

Operation Performing Explanation

Erase softkey From the Settings menu, unlock phone options Resets user and network configuration settings to
(see the “Unlocking and Locking Options” section |their default values, deletes the CTL file from the
on page 4-3). Then press the Erase softkey. phone, and restarts the phone.

From the Network Configuration menu, unlock Resets network configuration settings to their
phone options (see the “Unlocking and Locking  |default values and resets the phone. (This method
Options” section on page 4-3). The press the Erase |causes DHCP reconfigure the IP address of the
softkey. phone.)

From the Security Configuration menu, unlock Deletes the CTL file from the phone and restarts
phone options (see the “Unlocking and Locking  |the phone.

Options” section on page 4-3). Then press the
Erase softkey.

Performing a Factory Reset

When you perform a factory reset of the Cisco Unified IP Phone, the following information is erased or
reset to its default value:

e CTL file—Erased

e LSC—Erased

e User configuration settings—Reset to default values

e Network configuration settings—Reset to default values
e (Call histories—Erased

e Locale information—Reset to default values

e Phone application—Erased (phone recovers by loading the term45.default.loads file or the
term65.default.loads file, depending on the phone model)

Before you perform a factory reset, ensure that the following conditions are met:
¢ The phone must be on a DHCP-enabled network.
e A valid TFTP server must be set in DHCP option 150 or option 66 on the DHCP server.

e The term45.default.loads file or the term65.default.loads file and the files specified in that file
should be available on the TFTP server that is specified by the DHCP packet.

To perform a factory reset of a phone, perform the following steps:

Procedure

Step 1 Unplug the power cable from the phone and then plug it back in.
The phone begins its power-up cycle.

Step2  While the phone is powering up, and before the Speaker button flashes on and off,
press and hold #.
Continue to hold # until each line button flashes on and off in sequence in amber.

Step3  Release # and press 123456789*0#.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
I oL-14641-01 .m



Chapter9 Troubleshooting and Maintenance

W Using the Quality Report Tool

You can press a key twice in a row, but if you press the keys out of sequence, the factory reset will not
take place.

After you press these keys, the line buttons on the phone flash red, and the phone goes through the
factory reset process.

Do not power down the phone until it completes the factory reset process, and the main screen appears.

Using the Quality Report Tool

The Quality Report Tool (QRT) is a voice quality and general problem-reporting tool for the
Cisco Unified IP Phone. The QRT feature is installed as part of the Cisco Unified Communications
Manager installation.

You can configure users’ Cisco Unified IP Phones with QRT. When you do so, users can report problems
with phone calls by pressing the QRT softkey. This softkey is available only when the Cisco

Unified IP Phone is in the Connected, Connected Conference, Connected Transfer, and/or OnHook
states.

When a user presses the QRT softkey, a list of problem categories appears. The user selects the
appropriate problem category, and this feedback is logged in an XML file. Actual information logged
depends on the user selection, and whether the destination device is a Cisco Unified IP Phone.

For more information about using QRT, refer to Cisco Unified Communications Manager Features and
Services Guide.

Monitoring the Voice Quality of Calls

To measure the voice quality of calls that are sent and received within the network, Cisco Unified IP
Phones use these statistical metrics that are based on concealment events. The DSP plays concealment
frames to mask frame loss in the voice packet stream.

e Concealment Ratio metrics—Show the ratio of concealment frames over total speech frames. An
interval conceal ratio is calculated every 3 seconds.

e (Concealed Second metrics—Show the number of seconds in which the DSP plays concealment
frames due to lost frames. A severely “concealed second” is a second in which the DSP plays more
than five percent concealment frames.

¢ MOS-LQK metrics—Use a numeric score to estimate the relative voice listening quality. The Cisco
Unified IP Phone calculates the mean opinion score (MOS) for listening quality (LQK) based
audible concealment events due to frame loss in the preceding 8 seconds, and includes perceptual
weighting factors such as codec type and frame size.

MOS LQK scores are produced by a Cisco proprietary algorithm, Cisco Voice Transmission Quality
(CVTQ) index. Depending on the MOS LQK version number, these scores might be compliant with
the International Telecommunications Union (ITU) standard P.564. This standard defines
evaluation methods and performance accuracy targets that predict listening quality scores based on
observation of actual network impairment.
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Note

Monitoring the Voice Quality of Calls 1l

Concealment ratio and concealment seconds are primary measurements based on frame loss while MOS
LQK scores project a “human-weighted” version of the same information on a scale from 5 (excellent)
to 1 (bad) for measuring listening quality.

Listening quality scores (MOS LQK) relate to the clarity or sound of the received voice signal.
Conversational quality scores (MOS CQ such as G.107) include impairment factors, such as delay, that
degrade the natural flow of conversation.

You can access voice quality metrics from the Cisco Unified IP Phone by using the Call Statistics screen
(see the “Call Statistics Screen” section on page 7-11) or remotely by using Streaming Statistics (see the
“Monitoring the Cisco Unified IP Phone Remotely” chapter).

Using Voice Quality Metrics

Note

To use the metrics for monitoring voice quality, note the typical scores under normal conditions of zero
packet loss and use the metrics as a baseline for comparison.

It is important to distinguish significant changes from random changes in metrics. Significant changes
are scores that change about 0.2 MOS or greater and persist in calls that last longer than 30 seconds.
Conceal Ratio changes should indicate greater than 3 percent frame loss.

MOS LQK scores can vary based on the codec that the Cisco Unified IP Phone uses. The following
codecs provide these maximum MOS LQK scores under normal conditions with zero frame loss:

e G.711 gives 4.5
o (G.722 gives 4.5
e G.728/iLBC gives 3.9
e G.729 A/AB gives 3.8

e CVTQ does not support wideband (7 kHz) speech codecs, as ITU has not defined the extension of
the technique to wideband. Therefore, MOS scores that correspond to G.711 performance are
reported for G.722 calls to allow basic quality monitoring, rather than not reporting an MOS score.

e Reporting G.711-scale MOS scores for wideband calls through the use of CVTQ allows basic
quality classifications to be indicated as good/normal or bad/abnormal. Calls with high scores
(approximately 4.5) indicate high quality/low packet loss, and lower scores (approximately 3.5)
indicate low quality/high packet loss.

e Unlike MOS, the Conceal Ratio and Concealed Seconds metrics remain valid and useful for both
wideband and narrowband calls.

A Conceal Ratio of zero indicates that the IP network is delivering frames and packets on time with no
loss.
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Troubleshooting Tips

When you observe significant and persistent changes to metrics, use Table 9-5 for general
troubleshooting information:

Table 9-5 Changes to Voice Quality Metrics

Metric Change Condition

MOS LQK scores decrease Network impairment from packet loss or high jitter:
significantly

e Average MOS LQK decreases could indicate widespread and
uniform impairment.

e Individual MOS LQK decreases indicate bursty impairment.

Cross-check with Conceal Ratio and Conceal Seconds for evidence of
packet loss and jitter.

MOS LQK scores decrease e Check to see if the phone is using a different codec than expected
significantly (RxType and TxType).

e Check to see if the MOS LQK version changed after a firmware

upgrade.

Conceal Ratio and Conceal e Network impairment from packet loss or high jitter.
Seconds increase significantly
Conceal Ratio is near or at ¢ Noise or distortion in the audio channel such as echo or audio
zero, but the voice quality is levels.

poor. e Tandem calls that undergo multiple encode/decode such as calls

to a cellular network or calling card network.

e Acoustic problems coming from a speakerphone, handsfree
cellular phone or wireless headset.

Check packet transmit (TxCnt) and packet receive (RxCnt) counters
to verify that voice packets are flowing.

~

Note  Voice quality metrics do not account for noise or distortion, only frame loss.

Where to Go for More Troubleshooting Information

If you have additional questions about troubleshooting the Cisco Unified IP Phones, several Cisco.com
web sites can provide you with more tips. Choose from the sites available for your access level.

e Cisco Unified IP Phone Troubleshooting Resources:

http://www.cisco.com/en/US/products/hw/phones/ps379/tsd_products_
support_series_home.html

e Cisco Products and Services (Technical Support and Documentation):

http://www.cisco.com/en/US/products/sw/voicesw/tsd_products_support_
category_home.html

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
[ 9-18 | oL-14641-01 |


http://www.cisco.com/en/US/products/hw/phones/ps379/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/voicesw/tsd_products_support_category_home.html
http://www.cisco.com/en/US/products/sw/voicesw/tsd_products_support_category_home.html

| Chapter9 Troubleshooting and Maintenance

Cleaning the Cisco Unified IP Phone

Cleaning the Cisco Unified IP Phone

To clean your Cisco Unified IP phone, use a soft, dry cloth to wipe the phone and the phone screen. Do
not apply liquids or powders directly on the phone. As with all non-weather-proof electronics, liquids
and powders can damage the components and cause failures.
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I Cleaning the Cisco Unified IP Phone
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Providing Information to Users Via a Website

If you are a system administrator, you are likely the primary source of information for Cisco Unified IP
Phone users in your network or company. It is important to provide current and thorough information to
end users.

Cisco recommends that you create a web page on your internal support site that provides end users with
important information about their Cisco Unified IP Phones.

Consider including the following types of information on this site:
e How Users Obtain Support for the Cisco Unified IP Phone, page A-1
e How Users Access the Online Help System on the Phone, page A-1
¢ How Users Get Copies of Cisco Unified IP Phone Manuals, page A-2
e Accessing Cisco 7900 Series Unified IP Phone eLearning Tutorials (SCCP Phones Only), page A-2
e How Users Subscribe to Services and Configure Phone Features, page A-3
e How Users Access a Voice Messaging System, page A-3

e How Users Configure Personal Directory Entries, page A-4

How Users Obtain Support for the Cisco Unified IP Phone

To successfully use some of the features on the Cisco Unified IP Phone (including speed dial, services,
and voice-messaging system options), users must receive information from you or from your network
team or be able to contact you for assistance. Make sure to provide end users with the names of people
to contact for assistance and with instructions for contacting those people.

How Users Access the Online Help System on the Phone

This Cisco Unified IP Phone 7965G and 7945G provides access to a comprehensive online help system.
To view the main help menu on a phone, press the ? button on the phone and wait for the menu to appear.
If you are already in Help, press Main.

Main menu topics include:
e About Your Cisco Unified IP Phone—Descriptive information about the phone model

e How do I...?—Procedures and information about commonly used phone tasks
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B How Users Get Copies of Cisco Unified IP Phone Manuals

e Calling Features—Descriptions and procedures for using calling features, such as conference and
transfer

e Help—Tips on using and accessing Help

You can also use the ? button to obtain information about softkeys, menu items, and the help system
itself. Refer to Cisco Unified IP Phone 7965G and 7945G Guide for more information.

How Users Get Copies of Cisco Unified IP Phone Manuals

You should provide end users with access to user documentation for the Cisco Unified IP Phones. Cisco
Unified IP Phone 7965G and 7945G Guide includes detailed user instructions for key phone features.

There are several Cisco Unified IP Phone models available, so to assist users in finding the appropriate
documentation on the Cisco website, Cisco recommends that you provide links to the current
documentation. If you do not want to or cannot send users to the Cisco website, Cisco suggests that you
download the PDF files and provide them to end users on your website.

For a list of available documentation, go to the Cisco Unified IP Phone website at this URL:
http://www.cisco.com/en/US/products/hw/phones/ps379/tsd_products_support_series_home.html

For more information about viewing or ordering documentation, see the “Obtaining Documentation,
Obtaining Support, and Security Guidelines” section on page Xxiii.

Additionally, you can provide end users with access to self-paced Cisco Unified IP Phone eLearning
tutorials for several phone models. The tutorials can include a link to a user guide PDF. For more
information, see the “Accessing Cisco 7900 Series Unified IP Phone eLearning Tutorials (SCCP Phones
Only)” section on page A-2.

Accessing Cisco 7900 Series Unified IP Phone eLearning
Tutorials (SCCP Phones Only)

Cisco 7900 Series Unified IP Phone eLearning tutorials use audio and animation to demonstrate basic
calling features for SCCP phones. The eLearning tutorials are currently available for the Cisco Unified
IP Phone 7965G and 7945G, and other Cisco Unified IP Phone models.

End-users can access runtime versions of the eLearning tutorials (English only) from Cisco.com by
looking for tutorials under relevant phone models at this site:

http://cisco.com/en/US/products/hw/phones/ps379/products_user_guide_list
.html

Administrators can either download customizable versions of the eLearning tutorials (English only)
from the phone product pages on Cisco.com
http://www.cisco.com/en/US/products/hw/phones/ps379/ps1855/index.html or obtain tutorials from the
Cisco Unified Communications Manager Design, Installation, and Operation Guides CD that ships with
Cisco Unified Communications Manager version 4.1 or later. (Availability of tutorials by phone model
can vary by CD version.) In either case, refer to the tutorial Read Me file included with the relevant
eLearning tutorial for specific instructions, including how to link to the most recent user guide PDF.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
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~

Note

How Users Subscribe to Services and Configure Phone Features W

The eLearning tutorials are updated periodically and therefore might not contain the latest feature
information for end-users. For the latest feature information, end-users should refer to the Cisco Unified
IP Phone end-user documentation specific to their phone model and Cisco Unified Communications
Manager version.

How Users Subscribe to Services and Configure Phone Features

End users can perform a variety of activities by using the Cisco Unified Communications Manager User
Options web pages. These activities include subscribing to services, setting up speed dial and call
forwarding numbers, configuring ring settings, and creating a personal address book. Keep in mind that
configuring settings on a phone using a website might be new for your end users. You need to provide
as much information as possible to ensure that they can successfully access and use the User Options
web pages.

Make sure to provide end users with the following information about the User Options web pages:
e The URL required to access the application. This URL is:

http://server_name:portnumber/ccmuser/, where server_name is the host on which the web server
is installed.

e A user ID and default password are needed to access the application.

These settings correspond to the values you entered when you added the user to
Cisco Unified Communications Manager (see the “Adding Users to Cisco Unified Communications
Manager” section on page 5-16).

e A brief description of what a web-based, graphical user interface application is, and how to access
it with a web browser.

e An overview of the tasks that users can accomplish by using the web page.

You can also refer users to Cisco Unified IP Phone 7965G and 7945G Guide, which is available at this
URL:

http://www.cisco.com/en/US/products/hw/phones/ps379/tsd_products_support_series_home.html

How Users Access a Voice Messaging System

Cisco Unified Communications Manager lets you integrate with many different voice messaging
systems, including the Cisco Unity voice messaging system. Because you can integrate with a variety of
systems, you must provide users with information about how to use your specific system.

You should provide this information to each user:
e How to access the voice messaging system account.

Make sure that you have used Cisco Unified Communications Manager to configure the Messages
button on the Cisco Unified IP Phone.

e Initial password for accessing the voice messaging system.
Make sure that you have configured a default voice messaging system password for all users.

e How the phone indicates that voice messages are waiting.
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I How Users Configure Personal Directory Entries

Make sure that you have used Cisco Unified Communications Manager to set up a message waiting
indicator (MWI) method.

How Users Configure Personal Directory Entries

Users can configure personal directory entries on the Cisco Unified IP Phone. To configure a personal
directory, users must have access to the following:

e User Options web pages—Make sure that users know how to access their User Options web pages.
See the “How Users Subscribe to Services and Configure Phone Features” section on page A-3 for
details.

e Cisco Unified IP Phone Address Book Synchronizer—Make sure to provide users with the installer
for this application. To obtain the installer, choose Application > Install Plugins from
Cisco Unified Communications Manager and click Cisco IP Phone Address Book Synchronizer.

See the “Installing and Configuring the Cisco Unified IP Phone Address Book Synchronizer” section on
page A-4 for information about installing the Cisco Unified IP Phone Address Book Synchronizer.

Installing and Configuring the Cisco Unified IP Phone Address Book
Synchronizer

Use this tool to synchronize data stored in your Microsoft Windows, Microsoft Outlook, or
Microsoft Outlook Express address book(s) with the Cisco Unified Communications Manager directory
and Personal Address Book service.

Installing the Synchronizer

Step1  Get the Cisco Unified IP Phone Address Book Synchronizer installer file from your system
administrator.

Step2  Double-click the TabSynclInstall.exe file provided by your system administrator.
The Welcome to Cisco Unified IP Phone Address Book Synchronizer window appears.
Step3  Click Next.
The License Agreement window appears.
Step4  Read the license agreement information, and click Yes to accept.
The Choose Destination Location window appears.
Step5  Choose the directory in which you want to install the application and click Next.
The Start Copying Files window appears.
Step6  Verify that you have chosen the correct directory, and click Next.

The installation wizard installs the application to your computer. When the installation is complete, the
InstallShield Wizard Complete window appears.

Step7  Click Finish.

Step8  To complete the process, you must next configure the Synchronizer.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
[ A4 | oL-14641-01 |



| Appendix A Providing Information to Users Via a Website

Step 1

Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Step 8

Step 9
Step 10

How Users Configure Personal Directory Entries 1l

Configuring the Synchronizer

Open the Cisco Unified IP Phone Address Book Synchronizer.

If you accepted the default installation directory, you can open the application by choosing Start >
Programs > Cisco > IP Phone Address Synchronizer.

To configure user information, click the Password button.

The Cisco Unified IP Phone User window appears.

Enter the Cisco Unified IP Phone user name and password and click OK.

To configure synchronization rules, click the Rules Options button.

Choose the synchronization method that you want to use and click OK.

To configure Cisco Unified Communications Manager information, click the CCM Server button.
The Configure Cisco Unified Communications Manager Web Server window appears.

Enter the IP address or host name of the Cisco Unified Communications Manager and click OK.
If you do not have this information, contact your system administrator.

Click the Password button.

The Cisco Unified IP Phone User window appears.

Enter your user identification and password for the Cisco Unified IP Phone User Options application.
To start the directory synchronization process, click the Synchronize button.

The Synchronization Status window provides information on the status of the address book
synchronization. If you chose the user intervention for duplicate entries rule and you have duplicate
address book entries, the Duplicate Selection window appears. Choose the entry that you want to include
in your Personal Address Book and click OK.

When synchronization completes, click Exit to close the Cisco Unified IP Phone
Address Book Synchronizer.
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= APPENDIX B

Feature Support by Protocol for the Cisco Unified
IP Phone 7965G and 7945G

This appendix provides information about feature support for the Cisco Unified IP Phone 7965G and
7945G using the SCCP or SIP protocol with Cisco Unified Communications Manager Release 6.0.

Table B-1 provides a high-level overview of calling features and their support by protocol. This table
focuses primarily on end-user calling features and is not intended to represent a comprehensive listing
of all available phone features.

Table B-1 also provides references to appropriate sections in Cisco Unified IP Phone 7965G and 7945G
Phone Guide for Cisco Unified Communications Manager 6.0, which is available at this URL:

http://www.cisco.com/en/US/products/hw/phones/ps379/tsd_products_support_series_home.html

Table B-1 Cisco Unified IP Phone 7965G and 7945G Feature Support by Protocol
Cisco Unified IP Phone 7965G
and 7945G

Features SCCP SIP For More Information

Calling Features

Abbreviated Dialing Supported Supported “Basic Call Handling—Placing a Call: Additional
Options”

Answer Release Supported Supported

Audible Message Waiting Indicator |Supported Supported “Accessing Voice Messages”

Auto Answer Supported Supported “Using a Handset, Headset, and
Speakerphone—Using Auto Answer”

Auto Dial Supported Supported “Basic Call Handling—Placing a Call: Basic
Options”

Barge (and cBarge) Supported Supported “Advanced Call Handling—Using a Shared Line”

Busy Lamp Field (BLF) Call Lists |Supported Supported “Advanced Call Handling—Determining if Another
Line is Busy or Idle”

Busy Lamp Field (BLF) Speed Dial |Supported Supported “Advanced Call Handling—Determining if Another
Line is Busy or Idle”

Call Back Supported Supported “Basic Call Handling—Placing a Call: Additional
Options”
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Table B-1 Cisco Unified IP Phone 7965G and 7945G Feature Support by Protocol (continued)
Cisco Unified IP Phone 7965G
and 7945G

Features SCCP SIP For More Information

Calling Features

Call Forward All Supported Supported “Basic Call Handling—Forwarding Calls to Another
Number”

Call Forward Busy Supported Supported “Basic Call Handling—Forwarding Calls to Another
Number”

Call Forward No Answer Supported Supported “Basic Call Handling—Forwarding Calls to Another
Number”

Call Park Supported Supported “Advanced Call Handling—Storing and Receiving
Parked Calls”

Call Pickup/Group Call Pickup Supported Supported “Advanced Call Handling—Picking Up a Redirected
Call on Your Phone”

Call Waiting Supported Supported “Basic Call Handling—Answering a Call”

Caller ID Supported Supported “An Overview of Your Phone—Understanding
Touch Screen Features” or “An Overview of Your
Phone—Understanding Phone Screen Features”

Client Matter Codes (CMC) Supported Not supported |“Basic Call Handling—Placing a Call: Additional
Options”

Conference Supported Supported “Basic Call Handling—Making Conference Calls”

Conference List Supported Supported “Basic Call Handling—Making Conference Calls”

Computer Telephony Integration Supported Some support | Users do not interact with this feature directly. It is

(CTI) Applications (such as Call configured on Cisco Communications Manager

Park, WMI)

Directed Call Park Supported Supported “Advanced Call Handling—Storing and Receiving
Parked Calls”

Do Not Disturb (DND) Supported Supported “Basic Call Handling—USsing Do Not Disturb”

Distinctive Ring Supported Supported “Using Phone Settings—Customizing Rings and
Message Indicators”

Extension Mobility Supported Supported “Advanced Call Handling—Using Cisco Extension
Mobility”

Fast Dial Service Supported Supported “Advanced Call Handling—Speed Dialing”

Forced Authorization Codes (FAC) |Supported Not supported |“Basic Call Handling—Placing a Call: Additional
Options”

Help System Supported Supported “An Overview of Your Phone—Understanding
Feature Buttons and Menus”

Hold/Resume Supported Supported “Basic Call Handling—Using Hold and Resume”

Hold Reversion Supported Supported “Basic Call Handling—Using Hold and Resume”

Immediate Divert Supported Supported “Basic Call Handling—Answering a Call”

Immediate Divert—Enhanced Supported Supported “Basic Call Handling—Sending a Call to a Voice
Messaging System”
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Feature Support by Protocol for the Cisco Unified IP Phone 7965G and 7945G

Table B-1 Cisco Unified IP Phone 7965G and 7945G Feature Support by Protocol (continued)
Cisco Unified IP Phone 7965G
and 7945G
Features SCCP SIP For More Information
Calling Features
Intercom Supported Supported “Basic Call Handling—Placing or Receiving
Intercom Calls”
Join/Select Supported Not supported |“Basic Call Handling—Making Conference Calls”
Join Across Lines Supported Not Supported |“Basic Call Handling—Making Conference Calls”
Log Out of Hunt Groups Supported Supported “Advanced Call Handling—Logging Out of Hunt
Groups”
Malicious Call ID Supported Not supported |“Advanced Call Handling—Tracing Suspicious
Calls”
Meet-Me Conference Supported Supported “Basic Call Handling—Making Conference Calls”
Multilevel Precedence and Supported Not supported |“Advanced Call Handling—Prioritizing Critical

Preemption (MLPP)

Calls”

Multiple Calls per Line Appearance (200 50 “An Overview of Your Phone—Understanding Lines
vs. Calls”

Mute Supported Supported “Basic Call Handling—Using Mute”

On-hook Dialing/Pre-Dial Supported Supported “Basic Call Handling—Placing a Call: Basic
Options”

Privacy Supported Supported “Advanced Call Handling—Using a Shared Line”

Programmable Line Keys Supported Not supported |Feature descriptions throughout phone guide

Quality Reporting Tool (QRT) Supported Supported “Troubleshooting—Using the Quality Reporting
Tool”

Redial Supported Supported “Basic Call Handling—Placing a Call: Basic
Options”

Secure Conferencing Supported Supported “Basic Call Handling—Making Conference Calls”

Shared Line Supported Supported “Advanced Call Handling—Using a Shared Line”

Single Button Barge Supported Not Supported |“Advanced Call-Handling—Using Barge to Add
Yourself to a Shared-Line Call”

Speed Dialing Supported Supported “Advanced Call Handling—Speed Dialing”

Transfer Supported Supported “Basic Call Handling—Transferring Calls”

Transfer - Direct Transfer Supported Not supported |“Basic Call Handling—Transferring Calls”

URL Dialing

Not supported |Supported

“Using Call Logs and Directories—Using Call Logs”

Video Support Supported Not supported |“Understanding Additional Configuration Options”

Voice Mail Supported Supported “Accessing Voice Messages” section of the Phone
Guide

WebDialer Supported Supported “Customizing Your Phone on the Web—Configuring
Features and Services on the Web”

Settings
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Table B-1 Cisco Unified IP Phone 7965G and 7945G Feature Support by Protocol (continued)
Cisco Unified IP Phone 7965G
and 7945G

Features SCCP SIP For More Information

Calling Features

Call Statistics Supported Supported “Troubleshooting Your Phone—Viewing Phone
Administrative Data”

Voice Quality Metrics Supported Supported “Troubleshooting Your Phone—Viewing Phone
Administrative Data”

Services

SDK Compliance 4.0(D) 4.0(1) Cisco IP Phone Service Application Development
Notes for Release 4.1(3) or later

Directories

Call Logs Supported Supported “Using Call Logs and Directories—Directory
Dialing”

Corporate Directories Supported Supported “Using Call Logs and Directories—Directory
Dialing”

Personal Directory Enhancements |Supported Supported “Using Call Logs and Directories—Directory
Dialing”

Supplemental Features and Applications

Cisco Unified Communications Supported Supported Cisco Unified Communications Manager Assistant

Manager Assistant User Guide

Cisco Communications Manager Supported Not supported |Cisco Unified Communications Manager Features

AutoAttendant and Services Guide

Cisco Unified Communications Supported Not supported |Cisco Unified Communications Manager Attendant

Manager Attendant Console Console User Guide

Cisco Unified IP Phone Expansion |Supported Not supported |Cisco Unified IP Phone Expansion Module 7914

Module 7914 Phone Guide

Cisco VT Advantage Supported Not supported |Cisco VT Advantage User Guide
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Supporting International Users

Translated and localized versions of the Cisco Unified IP Phones are available in several languages. If
you are supporting Cisco Unified IP Phones in a non-English environment, refer to the following
sections to ensure that the phones are set up properly for your users:

e Adding Language Overlays to Phone Buttons, page C-1

¢ Installing the Cisco Unified Communications Manager Locale Installer, page C-1

Adding Language Overlays to Phone Buttons

Note

To support the needs of international users, the button labels on the Cisco Unified IP Phones exhibit
icons rather than text to indicate the purposes of the buttons. You can purchase language-specific text
overlays to add to a phone. To order these language-specific overlays, go to this website:

http://www.overlaypro.com/cisco_systems?b=1

Phone overlays are available only for languages in which the Cisco Unified IP Phone software has been
localized. All languages may not be immediately available, so continue to check the website for updates.

Installing the Cisco Unified Communications Manager Locale
Installer

Note

If you are using Cisco Unified IP Phones in a locale other than English (United States), you must install
the locale-specific version of the Cisco Unified Communications Manager Locale Installer on every
Cisco Unified Communications Manager server in the cluster. Installing the locale installer ensures that
you have the latest translated text, user and network locales, and country-specific phone tones available
for the Cisco Unified IP Phones. You can find locale-specific versions of the Cisco Unified
Communications Manager Locale Installer at
http://www.cisco.com/kobayashi/sw-center/telephony/callmgr/locale-installer.shtml.

For more information, refer to the “Locale Installation” section in the Cisco Unified Communications
Operating System Administration Guide.

All languages may not be immediately available, so continue to check the website for updates.
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Technical Specifications

The following sections describe the technical specifications for the Cisco Unified IP Phone 7965G and

7945G.

e Physical and Operating Environment Specifications, page D-1

e (Cable Specifications, page D-2

e Network and Access Port Pinouts, page D-2

Physical and Operating Environment Specifications

Table D-1 shows the physical and operating environment specifications for the Cisco Unified IP Phone.

Table D-1 Physical and Operating Specifications

Specification

Value or Range

Operating temperature

32° to 104°F (0° to 40°C)

Operating relative humidity

10% to 95% (non-condensing)

Storage temperature

14° to 140°F (-10° to 60°C)

Height 9.07 in. (23.03 cm)
Width 10.82 in. (27.48 cm)
Depth e 2.541in. (6.45 cm)—with footstand fully closed
e 6.0in. (15.24 cm)—with footstand fully open
e 3.54in. (9.00 cm)—with optional wall mount kit
Weight 3.251b (1.47 kg)
Power

e 100-240 VAC, 50-60 Hz, 0.5 A—when using the AC adapter

e 44V-57V DC, 0.25 A—when using the in-line power over the
network cable
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M Cable Specifications

Table D-1 Physical and Operating Specifications (continued)
Specification Value or Range
Cables Category 3/5/5e/6 for 10-Mbps cables with 4 pairs

Category 5/5e/6 for 100-Mbps cables with 4 pairs
Category 5e/6 for 1000-Mbps cables with 4 pairs

Note Cables have 4 pairs of wires for a total of 8 conductors.

Distance Requirements As supported by the Ethernet Specification, it is assumed that the
maximum cable length between each Cisco Unified IP Phone and the
switch is 100 meters (330 feet).

Cable Specifications

e RJ-9 jack (4-conductor) for handset and headset connection.
e RJ-45 jack for the LAN 10/100/1000BaseT connection (labeled 10/100/1000 SW).
e RIJ-45 jack for a second 10/100/1000BaseT compliant connection (labeled 10/100/1000 PC).

e 48-volt power connector.

Network and Access Port Pinouts

Although both the network and access ports are used for network connectivity, they serve different
purposes and have different port pinouts.

e The network port is labeled 10/100/1000 sw on the Cisco Unified IP Phone.

® The access port is labeled 10/100/1000 pc on the Cisco Unified IP Phone.

Network Port Connector

Table D-2 describes the network port connector pinouts.

Table D-2 Network Port Connector Pinouts
Pin Number Function

1 BI_DA+

2 BI_DA-

3 BI_DB+

4 BI_DC+

5 BI_DC-

6 BI_DB-

7 BI_DD+

8 BI_DD-

Note  “BI” stands for bi-directional, while DA, DB, DC and DD stand for
“Data A”, “Data B”, “Data C” and “Data D”, respectively.

Cisco Unified IP Phone 7965G and 7945G Administration Guide for Cisco Unified Communications Manager 6.1
| D-2 | oL-14641-01 |



| Appendix D  Technical Specifications

Network and Access Port Pinouts

Access Port Connector

Table D-3 describes the access port connector pinouts.

Table D-3 Access Port Connector Pinouts
Pin Number Function

1 BI_DB+

2 BI_DB-

3 BI_DA+

4 BI_DD+

5 BI_DD-

6 BI_DA-

7 BI_DC+

8 BI_DC-

Note  “BI” stands for bi-directional, while DA, DB, DC and DD stand for
“Data A”, “Data B”, “Data C” and “Data D”, respectively.
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EAP-MD5 4-34 audience, for this document  i-xi

Device ID  4-34 authenticated call 1-13

Realm 4-34 authentication 1-9,3-13
Shared Secret 4-33 authentication server, in 802.1X 1-16
802.1X Authentication Status menu Authentication URL  4-16
about 4-32 authenticator, in 802.1X 1-16
states 4-35 auto answer 5-3

Auto Call Select 4-19
Auto Line Select 4-18

A
auto-pickup  5-3
abbreviated dialing 5-2 auto-registration
AC adapter, connecting 3-6 using 2-9
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auxiliary VLAN 2-3

background image
configuring 6-5
creating 6-4
custom 6-4
List.xml file 6-4
PNG file 6-4,6-5
barge 1-17,5-3
call security restrictions 1-14
BLF for Call Lists  4-18
block external to external transfer 5-3
BootP 1-4
BOOTP Server 4-5
Bootstrap Protocol (BootP) 1-4
Busy Lamp Field (BLF) speed dial 5-3

C

cable lock, connecting to phone 3-10
call
authenticated 1-13
encrypted 1-13
security interactions 1-14
call display restrictions 5-3
caller ID 5-5
Caller ID Blocking 5-5
call forward
all calls 5-4
destination override 5-4
display, configuring 5-4
call forward display, configuring 5-4, 5-6
CallManager Configuration Menu  4-11
call park 5-4
call pickup 5-4

call recording 5-4

Index W

call security restrictions using Barge 1-14
Call Statistics screen  7-1
call waiting 5-4
CAPF (Certificate Authority Proxy Function) 1-12,3-13
cell phone interference 1-1
certificate trust list file
See CTL file
Cisco Call Back 5-5
Cisco Discovery Protocol
See CDP
Cisco IP Manager Assistant (Cisco IPMA) 5-5
Cisco Peer-to-Peer Distribution Protocol (CPPDP) 1-6
Cisco Unified Communications Manager
adding phone to database of 2-8
interactions with  2-2
required for Cisco Unified IP Phones 3-2
verifying settings 9-4
Cisco Unified Communications Manager Administration
adding telephony features using 5-2
configuring LCD display using 6-8
Cisco Unified IP Phone

adding manually to Cisco Unified Communications
Manager 2-11

adding to Cisco Unified Communications
Manager 2-8

cleaning 9-19

configuration checklist 1-19
configuration requirements  1-17
configuring user services 5-16
features 1-2

figure 1-2

installation checklist 1-22
installation overview 1-17,1-21
installation procedure 3-6
installation requirements  1-17
modifying phone button templates 5-15
mounting to wall  3-10

power sources 2-3

registering  2-8
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W Index

registering with Cisco Unified Communications

Manager 2-9

resetting  9-14

supported networking protocols 1-4
technical specifications D-1
troubleshooting  9-1

using LDAP directories 5-14

web page 8-1

Cisco Unified IP Phone Expansion Module 7914

attaching to phone 3-8
statistics  7-3,7-10

troubleshooting 9-14

cleaning the Cisco Unified IP Phone 9-19

Clear softkey 7-4,7-9
client matter codes 5-5
Communications Manager 1-5 4-11
conference 5-6
secure 1-14
conference joining 5-6
configurable call forward display 5-6
configuration file
creating 9-5
encrypted 1-12
modifying 6-1
overview 2-5
XmlDefault.cnf.xml 2-6
configuring
from a Cisco Unified IP Phone 4-3
LDAP directories 5-14
overview 1-17
personal directories 5-14
phone button templates  5-15
softkey templates 5-15
startup network settings 3-13

user features 5-16

connecting
handset 3-6
headset 3-6

to AC adapter 3-6

to a computer 3-7

to the network  3-7
connection monitor

modifying duration time 4-10
Console Logs web page 8-2
Core Dumps web page 8-2
CTL file

deleting from phone 9-15

requesting  2-7

unlocking 4-32
CTL File menu 4-32
custom phone rings

about 6-2

creating 6-2, 6-3, 6-5

PCM file requirements 6-3

D

daisy chaining 9-10
data VLAN 2-3
Days Display Not Active 4-23, 6-8
Debug Display web page 8-2, 8-11
Default Router 1-5 4-7
Device Authentication 4-34
device authentication 1-11
Device Configuration menu
displaying 4-2
editing values 4-3
overview 4-1
sub-menus  4-11
Device Information web page 8-2,8-3
DHCP
description 1-5
troubleshooting  9-7
DHCP Address Released 4-9
DHCP Enabled 4-8
DHCP IP address 9-13
DHCP Server 4-5
directed call park 5-6
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directories button 1-3
Directories URL  4-16
directory numbers, assigning manually 2-11
direct transfer 5-6
display, turning on and off automatically 6-8
Display button 6-8
display button 1-3
Display Idle Timeout 4-23, 6-9
Display On Duration 4-23, 6-9
Display On If Incoming call 4-23, 6-9
Display On Time 4-23, 6-8
Display On When Incoming Call 6-9
Display On When Incoming call 4-23
DND 5-7
DNS server
troubleshooting 9-8
verifying settings 9-4
DNS Server 1-5 4-8
documentation
additional i-xii
for users A-2
Domain Name 4-6
Domain Name System (DNS) 4-6
Domain Name System (DNS) server 4-8
do not disturb  5-7
DSCP For Call Control 4-26
DSCP For Configuration 4-26
DSCP For Services 4-26
Dynamic Host Configuration Protocol

See DHCP

EAP-MD5 4-34

editing, configuration values 4-3
encrypted call 1-13

encrypted configuration file 1-12
encryption

media 1-9,1-12

Index W

signaling 1-9,1-12
Erase softkey 9-15
error messages, used for troubleshooting 9-3
Ethernet Configuration menu
about 4-24
Span to PC Port option  4-24
Ethernet Information web page 8-2,8-8
Expansion Module
See Cisco Unified IP Phone Expansion Module 7914
Expansion Module(s) screen 7-3,7-10

extension mobility 5-7

F

fast dial service 5-7
feature buttons
directories 1-3
help 1-3
messages 1-3
services 1-3
settings 1-3
features
configuring on phone, overview 1-8

configuring with Cisco Unified Communications
Manager, overview 1-8

informing users about 1-9
figure
Cisco Unified IP Phone features 1-2
Cisco Unified IP Phone rear cable connections 3-7
Cisco Unified IP Phone wall mount 3-11
file authentication 1-11
file format
List.xml 6-4
RingList.xml 6-2
firmware, verifying version 7-10
Firmware Versions screen 7-10
footstand
adjusting  3-9
adjustment button 1-3,3-11
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W Index

adjustment plate  3-11
identifying 1-3

forced authorization codes 5-7

G

G.711a, G. 711y, G.722, G.729a, G.729ab, iLBC 1-1
G.722 codec  4-22

G.729 141

G729a 11

G729ab 141

G729 141

GARP Enabled 4-25

group call pickup 5-8

handset 1-4
handset, connecting 3-6
headset
audio quality 3-5
button for 1-3
connecting 3-5
disabling 3-5
quality 3-6
sound quality 3-6
using 3-4
Headset Enabled 4-20
headset port 3-6
height, adjusting 3-9
help button 1-3
hold 5-8
hold reversion 5-8
Host Name 4-5
HTTP, description 1-5
HTTP Configuration menu
about 4-16

options

Authentication URL  4-16
Directories URL  4-16
Idle URL 4-17
Idle URL Time 4-17
Information URL 4-16
Messages URL  4-16
Proxy Server URL 4-17
Services URL 4-16
hunt group 5-8
log out of hunt groups 5-9

Hypertext Transfer Protocol

See HTTP

|

icon
lock 1-13
padlock 1-13
shield 1-13

idle display
configuring 6-7
timeout 4-17
viewing settings 6-7
XML service 4-17,6-7
Idle URL 4-17
Idle URL Time 4-17
iLBC codec 9-13
image authentication 1-11
immediate divert 5-8
Information URL  4-16
installing

Cisco Unified Communications Manager
configuration 3-2

network requirements  3-2
preparing 2-8

procedure 3-6
requirements, overview 1-17
safety warnings 3-2

intercom 5-9
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interference, cell phone 1-1
Internet Protocol (IP) 1-5

IP Address 4-6

IP address, troubleshooting 9-4

J

join 5-9

K

keypad 1-4
L

language overlays C-1
LCD screen
turning on and off automatically 6-8

LDAP directories, using with Cisco Unified IP
Phone 5-14

light strip, on handset 1-4

line buttons 1-3

Link Layer Discovery Protocol (LLDP)
network configuration 8-8

Link Layer Discovery Protocol-Media Endpoint Devices
(LLDP-MED)

network configuration 8-8
List.xml file 6-4
Locale Configuration menu
about 4-17,4-18
options
Network Locale 4-17
Network Locale Version 4-17
User Locale 4-17
User Locale Char Set 4-17
User Locale Version 4-17
Locale Installer C-1

localization

Index W

Installing the Cisco Unified Communications Manager
Locale Installer C-1

phone button overlays for C-1
Locally Significant Certificate (LSC) 3-13
lock icon 1-13
Logging Display 4-25
Log server 4-29,9-12

MAC address 4-5
malicious call identification (MCID) 5-9
manufacturing installed certificate (MIC) 1-11
Media Configuration menu
about 4-20
options
Headset Enabled 4-20
Recording Tone 4-20
Recording Tone Duration 4-21
Recording Tone Local Volume 4-21
Recording Tone Remote Volume 4-21
Speaker Enabled 4-20
Video Capability Enabled 4-20
media encryption 1-12
meet-me conference 5-9
messages button 1-3
Messages URL  4-16
message waiting 5-2,5-10
metrics, voice quality 8-12
MIC 11
mobile connect 5-10
mobile voice access 5-10
Model Information screen 7-1
multilevel precedence and preemption (MLPP) 5-10
music-on-hold 5-10

mute button 1-3
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W Index

native VLAN  2-3
Navigation button 1-4
Network Configuration Area items
LLDP-MED on SW port 8-8
LLDP on PC port 8-8
Network Configuration menu
about 4-5
displaying 4-2
editing values 4-3
locking options  4-3
options
Admin. VLANID 4-8
Alternate TFTP 4-9
BOOTP Server 4-5
CDP on PC port 4-28,9-12
CDP on switch port 4-28
Default Router 1-5 4-7
DHCP Address Released 4-9
DHCP Enabled 4-8
DHCP Server 4-5
DNS Server 1-5 4-8
Domain Name 4-6
Host Name 4-5
IP Address 4-6
MAC Address 4-5
Operational VLAN ID  4-8
PC Port Configuration 4-10
PC VLAN 4-10
Subnet Mask 4-6
SW Port Configuration 4-9
TFTP Server 1 4-7
TFTP Server 2 4-7
overview 4-1
unlocking options 4-3
Network Configuration web page 8-2, 8-4
network connectivity, verifying 9-3

networking protocol

802.1X 1-5
BootP 1-4
CDP 14
CPPDP 1-6
DHCP 1-5
HTTP 1-5
IP 15
RTCP 1-6
RTP 1-6
SCCP 1-6
SIP 1-6
TCP 1-7
TFTP 1-7
TLS 1-7
UDP 1-7

networking protocols, supported 1-4
Network Locale 4-17
Network Locale Version 4-17
network outages, identifying 9-7
network port

10/100/1000 SW  3-4

configuring 4-9

connecting to  3-7
network requirements, for installing 3-2
network settings, startup configuration 3-13
network statistics  7-9, 8-8
Network Statistics screen  7-9

Network web page 8-2, 8-8

o

on hook call transfer 5-10
Operational VLAN ID  4-8
other group pickup 5-10

P

padlock icon 1-13,4-3
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PC, connecting to the phone 3-4
PCM file requirements, for custom ring types 6-3
PC Port Configuration 4-10
PC Port Disabled 4-25
PC VLAN 4-10
Peer firmware sharing  4-29, 9-12
personal directories 5-14
phone button templates, modifying 5-15
phone lines, buttons for 1-3
phone screen 2-4
phone settings access  4-1
physical connection, verifying 9-7
plugging in Cisco Unified IP Phone 3-6
PNG file 6-4,6-5
power
maximum required from a switch 2-4
providing to the Cisco Unified IP Phone 2-3
power consumption 2-4
Power over Ethernet (PoE) 2-3
Power Save Configuration menu
about 4-23
options
Days Display Not Active 4-23
Display Idle Timeout 4-23
Display On Duration 4-23
Display On If Incoming call 4-23, 6-9
Display On Time 4-23
Display On When Incoming call 4-23
power source
causing phone to reset 9-8
description 2-3
effect on phone screen brightness 2-4
external power 2-3,2-4
PoE 2-3,2-4
power consumption 2-4
power injector 2-4
presence-enabled directories 5-10
privacy 5-11
Private Line Automated Ringdown (PLAR) 5-10

Index W

programmable buttons, description 1-3

Proxy Server URL 4-17

Q

QoS Configuration menu
about 4-26
options
DSCP For Call Control 4-26
DSCP For Configuration 4-26
DSCP For Services 4-26
QRT softkey 5-11,9-16
Quality Reporting Tool (QRT) 5-11,9-16

Real-Time Control Protocol
See RTCP
Real-Time Transport Protocol
See RTP
Recording Tone 4-20
Recording Tone Duration 4-21
Recording Tone Local Volume 4-21

Recording Tone Remote Volume 4-21

redial 5-11
reset
basic 9-14

factory 9-15

resetting
basic 9-14
Cisco Unified IP phone 9-14
continuously 9-6
intentionally 9-8
methods 9-14

ring activity 5-11

ringer, indicator for 1-4

RingList.xml file format 6-2
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W Index

S

safety warnings 3-2
SCCP, description 1-6
screen
See also LCD screen
See LCD screen
screen illumination disabling 5-13
secure conference
description 1-14,5-11
establishing 1-14
identifying 1-14
restrictions  1-14
security restrictions 1-14
secure SRST reference 1-12
securing the phone with a cable lock 3-10

security

CAPF (Certificate Authority Proxy Function)

3-13

configuring on phone 3-13

device authentication 1-11

encrypted configuration file 1-12

file authentication 1-11

image authentication 1-11

Locally Significant Certificate (LSC) 3-13
manufacturing installed certificate (MIC)
media encryption  1-12

secure SRST reference 1-12

security profiles 1-12,1-13

signaling authentication 1-11

signaling encryption 1-12

Security Configuration menu (on Device Configuration

menu)
about 4-25
options
GARP Enabled 4-25
Logging Display 4-25
PC Port Disabled 4-25
Security Mode 4-25

1-11

Voice VLAN Enabled 4-25
Web Access Enabled  4-25
Security Configuration menu (on Settings menu)
about 4-31
options
802.1X Authentication 4-32
802.1X Authentication Status 4-32
CAPF Server 4-31
CTL File 4-31
LSC 4-31
MIC 4-31
Security Mode 4-31
Trust List  4-31
Web Access Enabled 4-31
Security Mode 4-25
security profiles 1-12,1-13
Select button 1-4
services
configuring for users 5-16
description 5-12
subscribing to  5-16
services button 1-3
Services URL  4-16
Services URL button 5-12
settings button 1-3
Settings menu access 3-14, 4-2
shared line 5-12
shield icon 1-13
signaling authentication 1-11
signaling encryption 1-12
silent monitoring 5-12
SIP, description 1-6
softkey buttons, description 1-4
softkey templates, configuring 5-15
Span to PC Port 4-24
Speaker button
description 1-3
Speaker button, disabling 3-4
Speaker Enabled 4-20
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speakerphone

button for 1-3
speed dial

buttons for 1-3

template for 5-15
speed dialing 5-2,5-12
SRST 4-12,8-6

connection monitor duration parameter 4-10

secure reference 1-12
standard (ad hoc) conference 5-6
startup problems 9-2
startup process

accessing TFTP server 2-7

configuring VLAN  2-7

contacting Cisco Unified Communications
Manager 2-8

loading stored phone image 2-7
obtaining IP address 2-7
obtaining power 2-7
requesting configuration file 2-8
requesting CTL file 2-7
understanding  2-7
verifying 3-12
statistics
network 7-9, 8-8
streaming  8-11
Status menu
description 7-1
submenus on  7-2
status messages 7-3
Status Messages screen 7-3
Status Messages web page 8-2, 8-11
Stream O web page 8-11
Stream 1 web page 8-3,8-11
Stream 2 web page 8-3,8-11
Stream 3 web page 8-3,8-11
Stream 4 web page 8-3, 8-11
Stream 5 web page 8-3, 8-11

streaming statistics  8-11

Index W

Subnet Mask 4-6

supplicant, in 802.1X 1-16

Survivable Remote Site Telephony
See SRST

SW Port Configuration 4-9

T

TCP 1-7
technical specifications, for Cisco Unified IP Phone
telephony features
abbreviated dialing 5-2
anonymous call block 5-2
audible message waiting indicator 5-2
auto answer 5-3
auto-pickup 5-3
barge 1-17,5-3
block external to external transfer 5-3
Busy Lamp Field (BLF) speed dial 5-3
call display restrictions 5-3
caller ID 5-5
caller ID blocking 5-5
call forward 5-4
call forward configurable display 5-4
call park 5-4
call pickup 5-4
call recording 5-4
call waiting 5-4
Cisco Call Back 5-5
Cisco IP Manager Assistant (Cisco IPMA) 5-5
client matter codes 5-5
conference 5-6
configurable call forward display 5-6
directed call park 5-6
direct transfer 5-6
do not disturb (DND) 5-7
extension mobility 5-7
fast dial service 5-7

forced authorization codes 5-7
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W Index

group call pickup 5-8
hold 5-8
hold reversion 5-8
hunt group 5-8
immediate divert 5-8
join 59
log out of hunt groups 5-9
Log server 4-29,9-12
malicious call identification (MCID) 5-9
meet-me conference 5-9
message waiting 5-2
mobile connect 5-10
mobile voice access 5-10
multilevel precedence and preemption (MLPP) 5-10
music-on-hold 5-10
on hook call transfer 5-10
other group pickup 5-10
Peer firmware sharing  4-29, 9-12
presence-enabled directories 5-10
privacy 5-11
redial 5-11
ring activity  5-11
screen illumination disabling 5-13
services 5-12
Services URL button 5-12
shared line 5-12
silent monitoring 5-12
speed dialing 5-12
Time-of-Day Routing 5-13
transfer 5-13
video mode 5-13
video support 5-13
voice messaging system 5-13
TFTP
description 1-7
troubleshooting 9-3
TFTP Server 1 4-7
TFTP Server 2 4-7
time, displayed on phone 3-2

Time-of-Day Routing 5-13

TLS 2-5

transfer 5-13

Transmission Control Protocol
See TCP

Transport Layer Security
See TLS

Trivial File Transfer Protocol
See TFTP

troubleshooting
Cisco Unified Communications Manager settings
Cisco Unified IP Phone 9-1

9-4

Cisco Unified IP Phone Expansion Module 7914  9-14

DHCP 9-7

DNS 9-8

DNS settings 9-4

IP addressing and routing 9-4
network connectivity 9-3
network outages 9-7
phones resetting 9-8
physical connection 9-7

services on Cisco Unified Communications
Manager 9-4

TFTP settings 9-3
VLAN configuration 9-7
Trust List menu  4-33

U

UI Configuration menu 4-18
options
Auto Call Select 4-19
Auto Line Select 4-18
BLF for Call Lists 4-18
uncompressed wideband (16bits, 16kHz) audio 1-1
Unlock softkey 4-33
User Datagram Protocol
See UDP
User Locale 4-17
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User Locale Char Set 4-17
User Locale Version 4-17
User Options web page
description 5-17
giving users access to  5-17
user options web page
call forward settings  5-17
users

adding to Cisco Unified Communications
Manager 5-16

configuring personal directories A-4
documentation for A-2

providing required information to  A-1
providing support to  A-1

subscribing to services A-3

\"/

verifying
firmware version 7-10
startup process 3-12

Video Capability Enabled 4-20

video mode 5-13

video support 5-13

VLAN
auxiliary, for voice traffic 2-3
configuring 4-8
configuring for voice networks 2-2
native, for data traffic 2-3
verifying 9-7

voice messaging system 5-13

voice messaging system, accessing A-3

voice quality metrics 8-12

voice VLAN 2-3

Voice VLAN Enabled 4-25

volume button 1-3

Index W

w

wall mounting 3-10
Web Access Enabled 4-25
web page
about 8-1
Access 8-2,8-8
accessing 8-2
Console Logs 8-2
Core Dumps 8-2
Debug Display 8-2, 8-11
Device Information 8-2, 8-3
disabling access to  8-3
Ethernet Information 8-2, 8-8
Network 8-2,8-8
Network Configuration 8-4
Network Configuration web page
preventing access to  8-3
Status Messages 8-2, 8-11
Stream 0 8-11
Stream 1  8-3, 8-11
Stream 2 8-3, 8-11
Stream 3 8-3, 8-11
Stream 4 8-3, 8-11
Stream 5  8-3, 8-11
wideband codec  1-1
wideband headset 4-22
option 4-19

user controllable 4-19

8-2

X

XmlDefault.cnf.xml 2-6
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